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Introduction

Digital nature photographers are a different breed from other types of photographers. They are equal parts

adventurer, traveler, nature and wildlife observer, and digital photographer. Facing challenges other photogra-

phers don’t have, digital nature photographers have to take a lot into consideration when practicing their craft.

Digital Nature Photography and Adobe Photoshop is written expressly for digital nature photographers, address-

ing their particular needs.

Digital Nature Photography and Adobe Photoshop combines information on editing and processing digital

nature and landscape photos using Adobe Photoshop, with an advanced guide to composing and shooting as

well as choosing the proper equipment. The first half of the book provides detailed information on the essen-

tial equipment, gear, and techniques needed to photograph nature and landscapes, while the second half lays

out how to develop workflows to perform color and tonal corrections to images, as well as how to apply some

advanced editing techniques to your photographs. This comprehensive guide also details creating special effects

using Photoshop filters and converting color images into stunning black-and-white photographs. All of the

essential skills are taught using step-by-step tutorials and enhanced by stunning full-color examples of digital

nature photography.
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I
gave up using my film SLR when I purchased a Sony DSC-F707 5-megapixel digital camera some years

back, and I haven’t shot a roll of film since. As a computer geek and nature photographer, the minute I dis-

covered that the quality of digital cameras was getting close to film, I jumped on the bandwagon. I had

been scanning my 35mm slides into digital files for years, processing them in Photoshop, and then printing them

on my array of photo-quality printers. For me, switching to full-time digital was a no-brainer.

Besides image quality, one of the other deciding factors in jumping to digital was the cost. When shooting film,

I’d purchase 40 rolls of Velvia at a time for my photo trips, spend a few days or a week shooting them, and then

send them out for processing. I wouldn’t see my results until days after I returned from shooting one of my

favorite landscape regions. With my digital camera, I can see my results instantly.

Photos taken with my first digital camera remain as staples in my nature portfolio. This landscape was taken

with a Sony DSC-F707.
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Since I jumped into the digital camera game, both con-

sumer- and professional-model digital cameras have

advanced technically to the point where shooting film 

doesn’t even make sense anymore. Unlike its film counter-

part, digital camera technology is advancing rapidly and

will continue to advance at a fever pace until the end,

which isn’t in sight. Currently, the top digital camera man-

ufacturers are waging megapixel wars, and it’s the photog-

rapher who’s winning. What we get every six months to a

year are a flock of new models that provide better features,

sharper sensors, and more megapixels. It doesn’t matter

whether you’re a Nikon, Canon, Olympus, Minolta, or

Pentax shooter (forgive me if I left your manufacturer out),

there is always a better model around the bend.

At the time of this writing, state-of-the-art digital SLRs are

boasting 12.4 to 16.7 megapixels and their price tags are

aimed at professionals. Affordably priced 8-megapixel digital SLRs are now the norm for Canon shooters. As a

matter of fact, digital SLRs from Canon, Nikon, Pentax, Olympus, and Minolta cost the same as that 5-megapixel

compact digital camera I purchased just a few years ago. Does that mean you need to upgrade your digital cam-

era equipment every six months to a year? Absolutely not; if your current digital camera is giving you great

results, what’s the rush? When you do get that itch to upgrade, you can be sure there will be a lot of new options

out there for you to choose from.

Advantages of Digital Cameras over Film in Nature Photography

If you’re still shooting film and you haven’t yet switched to digital, you’re not alone. On a recent trip shooting

waterfalls during peak fall color in a popular region of northern Michigan, I ran into a lot of photographers. Yes,

most were shooting digital—almost all of the digital photographers I ran into were using digital SLRs—but I was

a little surprised to see how many were still using their film-based SLRs and large-format cameras. It makes

sense; many nature photographers have years of investment in film equipment, all of it still serviceable. In talk-

ing to these nature photographers (we are always striking up conversations), I find that although they are still

shooting film, almost all are scanning their images using high-end film scanners, and almost all are using

Photoshop. Additionally, all of the film shooters I met were planning to switch to digital in the near future.

Image courtesy of Nikon USA.
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Like many of us nature photographers, I switched to digital simply because the advantages outweighed the dis-

advantages. Advantages for using digital cameras for nature photography include:

■ Getting immediate feedback. One of the

biggest advantages to shooting digital is

the fact that you can get immediate feed-

back after a shot. You can view the image

on your LCD, and on many models you

can view a histogram to help you judge

exposure. The histogram comes in espe-

cially handy when you are shooting in

difficult lighting conditions, such as

when your image includes a combina-

tion of sunlit and shadow areas. After

composing and taking a photo, you can

review your composition on the LCD

and recompose the next shot until you

get it right. Additionally, you can also see

whether the image is properly focused; if

it isn’t, you can always delete the image

and take another.

■ Changing ISO on the fly. With film cam-

eras, you have to change your roll of film

if you want to shoot a scene at a different

ISO setting. That can be quite inconven-

ient if you have 20 shots left on a 36-

exposure roll. With digital, all you have

to do is change the ISO setting! You can

shoot as many shots with different ISO

settings as you want. Digital gives you a

time- and money-saving advantage when

it comes to switching ISO, which, as

nature photographers, we do often in the

field.

The ability to receive immediate feedback helps nature photogra-

phers make changes to camera settings when shooting in difficult

lighting situations.
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■ Adjusting white balance. With film cameras, if you wanted to switch from shooting in different 

lighting conditions, such as shooting flowers in natural lighting and then going into the studio 

to shoot with tungsten lighting, you’d have to switch film rolls. With digital, you can use the auto

white-balance setting or manually set your white balance to the lighting conditions in which you’re

shooting.

■ Composing shots using the LCD. I’m going to hear some argument on this, but on compact digital

cameras, you have the ability to compose a scene using the LCD screen instead of the viewfinder.

Of course, this is only for compact digital cameras; on digital SLRs you still have to compose 

your shot using the viewfinder. On another note, nature photographers shoot outdoors, where in

most conditions it may be difficult to actually see the scene on the LCD due to sunlight or bright

conditions.

■ Saving on cost. If you shoot thousands of nature photos a year, like I do, you’re going to save a ton

of money shooting digital. No film or processing costs! Suppose you shoot 100 rolls of 36-exposure

film at a cost of $15 (with processing). Do the math—that’s a $1,500 savings right there! It doesn’t

take much thought to figure out that you can finance your purchase of some pretty good digital

camera equipment in a short period of time, just by saving in film and processing costs.

■ Saving time. Let’s face it—photographers like instant gratification. We shoot all day long in the field,

and the first thing we do when we get home is load up our memory cards to our computer and

view the day’s catch. With film, you have to either develop the film yourself or send it out to a lab

for processing, which could take a few hours to a few days. By shooting digital, you can preview

your photos immediately on your digital camera’s LCD or load them onto your computer and view

your images with Photoshop right away. If you’re fast, you can get some images printed on your

inkjet within minutes of loading your images onto your computer.
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The Right Digital Camera for the Job

With all the digital camera choices available on the market now, which one is best for the nature photographer?

To be honest, there really isn’t a correct answer. Just like film cameras, digital cameras come in all sorts of fla-

vors, and your personal tastes will dictate a lot of the choices you’ll make. There are professionals out there who

will only work with high-end professional digital cameras, such as the Canon EOS 1Ds Mark II with its speed

of four frames per second (4 fps) and its full-frame 16.7-megapixel sensor, while others are happy with com-

pact digital “point and shoot” cameras.

Other nature photographers, like me, use a number of different digital cameras. I carry into the field my digi-

tal SLR and accompanying lenses, plus a compact digital camera. Actually, I like the idea of carrying a com-

pact digital camera everywhere I go. Additionally, a small “pocketable” compact, such as the Nikon Coolpix

7900 digital camera, gives you the ability to shoot some great macro shots, which is something I do often while

I’m out shooting other nature scenes. I carry this camera wherever I go, shooting nature or just as an everyday

walking-around camera.

Some high-end users and professional

nature photographers will only shoot

with professional equipment, such as

the Canon EOS 1Ds Mark II.

Carrying a small, compact digital camera, such as the Nikon

Coolpix 7900, has its advantages, like shooting great macro

images. These high-quality compact digital cameras boast

great lenses and adequate megapixel sensors, and they’re a

great everyday carry-around camera.
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Before graduating to digital SLRs, I used prosumer (professional-consumer grade) digital cameras. A prosumer

digital camera contains excellent wide-angle-to-zoom lenses and equally excellent image sensors. These pro-

sumer models just keep getting better, with many models now including vibration reduction, which allows you

to take sharp photos by eliminating vibration when you’re taking the picture. Examples of these “all-in-one”

cameras are the Nikon Coolpix 8800, the Canon PowerShot Pro1, and the Panasonic Lumix DMC-FZ30. Recent

models of this class of cameras come equipped with professional-quality lenses, vibration reduction (on some

models), and 8-megapixel sensors or larger.

The fastest growing segment of digital cameras is the now-affordable digital SLR. In the past few years, Canon,

Nikon, Minolta, Pentax, Olympus, and Sigma have all come out with their versions of the digital SLR. Only a

few years ago, purchasing a digital SLR wasn’t within the reach of most hobbyists or advanced amateurs. The

digital SLRs on the market were only aimed at the professional, with price tags matching those of gas-guzzling

SUVs. Now for the same price as the top prosumer models, you can obtain a digital SLR with a lens.

Prosumer digital cameras offer all-in-one packages that include high-

megapixel sensors, vibration reduction, and wide-angle telephoto

lenses. The Panasonic Lumix DMC-FZ30 offers an 8-megapixel sensor

with an excellent Leica 35mm to 420mm lens with MEGA Optical

Image Stabilizer, a great combo for nature and wildlife photographers.

The Nikon D50 with a kit lens costs about the same as many

compact or prosumer digital cameras. Digital SLRs are

becoming more and more affordable to nature photogra-

phers who want to upgrade.
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Digital SLRs appeal to film shooters who have already invested in lenses for their particular models. Purchasing a

digital SLR from the same manufacturer as your film system makes sense because you can still use the lenses in

which you have invested. When choosing a digital SLR, keep in mind that you are also locking yourself into a “sys-

tem,” because each manufacturer has proprietary lenses and accessories that only work on their brand of camera.

Besides impressing friends and other photographers, advantages to a digital SLR include:

■ Interchangeability of lenses and accessories. When you buy into a digital SLR, you’re buying into

a system. If you already own a Nikon F100 film SLR, the lenses and accessories you already have

will probably work on your new Nikon digital SLR. In turn, when you purchase a new digital SLR,

any lenses or accessories you purchase along with it will probably be compatible with additional

digital SLRs you might purchase from the same manufacturer in the future. Many professional nature

photographers who used Canon or Nikon film SLRs have remained loyal to the same manufactur-

ers for their digital equipment, mainly because of the thousands of dollars worth of lenses they had

already invested in that manufacturer’s system.

Additionally, for nature photographers, nothing can beat the effects you can get from interchange-

able lenses. The quality and range of lenses manufactured for SLRs often can’t be duplicated in a

compact or prosumer digital camera. Yes, you can get consistent excellent results with these digital

cameras, but the advantage and quality of choices in a digital SLR lens lineup can be noticeable in

the images a knowledgeable photographer can produce with good gear.

■ Better image quality. Digital SLRs often come equipped with advanced image sensors, often phys-

ically larger than those found in compact digital cameras. The result of having larger image sensors

is that the manufacturer isn’t “cramming” pixels into a smaller space like with their compact digi-

tal counterparts. For instance, a six-megapixel sensor on a digital SLR is physically larger than a six-

megapixel sensor on a compact digital camera. The result of larger sensors is sharper images with

less image noise and “blooming,” an effect of purple fringing in detail areas of images.

■ Lens crop factor. On many digital SLRs, you have an effect of lens cropping. Lens cropping occurs

when you have a lens on a film SLR that’s rated at 200mm, but when you use it on a digital SLR, it

becomes a 300mm lens! The crop factor occurs because the image sensor is smaller than a 35mm

frame, thus the image is focused into a smaller area, resulting in better reach of your telephoto

lenses. The downside is that you lose crop factor on the wide-angle end of the lens range. A 20mm

wide-angle lens on a film camera would have the effect of a 30mm lens on a digital SLR with a 1.5×

crop factor. Some digital SLRs—high-end models such as the Canon EOS 1Ds Mark II—have full-

frame image sensors with no crop factor at all. The image sensor is so large that it’s the same size

as its 35mm film frame!
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Choosing the Right Accessories

Choosing the right accessories for your digital camera is almost as important as choosing the digital camera itself.

For nature photographers, there are a number of accessories you should have in your camera bag when going

out in the field, in addition to a good supply of bubble gum and aspirin. Nature photographers have different

gadget needs than, let’s say, a portrait photographer. Nature photographers need a greater zoom range in their

lenses, possibly accessory lenses for compacts or prosumer models, tripods, memory cards, batteries, lens

cleaning blowers and brushes, and other gadgets most people wouldn’t even think of.

What’s in your bag? Nature photographers need to carry all their accessories with them out in

the field—everything from lenses to batteries.
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Important accessories for the nature photographer include:

■ Memory cards. With any digital camera, you need memory cards on which to store your photos.

Memory cards replace film, in a way. Instead of your lens and shutter capturing an image on film,

it records on your image sensor, which in turn records the digital image information on a memory

card. Memory cards come in different flavors, the most popular being CompactFlash, XD, SD, or

Memory Stick. They all work the same; however your digital camera might only accept one type of

card. I have a collection of all kinds—CompactFlash cards for my digital SLR, Memory Sticks for my

Sony compact digital camera, and SD cards for my Nikon compact digital camera. It’s a shame the

industry hasn’t standardized to one format, because it can be confusing.

If you know what type of card your digital camera accepts, you need to estimate how many cards

you’ll need and how much memory capacity each should have. I used to purchase my cards at a

size of 512 megabytes. I liked the fact that I could back up each card on a writable CD, and 512

megabytes was a good amount to fill up a CD. However, digital cameras are now boasting 6- to 16-

megabyte images, which can fill up a memory card pretty fast. I now use 1 or 2 gigabyte memory

cards, which will hold 100 to 200 digital images each, but I now back them up to DVDs, which have

a capacity of 4.5 gigabytes.

I carry with me at least enough memory cards to

get me through an entire day of shooting in the

field, but I have enough to last me through four or

five days of full-time shooting. I often fill up two

or three 1-gigabyte cards in a day shooting my

landscapes, which translates into hundreds of pho-

tos. The way I look at it, memory cards are cheap

and reusable, so why not take a lot of photos? 

I own about 12 cards and I keep them all in my

bag. After a day of shooting, I download my cards

to my laptop computer (which I travel with), and

then I immediately back up those images to a

DVD. If I’m out of town, I save the memory cards

I’ve used, downloaded, and backed up just as an

extra precaution until I get back to my home office.

Only when I’m sure my images are properly down-

loaded and backed up will I reuse my cards.

Memory cards come in all sorts of sizes and formats. As a

rule of thumb, you should buy the largest and fastest one

that you can afford.
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■ Offline storage devices. If carrying a laptop with

you when you take trips is a pain, there are other

offline storage devices to which you can down-

load your digital images. You can download

images to an Apple iPod, as well as the Epson 

P-4000 viewer. Both are good alternatives to car-

rying a laptop on long trips and can provide

plenty of offline storage for your viewing needs

while traveling on the road.

■ Tripods. The most important accessory for the

nature photographer is a tripod. More often than

not, we shoot scenes that require a solid mount

for our digital cameras because we often shoot

in low-light situations. I’ll explain about tripods

in more detail in Chapter 3, “Outfitting for the

Outdoors.”

■ Lenses. Nature photographers often need lenses

that can reach both wide-angle and telephoto

extremes. If you’re into shooting photos of wildlife, you may need zooms that can reach 400 to

600mm. Shooting grand vistas requires both wide-angle and telephoto ranges. I typically shoot with

ranges from 17mm all the way to 450mm.

If you’re shooting with a digital SLR, lenses that cover wide-angle to normal ranges are popular.

These lenses will typically cover 17 or 18mm to 50 or 70mm. If you want longer reach, 70 to 200

or 300mm lenses are popular “second” lenses.

If you’re shooting with a prosumer or compact digital camera, chances are you can purchase acces-

sory lenses. Accessory lenses are attachments you can purchase for your built-in lens that can offer

you either wide-angle or telephoto capabilities. Check with your digital camera manufacturer for the

availability of these add-on lenses.

The Epson P-4000 Multimedia Storage Viewer comes with

an 80-gigabyte hard disk, a 3.5-inch LCD display that can

show both JPEG and raw images, and slots for both

CompactFlash and SD cards.
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■ Filters. For nature photographers, the most popular filters to consider adding to your gadget col-

lection are neutral density and circular polarizing filters. I carry neutral density filters to darken

scenes without affecting color; darkening the scenes gives me an extra couple f-stops needed to get

a nice blurring effect with waterfalls. Circular polarizers are great additions to darken blue skies

and to reduce glare off of rocks and foliage.

Neutral density filters are handy when you want to

slow down your shutter speeds to get soft water

effects when shooting waterfalls or rapids. Neutral

density filters just help darken the image, resulting

in slowing your exposure a few f-stops—often

enough to get great effects.
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■ Batteries. Nothing can get a nature photographer angrier than exhausting a camera battery and not

having a spare. It’s a good idea to have at least one or two spare batteries in your camera bag at all

times, especially when traveling. Never venture out without having all your digital camera batter-

ies charged. Also consider buying accessory car battery chargers when traveling on the road, and

make sure you bring along your regular battery charger to recharge your batteries when you get to

your hotel.

■ Flashlights. I always carry a small pen-sized flashlight in my camera bag. When I’m out in the field,

I’m often out shooting in the early morning, before sunrise, or even late, after sunset. Having a small

flashlight helps me find other gadgets in my bag when it’s dark, and it even helps illuminate con-

trols on my digital camera in the dark.

■ Lens-cleaning items. When venturing out in the field, make sure to pack lens-cleaning tissue and

dust-removal blowers and brushes. If you’re out shooting in the elements, you’ll often find that dust,

dirt, grime, and sand can find their way onto the surfaces of your lenses and filters. I always carry

blower brushes, lens-cleaning tissue, and lens-cleaning fluid with me in the field, and I use these

often.
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I
belong to the early adopter generation. Let’s put it this way; my first computer was an IBM XT with a 10-

MB hard disk and 256 K of memory. It ran WordStar (now gone), Lotus 1-2-3 (now gone, I think!), and an

assortment of lightweight database products. The most advanced software you could run on that computer

was Microsoft’s Flight Simulator, but only if you had a Hercules graphics card—monochrome of course! That

was in the early 1980s, right around the same time that good music took a long vacation.

I’ve owned several computers since—yes, I’m one to upgrade every couple years—but I was a computer guy

anyway. Either I was selling them to corporate America or buying them for corporate America. My day job was

in IT; I purchased, networked, and set up the things by the truckload. Does that make me an expert in computers

now? Not since I was a computer jockey years back, but I still know all the configurations and gadgets the

nature photographer needs. Now I can let somebody else install enterprise networks and Web applications; I’m

going out to take some photos of deer!

Nature photography

meets technology.

Our tools were

cameras, lenses, and

film; now they’re

cameras, lenses, and

computers.



Desktop computers are still very popular and offer advantages over

laptop computers for speed, price, and video quality. ©1994–2003

Hewlett-Packard Company. All rights reserved.

Whether you’re using a PC or a Mac, make sure you purchase the highest-end desktop

you can afford. Apple offers excellent desktop computers, such as the PowerMac G5,

favorites of graphic artists and photographers. Photo courtesy of Apple Computer.
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Computers and Software for Digital Photographers

The rule of thumb when purchasing computers is to buy the biggest and fastest you can afford. For nature pho-

tographers, the rule needs to be customized a bit. I still believe you need a big, honking computer for processing

your images in Photoshop, but what about when you’re out in the field? I don’t lug around my desktop com-

puter when I travel cross-country on a photo safari; I recommend hauling a laptop. Unfortunately, not every-

one has the luxury of having both a desktop computer and a laptop, but let’s look at the advantages and

disadvantages of each.

Desktop Computers for the Nature Photographer

Desktop computers typically contain more memory, disk space, and expandability than their portable coun-

terparts. It’s always been that way, and it will continue to be for the foreseeable future. The reason? There’s

more room for computer manufacturers to include less-expensive components with desktops than with laptops.

What that means to you is more bang for your buck; you can typically get a desktop computer for far less

money than a similarly equipped laptop.
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For desktop computers, I recommend the following equipment specifications.

■ Processor. Graphics and photo editing software, such as Photoshop, requires a lot of horsepower.

My suggestion is to get the most powerful processor you can afford. In the PC world, that means a

computer equipped with a Pentium 4 or the newer Pentium D, with at least a 3.2-gigahertz clock

speed. You can find desktop computers with Celeron processors much cheaper, but they aren’t

nearly as powerful as the Pentium 4 or D. If you’re a Mac user, stick with one of Apple’s higher-end

desktop models, such as the Power Mac G5.

■ Memory. The next important part of your computer is internal memory. Internal memory is what your

computer uses as a “temporary holding tank” to load operating system (Windows or Mac OS) pro-

grams and files. Although Photoshop will run with less than 512 megabytes of memory, make sure

your computer has at least 1,024 megabytes of memory.

■ Hard disk. The second type of memory you need to consider for your computer is your hard disk.

Your computer’s hard disk is the permanent (or at least for as long as your hard disk stays healthy)

file and program storage for your computer. It seems that hard disk drives get bigger and bigger

every year. Higher-end models come equipped with 300 gigabytes of storage! Because the nature

photographer will often take multiple shots of the same scene, even more with bracketing shots (see

Chapter 4, “Shooting Landscapes”), those 1-gig cards downloaded to your computer add up after a

while. Go for the biggest hard disk drive your computer can handle. You’ll use it; trust me!

■ Graphics card. The graphics card (also referred to as the graphics controller) is the component inside

your computer that determines how graphics are displayed on your computer monitor. All com-

puters come with graphics cards; however, some computer models are configured with enhanced

graphics cards with extra “onboard” video memory, usually suited to game players. Even if you

don’t play games on your computer, the extra video memory these enhanced controllers offer will

help render your photos a little quicker.

■ Input/output (IO) ports. Nature photographers pack a few more peripherals than most computer

users. Card readers, external hard disk drives, graphics tablets, mice, and direct-connecting digital

cameras mean you need some USB and/or FireWire ports. USB and FireWire ports allow you to

connect these peripherals to your computer. Typically, I’ll have a USB mouse, two external

FireWire/USB hard disk drives, and a card reader connected to my computer. That’s a minimum of

four ports needed on my computer. If I wanted to direct-connect a digital camera or one of those

little pocket Flash drives to my computer, I’d have to unplug one of my peripherals. Make sure you

get a computer with at least four USB ports and one FireWire port.



Digital Nature Photography and Adobe Photoshop

22



Chapter 2    Computer Gear for Your Digital Darkroom

23

Laptops for the Nature Photographer on the Go

I remember my first “portable” computer. It was

a two-floppy Compaq Portable with a 9-inch

monochrome display, and it weighed about 30

pounds! You carried it around like a suitcase,

and if you were carrying it home from work,

you’d stretch the arm you were carrying it with.

After a while, you’d wind up with one arm

longer than the other! If you switched arms once

in a while, you’d start looking like an orangutan.

(You get the idea…and I do like orangutans!)

We’ve come a long way since the early 1980s.

We now can purchase laptop computers that

weigh just a couple of pounds; come with more

than 100-gigabyte disk drives, one to two giga-

bytes of memory, and 17-inch displays; and will

play our favorite DVDs while we’re on an air-

plane or camping! Nowadays you can even get

a laptop equipped with a TV tuner. Next, I’m

waiting for a massaging keyboard (adjustable) to

relax my hands after a long day of shooting in

the field (quick, to the patent office!).

Laptop computers are more important for a

nature photographer than for a portrait or still-

life shooter. The reason? We often travel to our

locations, whether they are quick overnighters

or extensive one- or two-week safaris. When

traveling overnight, I always pack my laptop. I could get by carrying an offline photo viewer, such as the Epson

P-4000, but I like the added insurance of downloading my images nightly and burning a couple of DVDs for

backups. The only way I get that insurance is to haul my laptop with me. As a bonus, by traveling with a lap-

top, I can spend the evenings in my hotel room or camper playing with my images in Photoshop.

Laptop computers have overtaken desktop computers in sales, and why

not? Many are equipped with large hard disks, plenty of memory, and

writable optical drives. ©1994–2005 Hewlett-Packard Company. All

rights reserved.
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My recommendation for laptop computers is the same as for desktop computers—buy the fastest you can afford

with lots of memory and hard disk space. Here are my recommendations to outfit your laptop:

■ Processor. Processors for laptops differ from those for desktop computers. Because laptop comput-

ers can run on batteries, computer manufacturers are always looking at ways to be more efficient

with power. You can purchase laptops with Pentium 4 processors, but also with Intel Pentium M

processors, specifically made for laptops to maximize power efficiency.

■ Memory. Requirements for internal memory in a laptop are no different than requirements for a

desktop computer. Make sure your laptop computer has at least 1,024 megabytes of memory.

■ Hard disk. Laptop computers typically come equipped with less hard disk space than their desktop

counterparts. You can still purchase a laptop with more than a 100-gigabyte hard disk, and I sug-

gest you do. Go for the biggest hard disk drive the laptop model offers. Keep in mind, though, for

serious editing you’re still better off keeping that big, clunky CRT and desktop computer back at your

desk.

■ Display. Laptop computers typically come with 14-inch to 17-inch displays. For editing nature pho-

tos, the bigger the better. If you can put up with a little extra size and weight, opt for a high-resolu-

tion 15.4- or 17-inch display. You’ll be glad if you plan to spend a lot of time editing photos in

Photoshop using your laptop.

■ Input/output (IO) ports. I still recommend at least four USB ports and one FireWire port for your

laptop (just like a desktop), but chances are you’re not going to find too many laptops with that

many ports. My laptop has three USB ports and one FireWire port, but that’s rare. Most laptops

come equipped with two USB ports, and only the higher-end models include a FireWire port. If

you need additional USB ports, you can purchase USB expanders that, when plugged into one USB

port, will “split” that port into four.
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Choosing the Best Computer Displays for Working with Photos

When choosing a computer monitor for your desktop computer or as an external display for your laptop, there

are a few specifications you’ll need to pay attention to: type, size, and dot pitch. LCD displays are becoming

more popular and have quickly replaced CRT (Cathode Ray Tube) displays as the monitors of choice. For pho-

tographers, CRTs are still the best choice.

CRT monitors offer the nature photographer bet-

ter resolution, color, quality, and calibration.

(You’ll read more on calibration in Chapter 10,

“Setting Up and Getting Around in Photoshop

CS2.”) LCDs look great on the desk, but CRTs are

still the way to go for overall quality. If you’re in

the market for a better display for your computer,

consider a CRT that is at least 19 inches and has

a dot pitch of below 24. Computer displays are

all rated by size and dot pitch. The lower the dot

pitch (size of pixels), the better the quality.

Some higher-end monitors, such as the Apple 25-

inch Cinema Display and the Sony Artisan, were

designed for photographers, video pros, and

graphic artists. These monitors are typically

priced higher than your computer and are tar-

geted toward the best video quality available. The

Sony Artisan even comes with a built-in col-

orimeter to make sure the monitor is calibrated

properly (see Chapter 10).

When choosing a display, strongly consider a

large, high-quality CRT or a high-quality LCD.

The king of all computer monitors for photographers is the Sony Artisan.
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Monitor Calibration Tools

A colorimeter is one of the most important tools you’ll need to ensure that the images you’re viewing and edit-

ing on your computer display represent what will be printed. A colorimeter is a color-measurement tool that

attaches to your display. In conjunction with software, it is used to create a monitor profile your computer uses.

When calibrating your monitor with a colorimeter, you’re more closely matching the colors shown on your dis-

play to the print that’s being churned out on your printer.

Popular calibration tools include the ColorPlus or Spyder2 from ColorVision (http://www.colorvision.com) and

the Monaco EZcolor and OPTIX solutions (http://www.xritephoto.com). You’ll find that investing in these tools

will be well worth the price, and calibrating your monitor will save you money by reducing the amount of

paper and ink used in a “trial and error” process.

Auxiliary Storage

I’ve found that an external hard disk drive is a necessity for nature photographers. We tend to shoot many more

photos than other types of photographers, and often we take tens, if not hundreds, of photos in one location.

Today’s digital cameras can capture anywhere from 8- to 16.7-megapixel images that translate into large files

of 6 to 17 megabytes each! It won’t take long to fill up a 160-gigabyte hard disk with files of that size. My lap-

top is equipped with a 100-gigabyte hard disk, and I use external hard disks of 160 to 300 megabytes to per-

form daily backups and to use as my “near-online” storage of my image libraries.

If not for the purpose of auxiliary storage of your images, I strongly recommend having a large (300-gigabyte)

external hard disk to perform daily backups of your computer’s hard disk drive. These external drives don’t cost

much, but they will ensure that your valuable images and computer data will be protected. There are two types

of computer users—those who have lost data and those who will. Protect yourself!

http://www.colorvision.com
http://www.xritephoto.com
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Choosing and Using Optical Drives

Writable optical drives have become standard equipment on most computers today. At a minimum, optical

drives can read and write CDs and DVDs. There are still a lot of CD-readable/writable drives out there that will

read DVDs, but not write to them. My recommendation is to make sure you have an optical drive that can write

both CDs and DVDs.

CDs hold a little less than 600 megabytes of data—enough to hold all the photos stored on a 512-megabyte

memory card. DVDs will store nine times that amount, at about 4.5 gigabytes of storage. That’s a full day’s

worth of images taken at your favorite location, raw images or fine JPEG quality, with room to spare. As

megabytes increase with advances in digital camera models, you’ll need the extra storage space DVD-writable

optical drives offer. If your computer is only equipped with a CD-readable/writable optical drive, consider

upgrading to a new DVD-writable internal or external drive.

Using Graphics Tablets

Nature photographers have a

tendency to edit fine details in

Photoshop. Almost all of us

are used to using a mouse to

navigate around our com-

puter. You’ll find that many

professional retouchers (yes,

there are pros dedicated to

retouching photos!) use finer

tools to navigate around fine

details of an image. The tool of

choice is a graphics tablet.

A graphics tablet gives you

much more precise control

over the brushes and tools you

use in Photoshop. It’s like

retouching an image with a

Graphics tablets offer much more precise control for editing photos in Photoshop than a mouse

does. Photo courtesy of Wacom Technology Corp.
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pen or paintbrush in your hand, and the stylus is even pressure-sensitive. Wacom Technology

(http://www.wacom.com) offers a great line of graphics tablets starting at small sizes of 4×5 inches and going

all the way up to larger sizes, such as 6×8 inches or larger. For the price of a good memory upgrade, consider

swapping your mouse out for a graphics tablet.

Faster Downloads with Card Readers

One other goodie I recommend for any digital photographer is an external card reader. Digital cameras come

with USB or FireWire cables that connect to your computer so you can download memory cards directly from

your digital camera. This method works fine, except it’s slow and drains the digital camera’s battery power. For

less than the cost of a tank of gas (okay, for an SUV with a 30-gallon tank), you can purchase a card reader that

connects directly to your USB port and downloads your memory cards a lot faster than if you directly connected

your digital camera to your computer. Card readers typically accept all the popular card types—CompactFlash,

SD, XD, and even Memory Stick.

Summary

Equipping your permanent and portable digital darkrooms can get expensive and can drain your funds faster

than you can say “lawyer” or “insurance company.” You don’t need all the bells and whistles at once, but I do

recommend you buy the fastest computer you can afford with a writable DVD drive, 1,024 gigabytes of inter-

nal memory, and a backup external hard disk to start. With the hundreds or thousands of nature photos you take

a year and the computer resources Photoshop requires, you’ll be glad you did.

http://www.wacom.com
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N
ature photographers have special requirements for shooting than other types of photographers do. We

brave the elements and have to travel, hike, swim, fly, and boat to our locations. Often we are out in

the field for days or weeks at a time. We have to pack tripods, clothing, camera bags, protective

equipment for our cameras and lenses, batteries, filters, cleaning supplies, trail mix, Hostess cupcakes (smile),

and water. Not exactly a list of equipment to haul if you’re equipping yourself for a two-hour portrait shoot. Not

that there is anything wrong with that; I shoot portraits all the time!

The traveling nature photographer also has to deal with how to download, back up, and manage large image

files during extended periods out in the field. There might be locations in which you don’t have access to an

electrical outlet where you can plug in a laptop. Unless you’re carrying a number of 2-gigabyte cards with you,

what do you do to protect your images?

Preparing for shooting in the outdoors can be a task, and in this chapter I intend to shed some light on some

of the gear that will make your nature photography adventures a little easier and safer.

Tripods for Nature and Landscape Photographers

As a nature photographer, I shoot 98 percent of my photos on a tripod. It’s a habit I grew into years ago and I

can swear by the results. A tripod is the second most important piece of equipment you could ever use; the first

most important piece of equipment is a good tripod.

To help drive my point home, I’ll tell you a little story. While out on a recent photo trip to the American south-

west with my travel group, the Red Rock Five, I was shooting some scenes at Monument Valley, Utah. One

scene, shown in Figure 3.1, was particularly difficult. I tried different angles, but our tour leader had a better

idea—get as low as you can to obtain a better angle. It was a great shot, but I got lazy and thought I had enough

light for a sharp photo, even at f/22, so I hand-held the shot so I didn’t have to reconfigure my tripod. Wrong!

I noticed after I got the photo in Photoshop and zoomed in that parts of the frame were not focused to my taste.
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Figure 3.1  This photo was taken without a tripod. Further examination after zooming in shows where the image is

“soft” and not too sharp. This is bad if you want to enlarge your photo to larger than 8×10 inches.
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Different Tripods for Different Folks

When friends ask me what type of tripod they should get, I get stumped. That blank and confused look briefly

appears on my face until I formulate an answer in my head. After composing myself, I break the rules and

answer a question with a question: What type of shooting

do you do? You see, I can recommend a number of differ-

ent models of tripods, but the answer depends on what

type of shooting people do, how physically fit they are

(some of these three-legged wonders can weigh a lot),

what type of camera equipment they haul, and finally, how

much money they have to spend on one.

If you don’t have a tripod or you feel you need to upgrade

the one you have, keep the following criteria in mind:

■ Camera type. The type and weight of a camera

greatly determines the tripod you can use.

Nature photographers often take long hikes and

prefer to carry the lightest tripod, but one that

is sturdy enough to reduce any vibrations. If

you’re shooting with a compact digital camera

such as the Canon G6, Nikon Coolpix 8800,

or Sony DSC-F808, you’re probably not going

to need a 12-pound tripod; a lighter-weight tri-

pod should do the trick. The Hakuba MAXi-

343E, shown in Figure 3.2, weighs just 1.9

pounds and is easily strapped to your camera

bag for those long hikes. If you’re using a light-

weight camera, one of these sturdy, lightweight

tripods should do the trick. I should know; I

traveled across Wales and England with one

this year, and it was a pleasure not to haul a

10-pound tripod along. I was shooting with

lightweight cameras and lenses, and the

Hakuba served me just fine.

Figure 3.2  Hakuba sells sturdy, lightweight tripods that fold

to 17.5 inches and weigh less than two pounds. This is per-

fect for use with a compact digital camera, such as my Nikon

Coolpix 7900, shown here.
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■ Weight. The one determining factor that’s more

important than most others is the amount of

weight your tripod has to support. Although my

Hakuba was great for a compact digital camera

while traveling abroad, most of my shooting in

the field is with digital SLRs and big, heavy pro-

model zoom lenses. The combined weight of

my digital camera and zoom lens exceeds five

pounds, and I opt for my Manfrotto 3221WN

Wilderness Tripod, shown in Figure 3.3.

■ Material. Another consideration in your deci-

sion is the material your tripod is made of.

Metal is less expensive, but if you can, you

should seriously investigate purchasing a car-

bon-fiber tripod. These carbon-fiber models are

becoming very popular with nature photogra-

phers; they weigh a lot less than metal and are

a pleasure to take on extended hikes. Be pre-

pared to spend 50 percent more for carbon-

fiber models though; they are more expensive,

but to many of us they are well worth the price

if our nature photography adventures take us

on extended hikes.

■ Versatility. I hate using that word—it sounds

like I’m in advertising, which I’m not. However,

one of the features you want in a tripod is ver-

satility—the ability to not only extend the legs

wider than the standard setting, but also to use

interchangeable tripod heads. For shots where you need to get down low to the ground, you need

a tripod with legs that can extend outward, allowing you to mount your camera only 12 inches or

so off the ground. I’ve found this feature extremely valuable in the field. On some models, you can

even reverse the tripod stem and mount the camera upside down.

Figure 3.3  The Manfrotto 3221WN Wilderness Tripod is sturdy

enough to handle any digital SLR and lens combination up to 13

pounds, but it weighs more than eight pounds with a head.
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It’s All in the Head

When you make a decision about a tripod, the next thing you’ll need is a tripod head. The same rules used when

selecting a tripod hold true for selecting a tripod head. You’ll need to take into consideration the weight of the

equipment you’ll be attaching to the head, the type of head that will best fit the type of shooting you’ll be doing

out in the field, and of course, the price.

Basically, there are two types of tripod heads nature photographers prefer:

■ Pan and tilt heads. Pan and tilt heads are the most popular tripod heads used by photographers, and

for most of your nature shooting, a pan and tilt model should serve you just fine. Pan and tilt heads

allow you to move your camera vertically and left to right (for panning), and to flip your mounted

camera to the vertical position for shooting in portrait mode. Figure 3.4 shows a Manfrotto 3030

Pan/Tilt Head attached to my Manfrotto 3221 Wilderness tripod. It’s a sturdy head, more than a

match for my heavy lenses.

Figure 3.4  The Manfrotto 3030 pan and tilt tripod head is a very sturdy model that will serve

most nature photographers’ needs.
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Whatever tripod head you choose, make sure you purchase a quick-release model. A quick-release

trip head lets you attach a plate to your camera’s tripod socket, which in turn is inserted into a slot

on the tripod head, and then secured with an easy-to-use clamp you can tighten with your thumb.

Quick-release heads let you attach plates to multiple cameras and lenses with tripod mounts, giv-

ing you a fast option for changing cameras or lenses without screwing in your camera to a tripod

every time you want to use it.

■ Ball heads. I’ve had other nature photographers bug me because I’d often travel with only a pan and

tilt head attached to my tripod. Finally, on a recent trip, I tried a ball head. I immediately fell in love

with its versatility, and I can see why users of ball heads brag. They are fun to use and give you bet-

ter flexibility for shooting wildlife or scenes where you have to point your lens high, toward the sky.

Figure 3.5 shows the Manfrotto 484 Ball Head, like the one I’ve used in the field.

Figure 3.5  The Manfrotto 484 ball head is a popular model among

nature photographers.
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Caring for Digital Images in the Field

One situation portrait or backyard photographers (that could be us sometimes) don’t have to worry about is what

to do with our digital images while we’re away from our digital darkroom. At some point, you’ve probably

been hundreds or thousands of miles away from home, taking hundreds or thousands of digital images, and been

faced with the predicament of how to download images. You do have some options:

■ Bring plenty of memory cards. I’ve done this before—leave

on an extended trip overseas and decide to leave the com-

puter at home. You’ll need to make sure you have more

than enough memory cards, but for the cost of purchasing

a dozen or two dozen cards, you’re probably better off

investing that money into one of the other options

explained here.

■ Bring your laptop. If you’re fortunate enough to have a lap-

top computer with decent memory, disk space, and a CD

or DVD burner, you can download your images daily and

make backups to CD or DVD while you’re at it. When

you’re not out shooting, you can even play with your

images in Photoshop or rearrange your fantasy football

team!

■ Purchase an offline image storage/viewer. Like I showed in

Chapter 1, the Epson P-4000 or Nikon COOLWALKER

offline storage viewer (see Figure 3.6) is a great accessory

to carry in your camera bag, and it doesn’t have the size or

weight a laptop computer has. These little wonders sport

large-capacity hard disks, from 30 to 80 gigabytes of stor-

age. The Epson P-4000 also has slots for CompactFlash, SD

cards, 80 gigabytes of hard disk space, and a 3.5-inch high-

resolution display. The Epson model will even store music

files and movies for playback. For extended travel when

you don’t want to lug around a laptop with your luggage,

an offline storage device is a perfect companion for the dig-

ital photographer.

Figure 3.6  The Nikon COOLWALKER and

Epson P-4000 are great additions for your

camera bag and good alternatives to bringing

a laptop computer out with you when you are

shooting in the field or on extended trips.

Photos courtesy of Nikon USA and Epson.
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Camera Backpacks and Bags

While traveling, hiking, or just driving to a local park for some nature shots, nature photographers need to haul

cameras, lenses, and accessories. We all have camera bags—some are suited for the field, and some really

aren’t. A good camera bag can be the nature photographer’s best friend (see Figure 3.7).

Like ice cream, digital cameras, and computers, camera bags come in all sort of flavors. You can choose shoul-

der bags, backpacks, hard cases, and even models that have storage room for a laptop computer. When choos-

ing a camera bag, nature photographers have to take a few things into consideration. Try to take a few criteria

into account when choosing a camera bag for your photo excursions.

■ Type of camera bag. Some nature photographers prefer not to carry a camera bag into the field at

all. I’ve seen a lot of photographers leave their camera bags in the car and opt to wear a photo vest

instead. They look cool too, but if you’re toting more than one digital camera and an assortment of

lenses, a shoulder bag or backpack is probably the way to go. I personally prefer a backpack model

that’s waterproof and large enough to hold either my monster Manfrotto 3221 Wilderness tripod or,

even easier, my Hakuba 343 compact tripod like my setup shown in Figure 3.8.

■ Size. When choosing a camera bag, size does matter. Some of these models are big enough to carry

multiple cameras, large lenses, and even a laptop computer. If you’re athletic, over six feet tall, and

have a strong back, one of these bags could be right for you. Be careful, though; after you load one

of these large bags with equipment, it might be too heavy to carry! Make sure the size is right for

you and you’re not going to break your back carrying that bag around while out in the field.

■ Waterproofing. If you’re out shooting scenes in all types of weather, consider choosing a camera bag

or backpack that’s weatherproof. Many bags, such as the Lowepro, designate in their model names

“AW” for all-weather. Some even come equipped with built-in rain covers.

■ Tripod straps and pockets. Many computer bags and backpacks have straps or pockets to which you

can firmly attach a folded tripod. I think this feature is a must for long hikes; the ability to strap my

tripod securely to the backpack makes long hikes a lot easier.
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Figure 3.7  Nature photographers often prefer camera backpacks to take on their

travels. The Lowepro CompuRover AW (all-weather) gives you a weatherproof back-

pack for your camera and computer gear, all in one. Photo courtesy of Lowepro.

Figure 3.8  I prefer the Lowepro Mini Trekker. The backpack is big

enough for my digital SLR, three or four lenses, filters, trail mix,

bottled water, and either one of my tripods strapped in. As a bonus,

I can protect my bag from wet weather with a built-in rain cover.
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Clothes on Your Back and Shoes That You Wear

I’m not what you might call a well-dressed man. My typical outfit consists of jeans, black t-shirts, and moccasins,

except when shooting nature photos in the field. Depending on the type of shooting I’m doing and the typical

weather conditions, I transform my wardrobe to accommodate the conditions at hand. When shooting in 

the field, you’ll need to outfit yourself with appropriate clothing, or your outing can become a miserable 

experience.

When getting ready to venture out for nature shooting, keep these ideas in mind regarding clothing.

■ Shoes and booties. I consider wearing the appropriate footwear just as important as using the right

tripod for the job. For short hikes (a few miles or less) in any terrain, I’ll always recommend low-cut

hiking shoes. I wear the Columbia Omni-Grip type. These boots (or pairs like them) are lightweight,

moisture-proof, and have great soles for hiking in rocky, sandy, or grassy areas. For longer hikes, the

kind that take days to do, I recommend more appropriate boots designed for hikers. See your local

outfitter for more recommendations.

■ Pants and shirts. Any sports store or outfitter will offer pants and shirts that are designed for extreme

outdoor conditions for any season. Strongly consider visiting these stores; you’ll be amazed at the

offerings. It’s a good idea to have separate sets of clothing tailored toward winter, spring, summer,

and fall. For winter garb, go for warmth first, weight second. For spring, look for layered

shirts/sweaters, and for summer, choose lightweight shorts, pants, and shirts.

■ Hats. Being follically challenged, I especially need to wear hats on sunny days. Whether you’re

spending very short periods of time or extensive hours out in the sunlight, the sun is a sure recipe

for skin problems ranging from sunburn to, even worse, skin cancer. Make sure you protect your

head and face with a good hat. Baseball hats are okay for short excursions, but wider-brimmed hats

offer better protection for your face and neck. Always carry sunblock with you and use it wherever

possible—in all seasons, just not summer.

■ Jackets. I’m a big fan of those new-fangled fashion-correct ski jackets by Columbia, Head, Lands’

End, and other higher-end sportswear outfitters. They offer jackets with removable layers, perfect for

ever-changing outdoor conditions and for the outdoor photographer. If you’re out shooting in the

winter, pay attention to what skiers wear—they know how to keep warm in the extreme elements!
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■ Gloves. Unless most of your outdoor shooting is done in warm climates or during the summer, you’ll

need some good-quality waterproof gloves. I prefer gloves that offer warmth, moisture protection,

and rubber bases to make it easier for me to fiddle with knobs and buttons on my digital cameras.

When I’m out shooting in temperatures warmer than freezing, I prefer gloves with the fingertips

exposed. Carry both winter and fingerless gloves with you in your camera bag.

Ideas to Keep You Safer

As a nature photographer who has ventured into all sorts of distant and not-so-distant places over the years, I’ve

become more and more aware of safety while out in the field. As an example, I often travel to Michigan’s Upper

Peninsula for landscape shooting. It’s a five-hour drive from southern Michigan to northern Michigan, and it

really is different terrain between the two.

When I returned from one of my photography trips to the north, a friend of mine viewed photos I had captured.

Being from Michigan’s Upper Peninsula, he asked what I was “packing” during my long hikes through the

wilderness. I then described the camera equipment I used, and he immediately interrupted me and said, “I’m

not talking about camera gear; I’m talking about firearms.” I was not aware that in certain parts of the region,

there are many black bears roaming around. If you mistakenly walk into an area where there are little bear, the

mommy bear can get quite upset. I didn’t realize this, but I’m not a gun person. Since then, I always make sure

I hike in areas where I’m not in danger of coming across local residents that have black fur and big claws.

As a rule of thumb, always keep safety in mind and don’t venture into areas unless you know of all the dangers

involved. Educate yourself to the wildlife that is common to the area, and plan your photography accordingly.

A few safety tips I have for you when you are out in the wild include

■ Carry a cell phone. Whether you’re traveling alone or with other people, keep a charged cell phone

on your person at all times. If you are venturing to areas without cell coverage, like nature photog-

raphers often do, consider purchasing or renting a satellite cell phone.

■ Carry two-way radios. If you’re with another person or a group, carry two-way—or better yet, mul-

tiple two-way—radios with you. Newer models will reach miles, and when you’re with a group that

splits up during photo excursions, it’s a good idea to pass these radios out to the different groups.

You always want to be in communication with those you travel with for safety reasons.
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■ First-aid pack. It never hurts (sorry for the pun) to have a small first-aid kit in the car or in your back-

pack when you’re traveling. You want to make sure you have a supply of Band-Aids and assorted

over-the-counter meds to help you with bug bites, cuts, and other ailments.

■ Leave an itinerary. Whether you’re traveling alone or with others, always leave your itinerary with

loved ones or with the clerk at the hotel at which you’re staying. If you travel to national or state

parks, check in at the ranger station and let them know where you are planning to hike or drive to.

Make sure to check in with them when you return! If you are a nature photographer, you should

always let someone know where you are going and when you intend to return.

Summary

Outfitting for nature photography not only means equipping yourself with appropriate digital camera equipment,

but also outfitting yourself for comfort and protection from the elements. In addition to equipment and cloth-

ing, I also categorize safety when outfitting for an outing. Don’t underestimate safety, and always take precau-

tions for yourself and others who may be traveling with you. Remember, an ounce of prevention is worth more

than a pound of cure. When it comes to your well-being, outfit yourself with the best protection possible for

your nature-photography outings.
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A
h, the feeling of looking miles in any direction, not a soul in sight, awestruck by the natural beauty

around you. When you get there, you’ll know it—an epiphany, as nature photographers often get. It’s

those moments that make it worthwhile. Getting the shot helps, too—something that causes you to

beat your chest like a gorilla after you review it on your LCD. Don’t forget, getting there is half the fun—the other

half is shooting the scene with your camera (using good techniques, of course!), and then getting home to fin-

ish the images off in Photoshop. The memories don’t end there, either; when reviewing my nature photos and

all the landscapes I’ve visited, I’m instantly reminded of the moments and the people I’ve traveled with in those

special locations.

This chapter is all about shooting grand (and maybe some “little” grand) landscapes. It will cover getting there,

knowing the light, composing the shot, and fiddling with all those settings on your digital camera. Remember,

getting there is half the battle and half the fun, like climbing a mile and a half of rough, rocky terrain to get to

Delicate Arch, shown in Figure 4.1.

Figure 4.1  Delicate

Arch is within Arches

National Park, Utah,

but getting to this

“Holy Grail” of

western outdoor

photographers is

another story. The

hike is not for the

faint of heart, consist-

ing of a mile and a

half of steep ascent

in rocky terrain, but it

is well worth the shot

if you get there at

the right time.
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Finding Locations and Beating the Crowds

One of the great things about being a nature photographer is all of the endless photographic possibilities we

have on this Earth of ours. Some of our biggest challenges include picking the spots to photograph, getting

there, and knowing the best times to practice our craft. Some of us have more time than others to photograph

landscapes, as well as more freedom to travel. Most enthusiasts, however, have day jobs or other responsibil-

ities that restrict their travel and photography opportunities.

Whether you have all the time (and money) in the world or

you are restricted to when you can shoot, some challenges

still apply to all of us.

■ Pick your spot. If you’re going to venture away

from home and travel, pick a region that is rich in

photo opportunities. You may have been think-

ing of a region for a long time, and researching

areas is easy now with the aid of the Web, so

planning trips is much easier than it was 10 years

ago. You can easily book flights and hotel rooms

online without having to wait for a travel agent to

get into the office the next morning.

■ Don’t forget the critters. If you’re planning to pri-

marily shoot landscape photos on your venture,

consider the wildlife that’s present in the region

you’ve chosen to shoot and plan for some

wildlife shooting (with a digital camera!) while

you’re there. As an example, while out shooting

in Arches National Park, my group came across

deer (see Figure 4.2) while shooting rock forma-

tions at sunset. We weren’t there for the wildlife,

but we enjoyed 15 minutes of casual shooting

when the deer wandered into our area. Be pre-

pared for venturing creatures! Figure 4.2  When you are shooting landscapes, be pre-

pared at all times for wildlife that may walk through your

frame or even behind you.
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■ Plan your trip. Don’t underestimate the importance of planning trips in detail, especially if you’re

venturing out for more than a couple days. Give yourself plenty of time to get there. If you’re going

to have to fly across the country, or even out of the country, plan on your first and last days as travel

days. In other words, you’re going to be busy getting to an airport or bus station rather than out in

the wilderness shooting. Keep some simple rules in mind, such as knowing when it’s deer-hunting

season. You don’t want to be out there with those orange-clad gun-toting outdoorsmen (and out-

doorswomen) when they’ve been drinking beer for days at a time, they haven’t bathed, and they’re

carrying loaded rifles.

I like traveling in the off season to avoid the crowds.

I don’t think I’d ever plan a trip to Mt. Rushmore, for

instance, on Fourth of July weekend. You can’t even

get a hotel room within a hundred miles of the park,

or really anywhere else. I’d never schedule a

Southwest trip in the summer—not only are the parks

extremely crowded, but it’s really hot! Early spring

and late autumn are prime times to plan your trip—

the summer crowds are gone and you might even be

able to get close to Mesa Arch in the Canyonlands of

Utah. You definitely want to get your shots without 50

tourists trying to capture the sunrise and blocking your

view—not fun when you’re trying to get serious work

done at yet another “Holy Grail” of the Southwest

photo, such as the one shown in Figure 4.3.

■ Schedule your days. Before departing, you will want

to schedule each day’s activities. Trust me on this

one. You want to maximize your time at each loca-

tion, and the best way to do that is to write a day-by-

day itinerary. Take bad weather, travel time, location

scouting, meals, and rest (nappy time) into consid-

eration as well. If you’re going to visit the national

parks—there are more in North America than you

can ever cover in a lifetime—visit their Web sites to

find out where the highlights are. You can also find

Figure 4.3  Know the optimum times of the year to

travel to your target destination. Beat the crowds, and

you might even be able to get close enough to

capture coveted shots, such as Mesa Arch.



Digital Nature Photography and Adobe Photoshop

58



Chapter 4    Shooting Landscapes

59

out how long it takes to travel to different parts of the park, and many Web sites offer information

about how long typical hikes or driving tours take. Don’t forget to take your shooting times into

consideration! That’s what you are there for!

For more information on national parks, visit http://nps.gov/parks.html. The Web is full of great

resources, and chances are you’ll be able to click through a lot of worthwhile information you can

use for scheduling your days ahead of time.

■ Scout locations. When you hit the ground, try to take

some time for scouting good locations. I try to use

midday for driving around to find locations, espe-

cially on days with poor lighting, such as high-noon

bright sun. I log the area and judge what part of day

the lighting may be better, such as early morning or

late afternoon, when the lighting is more dramatic.

Bring a compass with you so you can calculate in

what direction the sun will be rising and setting.

■ Look for the best light. When shooting landscapes

and nature, light is everything. Plan and time your

shooting for the optimum lighting conditions. If you

want to shoot Mesa Arch, you need to arrive before

sunrise. I’d recommend an hour before the sun

rises—not just to get there on time, but also to get a

good spot. It’s a popular place and it gets very

crowded, to the point where you may not get a good

enough spot to shoot. From my experience, only

about 10 photographers can fit into the small area

available, and only three of those 10 photographers

get a good spot.

In addition to scoping out the best sunrise shots, look

for good sunset shots too. On good-weather days,

you only have about 15 minutes total of that “magic

light”—the time just before the sun rises above the

horizon, as in the photo shown in Figure 4.4, and

Figure 4.4  The “magic light” is the time just before

sunrise or the few minutes just after the sun sets over

the horizon. You can get dramatic colors at those times,

but usually only for a few minutes.

http://nps.gov/parks.html
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the time when the sun dips below the horizon in the evening. I start shooting before the sun rises

and after it begins to set. Light changes by the second, and I always try to be prepared for whatever

nature provides.

■ Have a weather backup plan. At times, all good plans can turn to muck. For shooting nature and

landscapes, don’t waste a rainy or stormy day watching Oprah on the TV back at your hotel—get

out and shoot the weather! You can add some dramatic shots that you would never get just by tak-

ing advantage of what nature gives you.

If you’re planning to visit a number of locations in a day but you get weathered out, stick with it.

Rainy days are great for forest shots—the wet weather darkens the trees and provides great contrast

of extra-saturated colors you’ll often see on rainy or misty days. If it’s pouring rain, shoot some land-

scapes through your car window. If you’re patient, you might get brief breaks in the weather, giving

you some time to get out of the shelter and set up your digital camera on your tripod to get some

shots, like the one in Figure 4.5.

Figure 4.5  If rotten weather threatens to ruin your outing, take advantage of it and make the weather

your subject matter.
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Light Is Everything

For all photographers, the most important part

and the most difficult part to master is getting the

right lighting for landscapes. Portrait photogra-

phers get to create the light they use for their

subjects with a mix of natural and studio light-

ing, but nature photographers have to rely on

what the particular nature conditions provide.

Though it’s not possible for the landscape pho-

tographer to control light, it is possible to arrive

at scenes when you know the light might be

optimal.

If I’m out shooting landscapes, I pay particular

attention to the clouds and how the light is

reflecting off my subject. I especially like partly

cloudy conditions in the middle of the day

because shadows are cast on my subjects while

streams of light break through, like in the land-

scape shown in Figure 4.6. When the clouds are

rolling over, be patient and wait for the light

that’s illuminating your subject to change; you’ll

be pleased with the results.

Don’t Let Bad Weather Ruin Your Day

When the weather gets bad, like when there are

clouds, rain, or rough storms, it’s not time to put

the camera bag back in the closet. Some of your

most dramatic shots can come from bad

weather. Don’t let the rain or wind ruin your day;

get out and shoot the weather.

Figure 4.6  Knowing when to capture the light is important. Be patient,

and the clouds will clear eventually!
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While out on a fall color shooting trip to northern Michigan last year, I ran into weather that consisted of storms

and 50-mph sustained winds for more than two days. Instead of staying in my travel trailer watching cable TV

(yes, I was really roughing it!), I decided to get out and shoot what I could. All it took was a drive to the

lakeshore, and I found what I wanted: high winds and beach grasses. Yes, my digital camera and I were pelted

with sand blowing in the 50-mph wind gusts, but the shooting was worth it, and I was pleased with the almost

abstract results I got, like in the photo on the previous page.

When the weather gets rough, I also point my lens upward and just shoot the sky. The sky is one of my favorite

subjects and is often overlooked by many nature photographers. When storms are coming, take some time to

just look up and make the sky the subject, rather than the landscape below it. Figure 4.7 shows some of my

more recent “skyscapes.”

Figure 4.7  Stormy weather makes for interesting skies. Point your lens upward, set your aperture at f/8, and use the

sky as your subject.
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Other tips for capturing great nature photos in bad weather include

■ Shoot foliage after it rains. I don’t recommend grabbing your digital camera and tripod to run into

the forest during a rainstorm, but right after the rain stops is a great time to shoot foliage. You’ll often

get some dramatic lighting from the sun peeking through remaining storm clouds, and the moisture

will darken trees for better contrast. Don’t be reluctant to capture reflections off your subject or

shoot with the light coming at you directly; you can get some interesting shots, like the one shown

in Figure 4.8.

Figure 4.8  Lighting can get interesting after a rainstorm. Be creative and take advantage of unique lighting conditions.
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■ Use a circular polarizer. As opposed to

making reflections part of your subject,

you can reduce reflections off of foliage

or other subjects by attaching a circular

polarizer to your lens. Rotate the polar-

izer to the point at which you see reflec-

tions start to decrease and colors start to

saturate. Experiment with your polarizer,

but be careful not to oversaturate your

subject, resulting in unnatural colors or

skies that are too dark.

■ Implement the 360-degree rule. If

you’re out shooting during or after a rain-

storm or snowstorm (or when you’re

shooting any subject matter), implement

the 360-degree rule. You might be out

shooting grand landscapes, but take a

360-degree view of the area you’re in.

Look up, look down, and don’t forget the

little things you normally wouldn’t think

of shooting, as shown in the close-up in

Figure 4.9.

Figure 4.9  By taking the time to observe all of the surroundings when

you're out taking photos, you'll discover subjects to photograph that

you might not have seen without implementing the 360-degree rule..
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■ Shoot the wind. If high winds (which often accompany storms and bad-weather days) are a prob-

lem when you are trying to get sharp photos of trees or grasses, don’t give up! Slow that shutter

speed down on your digital camera by shooting at a small aperture, such as f/16, or switch to shut-

ter priority mode and choose a slow shutter speed. Extremely blurred scenes can make for dramatic

photos, such as the windblown grass in Figure 4.10.

Figure 4.10  Don’t let high winds detract you from capturing landscapes. If the winds are high, slow down your shutter speed

and capture the movement of grasses or trees. Add extra color in Photoshop to “punch up” the image, and you can get

some wonderful abstract landscapes.
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Composition for Landscape Photos

Techie stuff is great to discuss, and there are a lot of photo geeks like us out there who can be considered “gear

heads”—that is, digital photographers who hunger for all the technical knowledge about megapixels and elec-

tronic wizardry. All that techie stuff is fine to talk about in forums or in camera clubs with photographer friends,

but all that electronic stuff ain’t worth a hoot when you get out in the field unless you have an eye for good com-

position.

To the nature photographer, composition is just as important as getting camera settings right. (See the next sec-

tion for more on this.) Having the correct white balance, aperture setting, shutter speed, ISO, and focus is a must,

but unless the composition in the actual scene you are capturing is set up correctly in your viewfinder or LCD,

you won’t get the results you want in your photograph. Knowing how to set up a scene before you take a shot

is key to making great nature photos.

There is a lot to be said about traditional photographic rules. I adhere to them often, but sometimes I like to

break them, depending on the subject matter. In my early years, my photo knowledge was basically self-taught,

consisting of a lot of reading and trial and error. However, I continually came across a few basic rules of com-

position.

■ Use the rule of thirds. The rule of thirds tells you that a landscape photo, whether it’s in landscape

or portrait orientation, needs to be divided into three parts. Consider a landscape photo in which

you have the foreground, the subject, and then finally the sky, as illustrated in Figure 4.11.

■ Don’t divide your photo in half. This rule is simple; if you’re shooting a photo, make sure you don’t

frame in two equal halves. For instance, for a simple landscape, balance your photo to show more

sky or more of the subject, but don’t give each an equal half of the frame, like in the bad example

shown in Figure 4.12.
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Figure 4.11  Illustrating

the rule of thirds, this

photo of the Three

Sisters in Monument

Valley shows the fore-

ground, subject, and sky,

divided into thirds.

Figure 4.12  When

composing your pho-

tos, make sure you

don’t divide the frame

in half; try to show

more of the top or

bottom.
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■ Offset your subject in the frame. This rule means if you have a subject, large or small, try not to have

the main subject perfectly centered in the frame, like in the first example photo in Figure 4.13; it’s

too typical! Cropping a centered image can give you a more dramatic effect for your photo.

Figure 4.13  Try to offset your subject matter in the frame to give a more dramatic image instead of keeping everything centered.

■ Keep everything in focus. Another rule nature photographers often hear is to have every portion of

a photo in focus. When photographing flowers or taking close-ups, I may break this rule (I like

breaking rules from time to time) by keeping my aperture setting wide open and only keeping a

portion of the photo in focus, like in the example shown in Figure 4.14.

Although rules are good to keep in mind when composing your nature photos, try breaking them once in a

while. For instance, sometimes I like my subject matter perfectly centered. At times, I don’t want the subject

perfectly sharp; I like to blur portions of some of my photos. There may even be instances when I actually want

my frame split into two equal halves. Rules were made to be broken at times, so don’t be afraid to bend them

a bit. You’ll give yourself more latitude to be creative.
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Figure 4.14  Sometimes a photo in which most of the subject is out of focus can draw more attention to the subject.
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Making Camera Settings for Nature and Landscape Photos

The one thing the nature photographer needs to technically master is the controls on the digital camera he or

she is using. I’ve stressed that the most important key to great photos is the composition, but you also need to

make sure your camera settings are correct to make sure you are capturing your composition correctly. To do

that, you need to know what settings are appropriate for each photo.

I get a lot of questions from many people who view my photographs, asking how I accomplished the shots.

You’ve probably had that experience too—showing off your photos and having people ask you, “How did you

do that?” My answer to them, especially if they’re photographers, is, “I use a workflow for every shot I take.”

I’ll give the person a few seconds to compose themself from the curve I just threw at them—after all, he or

she was expecting me to say something like, “I used an f/stop of 2.8 at 1/500 of a second.” However, that’s

not how I take my photos. I go through a progression of steps, also called a workflow, when I’m out in the

field shooting.

Shooting Workflow: Making Camera Settings

You need a workflow when you’re shooting. Everyone’s is a bit different, but this section includes some sug-

gestions to get you on the right track.

1. Evaluate the scene. The first step in my shooting workflow is to evaluate the scene. Don’t just slap

your digital camera on your tripod and begin shooting; take a few seconds and plan how you are

going to photograph the scene.

Think about how you want to “construct” the photo. For instance, if you’re shooting a grand land-

scape, you’ll want to choose how you want to meter the scene. You’ll probably either want to have

your digital camera’s light meter off of the sky or the subject. Additionally, you’ll want to select your

aperture setting and even white balance before you take the shot.
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2. Select orientation. As a rule of thumb, I usually shoot almost all of my photos in both portrait and

landscape orientations. The reason? Even though a particular scene might be best suited to “wide”

or landscape orientation, there is a chance that I might need that image for a magazine or book arti-

cle, which often dictates portrait orientation for full-page spreads. Additionally, I like to have both por-

trait and landscape versions of my scenes as a general rule because sometimes when I review photos

later on my computer, I change my mind and actually like the other orientation better! Best rule for

this step: Shoot your photos in both landscape and portrait orientations, like I did in Figure 4.15.

Figure 4.15  Shoot nature photos in both portrait and landscape orientations; you’ll have

more options for outputting your images to print later without having to crop.
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3. Place your digital camera on your tripod. Even though you might have plenty of light and you can

shoot at a fast shutter speed, don’t be tempted to hand-hold your digital camera while taking the

photo. As a reminder, always use a sturdy tripod for your nature and landscape photos. Your port-

folio will include sharper photos if you do!

4. Compose the scene. The next step is to carefully compose the scene in your viewfinder (if you’re

shooting with a digital SLR) or your LCD. Keep in mind that when you’re shooting photos outdoors,

it can be difficult to view the scene on a digital camera’s LCD. Most digital cameras also come

equipped with viewfinders; don’t forget that option to frame your scene. As I’ve mentioned, consider

taking the photo in both landscape and portrait orientations.

Take different versions of the shot by zooming in on the subject, and then zooming out. It’s also a

good habit to frame the scene, but leave yourself a little room—you never know whether you’ll

want to crop the image in Photoshop later. You don’t have to zoom out of every shot—just a little

bit is a good habit. If your digital camera packs a lot of megapixels, don’t worry; you’ll have plenty

of resolution to allow for some cropping later.

5. Choose the shooting mode. Most digital cameras offer a number of different shooting modes for you

to use. Nature photographers typically use aperture priority mode, allowing you to choose the aper-

ture setting for the photo while the digital camera chooses the shutter speed for that aperture set-

ting based on its internal light meter setting.

The aperture setting dictates the amount of light and depth of field that passes through the lens. The

aperture is actually a diaphragm that opens and closes according to the setting you’ve indicated.

Small aperture settings are actually set to the higher numbers, such as f/16, f/18, or f/22. Small aper-

tures give more depth of field or focus in your foreground, subject, and background. Large (or wide-

open) apertures, such as f/2.8 to f/5.6, allow you to focus on the subject but get a blurred foreground

or background, like in the photo shown in Figure 4.16. Figure 4.17 shows a photo taken with a

small aperture, set to f/22 in order to obtain sharp depth of field throughout the photo.

In addition to aperture priority mode, you can use shutter priority mode when you’re shooting in sit-

uations in which your subject is moving and you want to freeze the action, such as when you’re

shooting wildlife. When you choose shutter priority mode, your digital camera automatically sets

the aperture according to its internal meter reading. When shooting wildlife, I switch from aperture

to shutter priority mode if my subject matter is on the move.
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Figure 4.16  Using a

wide-open aperture

setting allows you to get

a focused subject with a

softened background.

Figure 4.17  Using a

small aperture setting

allows you to get a

completely focused

image from the fore-

ground to the back-

ground, which is

preferred for many

landscapes.
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Your digital camera will also offer preprogrammed modes, such as action, landscape, and portrait.

When you choose these modes, your digital camera automatically sets the aperture or shutter speed

according to the mode you’ve selected. For instance, if you choose landscape mode, your digital

camera will automatically set the aperture at a small setting, such as f/16, and then set the shutter

speed according to the metered scene. For portrait mode, your digital camera will use an aperture

setting around f/5.6 for less depth of field. In automatic mode, your digital camera will set the aper-

ture according to the median level of available light for the metered scene, and then set the shutter

speed accordingly. I only use automatic mode for quick snapshots.

Manual mode is used to take photographs in situations in which your digital camera’s meter can’t

evaluate what you want to capture. I often use my digital SLR’s manual mode, in which I select both

the aperture and shutter speed settings. Don’t get me wrong—our digital cameras’ internal light

meters do a great job, but if you’re shooting difficult lighting situations, such as the moon in the

evening or sunrise at Mesa Arch (see Figure 4.18), you might be better off going by instinct and tak-

ing test shots of the subject in manual mode to achieve the results you’re looking for in the image.

Figure 4.18

Sometimes you have

to rely on instinct and

use manual mode to

achieve the correct

exposure for a difficult

image to meter. I shot

this photo of Mesa

Arch in manual mode,

f/20 at 1/30 of a

second.
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For the most part, nature photographers often like to have control of the aperture setting and will

often use aperture priority mode for most of their shooting. I shoot mainly landscapes and some

wildlife (including people!), and I’ve gotten in the habit of shooting in aperture priority mode to

give me the most control possible of my depth of field.

6. Check ISO. The ISO setting on your digital camera is comparable to the ISO rating of film (you

know, that analog stuff we used to shoot with). ISO (formally referred to as film speed) is a numeric

setting used to represent the chosen light sensitivity of your image sensor. Digital cameras typically

let you choose ISO settings of 50 to 1600. Some digital cameras, such as the Nikon D70s, have a

minimum ISO setting of 200; other high-end models have ISO settings that begin at 50. As a rule of

thumb, you want to keep your ISO setting at the lowest number you can. If you’re shooting in low-

light situations, you might want to increase your ISO setting to 200 to 400 because this setting will

allow you to increase the shutter speed. Keep in mind that the lower the ISO setting, the better the

quality of images you’ll get.

On some older-model digital cameras, increasing your ISO setting to even 400 would result in very

noticeable image noise. Image noise increases as your ISO setting increases; you can recognize 

it by those colorful speckled areas of an image. If I’m shooting outdoors, I always keep my ISO 

setting to the lowest number on my digital camera to ensure minimal image noise and maximum

quality.

7. Set white balance. White balance is a feature of digital cameras that we didn’t have with film. White

balance lets you better adjust the camera to the type of lighting you are shooting photos with. The

ability to set the white balance is one of the biggest advantages to shooting digital. You can adjust

white balance to conditions such as cloudy, sunshine, shade, indoor lighting, fluorescent lighting,

or tungsten lighting. All of these lighting conditions provide different types of lighting your digital

camera has to interpret. Back in the old days when we shot with film, nature photographers would

purchase film that was optimized for outdoor lighting situations. If you were shooting indoors with

studio lights, you had to load special film into your camera so you wouldn’t get photos with an

incorrect color cast, which was difficult to correct in a color darkroom.

How does your digital camera know how to adjust for the lighting type? By measuring the color tem-

perature of the scene. Color temperature is measured on the Kelvin scale, with light being measured

on a scale of 2,000 to 50,000 degrees Kelvin.
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Now that you probably heard more than you wanted to about white balance adjustment, I’ll tell you

what you should do with the white balance setting on your digital camera. For most lighting situa-

tions, leave it on automatic! Your digital camera will usually do a great job of measuring the color

temperature of the scene. I’ve discovered that when I use the automatic setting on my digital cam-

era, the camera adjusts the color temperature correctly 95 percent of the time. For the remaining five

percent, I manually set the white balance to the mode I think is best, then take a few test shots and

view my results in the viewfinder, making any adjustments if necessary after that.

Figure 4.19 illustrates the difference among the different white balance settings your digital camera

offers.

8. Take the photo. This seems to be a simple step…or is it? If you’re shooting a scene at a slow shut-

ter speed, do you press the shutter button with your finger? When you do press the shutter button

on your digital camera, you’re introducing vibration, which can decrease image sharpness. If you’re

shooting at slow shutter speeds (1/60 of a second or slower), use your digital camera’s self-timer

option or use a remote shutter release designed for your camera. The self-timer or remote shutter

release will allow you to take the photo without introducing vibration to your digital camera.

9. Review the image. After I take a photo, I review the image on the digital camera’s LCD. I check the

preview in the LCD for sharpness first by using my digital camera’s image-viewing zoom feature. I

also check the image for composition, depth of field (aperture), white balance, and exposure using

my digital camera’s histogram feature.

10. Take more photos. After reviewing your photo, make any necessary adjustments, such as adjusting

your aperture, shutter speed, zoom, or even your composition, and reshoot your photo. If you were

pleased with the results, recompose the image for the other orientation (landscape or portrait).

While you’re at it, evaluate whether the scene you’re photographing is a candidate for a panorama,

shooting a series of three or four photos you can stitch together later in Photoshop.
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Figure 4.19  White balance

affects the color temperature

of your photos, as shown

when adjusted in Camera

Raw. When you change the

white balance settings on

your digital camera, you’re

actually changing the color

temperature and tint of your

image.

As shot, 5000° Kelvin Daylight, 5500° Kelvin Cloudy, 6500° Kelvin

Shade, 7500° Kelvin Tungsten, 2850° Kelvin Fluorescent, 3800° Kelvin
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Shooting Panoramic Images

Panoramas are becoming easier to accomplish because software easily allows digital photographers to stitch

together separate photos taken in succession, like the sunset over Lake Huron shown in Figure 4.20. Whenever

I’m out in the field shooting landscapes, I make a habit of evaluating my subjects for both individual photos

and opportunities for panoramas as well. Whenever possible, I shoot a series of shots to stitch together later on

my computer. I’m a fan of Photoshop’s Photomerge utility.

Figure 4.20  Shooting photos for the purpose of assembling panoramas in Photoshop requires a step-by-step process.
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Steps for shooting panoramic scenes include

1. Select a scene that’s either wide or tall. When shooting panoramic images, don’t get caught in the

habit of automatically shooting them in landscape orientation. You can also shoot a series of photos

with your digital camera in the vertical position! Shooting a series of photos in portrait orientation

is good for putting together grand landscapes in which you want to frame more foreground or back-

ground, like in the photo shown in Figure 4.21. This panorama consisted of five portrait orientation

photos taken in succession, then stitched together in Photoshop using the Photomerge utility.

Figure 4.21  Although most panoramic photos consist of three or four photos taken in landscape orientation, you can also shoot panoramas in portrait orientation.

2. Use a sturdy tripod. I always recommend shooting panoramas on a tripod. A tripod helps you

achieve the sharpest photos you can, especially when you’re shooting in low-light conditions in

which your shutter speed is below 1/125 of a second. Shooting panoramas on a tripod also helps

you keep your series of shots level. To keep your shots level, look through your viewfinder or LCD

and pan the scene from left to right (or top to bottom) to make sure your camera is level. If you see

that your panning is off, adjust your tripod head to level your camera as best as you can. You can

always utilize a leveling bubble, which some tripod heads come equipped with, or even an add-on

level that attaches to your digital camera’s hot shoe.
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3. Meter the subject matter of the scene. You need to have the same exposure for each photo taken

in your panoramic series. I recommend first taking a meter reading of the major part of your sub-

ject matter, then using that aperture and shutter speed, switching to manual mode, and dialing in

those settings. This will ensure that the exposure is the same for each photo sequence you shoot.

Additionally, manually set your white balance to the conditions in which you’re shooting, such as

daylight, cloudy conditions, or shade, because as you pan, your digital camera might change the

white balance setting.

4. Take a series of photos. To begin your series of photos to use in a panorama, start on the left of the

scene you’re shooting and take the first shot. Pan your camera to the right until you have overlapped

the previous shot by 1/3. Take the second shot. Pan to the right again until you’ve overlapped the

previous shot by 1/3 and take the photo. If your panorama requires a fourth frame, repeat the process,

overlapping the previous frame by 1/3.

5. Review your photos. Using your digital camera’s LCD, review your photos to make sure you

achieved the results you intended. Check to make sure your images are sharp and properly metered,

using the histogram to assist you in evaluating your exposure. Continue capturing different aspects

of the scene to make sure you captured the panoramic frames you know will make a great

panoramic.

Summary

Shooting nature photos isn’t as easy as grabbing your digital camera and running into your backyard to snap

some photos. I think digital photographers are a different breed who often do things other people don’t do. We

invest in outfitting for the outdoors (which looks cool—I like the style, personally), we lug around tripods with

expensive heads, and instead of taking vacations with our families, we often travel to distant places to capture

photos most people wouldn’t even think of.

Getting there is half the battle, and using good shooting techniques is the other half. Getting the final images

you want is worth all the bother you go through to get them. Use some of the tips and workflow suggestions

discussed in this chapter to improve the quality of your images. Repetition of good technique and avoiding short-

cuts are keys to becoming a better nature photographer.
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P
hotographing wildlife is another form of nature photography that takes you to the outdoors. Like land-

scape photography, wildlife photography is an art in itself. I know of many photographers who special-

ize in wildlife photography and could really care less about shooting the landscapes around them. That’s

okay with me; we all have our particular interests. Personally, I like to shoot a lot of subjects, but wildlife is

always high on my list. The tricks to capturing wildlife images are getting to where the wildlife is, knowing

techniques for taking photos of animals, and getting home safely without any harm done to you, the wildlife,

or their habitat.

Like many nature photographers, I don’t live anywhere

near one of the grand national parks. As a matter of fact, I

live in the city. However, traveling less than an hour in any

direction usually gets me out to where the wildlife is—usu-

ally of the animal kind. I make it a habit to spend many

Saturday mornings throughout the year driving to a metro

park located in southeast Michigan. It’s a little less than an

hour from my home, which is much closer to the city than

the average nature photographer would like, but there is an

abundance of wildlife living in their natural habitat, and I

never know what I’ll come across from Saturday to

Saturday. I often come across deer, ducks, and swans (and

an occasional wild turkey, like the one that once tried to

attack me—honest!).

Getting to Where the Wildlife Is

Whether you live out in the country or in the city, you

probably don’t have to travel far to take photos of wildlife.

Sometimes I don’t have to travel any farther than my back-

yard, which, by the way, has offered me plenty of wildlife

and nature opportunities for photographs over the years,

like the hawk shown in Figure 5.1. All I have to do is take

a seat on the patio, have my digital SLR ready with a long

telephoto lens attached, have my cup of coffee and maybe

a newspaper, and the wildlife actually comes to me. It’s

Figure 5.1  Travel as far as your backyard and you’ll be

surprised at the wildlife that surrounds you.
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my spring, summer, and autumn ritual. Even though I live close to the city, a few times a year I see a herd of

deer taking a stroll across my property—but that’s rare, and I haven’t caught any on camera yet.

Late summer or early autumn in the Midwest is a good time to hang around flowerbeds; that’s when the but-

terflies start feeding on blooming butterfly bushes, which are conveniently planted 10 feet from my patio. I can

spend hours just taking photographs of butterflies like the ones shown in Figure 5.2, all without having to travel.

Now, you might be asking what butterflies have to do with shooting wildlife, but remember, butterflies may not

be wild buffalo, graceful deer, or roaring lions, but they are classified in the animal kingdom, even if they are

small and don’t bite (at least I don’t think they bite…).

Figure 5.2  In most regions butterflies are in abundance only at certain times of the year. Doing a little homework and knowing their habits gives you a better

chance for some good shooting opportunities.



Digital Nature Photography and Adobe Photoshop

94



Chapter 5    Photographing Wildlife

95

Finding the Spots

We can’t spend the rest of our lives taking nature photos in our backyards, but it’s a start. If you’re like me, you

want to get out to the forest, mountains, jungle, plains, or even the ocean to capture photos of wildlife. We all

have our own habits for doing this, like my Saturday morning sessions at the park outside of the city or my yearly

travels to Michigan’s Upper Peninsula, but to get a more varied flavor of wildlife opportunities, keep the fol-

lowing ideas in mind.

■ Keep an open mind. If you’re venturing out to take photos of lizards in the desert, but instead you

come across some interesting rattlesnakes, go for it! Just don’t stick your hands in any holes. (I

learned that while traveling out West.) In other words, you might be planning to shoot deer in a for-

est, but if instead you come across a family of ducks that look pretty cute in the nearby lake, take

the time to photograph the duckies!

■ Choose locations carefully. Heading out for a day of shooting wildlife does take a little planning and

common sense. For instance, autumn is a great time for taking photos of wildlife combined with fall

colors for landscapes. One thing you’ll want to keep in mind is to avoid venturing out during hunt-

ing season! In many areas, deer hunting begins November first. I’d avoid venturing out for your pho-

tography at that time. It’s not a good idea to mix beer, shotguns, bows and arrows, and nature

photographers in the same region.

When choosing spots to do your nature and wildlife photography, do your homework on the loca-

tion. It’s never a good idea to trespass on private property. Think about venturing into state and

national parks that are known for their abundance of wildlife. Wildlife refuges can be found across

North America; these are great places for shooting wildlife. I’ve traveled to the Seney National

Wildlife Refuge a few times—it’s in the middle of Michigan’s Upper Peninsula and offers a wide

range of wildlife to photograph. Trails are well marked in refuges and parks, and their nature cen-

ters often offer guided tours or information on venturing out on your own, providing you with infor-

mation about the best spots to find wildlife. Stop by the information/nature center, and you’ll often

find the park staff more than willing to give you tips on the best times and locations for shooting.
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■ Understand your subject matter. Taking photos of birds is different than stalking bears for photo

opportunities. Birding is a science all on its own, and successful bird photographers know their sub-

jects and often are as educated as the best birders. A good bird photographer will know the species

common in a particular region, their yearly migration habits, and the best part of the day to locate

and photograph the birds. Other wildlife

photographers might be well versed in

the behavior of different species of bears,

their habitats, and how to approach (or

not to approach) their subjects. Before

venturing out to photograph a particular

type of wildlife, do your homework and

study your subject. You’ll have better

photo opportunities, and you’ll be safer

for it.

Different types of animals have different

reactions when humans are around. I

like to photograph deer and I know that

deer behave differently toward humans

depending on their immediate environ-

ment. When I see a herd strolling

through my yard, I know I can’t allow

them to see or even smell me, or they’ll

run like the wind. If I drive 45 minutes to

the metro park, the deer in certain parts

of the park are much more relaxed

around humans (see Figure 5.3) because

they have had more exposure to people

in their environment. It makes a huge

difference; in one part of the area I can

basically walk within six feet of a deer,

whereas in other places I can’t be within

a quarter mile without scaring the deer

away.

Figure 5.3  Deer will behave differently from one location to another,

depending on their exposure to humans. If they are used to seeing

people in their environment, they might let you get a little closer.
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■ Protect yourself. I’ve already mentioned the importance of keeping safety in mind when you’re ven-

turing out in the outdoors alone. The obvious precaution you can take is to never venture out into

remote areas alone. But that’s not always possible, so when you’re planning to go out to remote

areas for wildlife shooting, the same safety rules apply. Don’t venture out without letting someone

know where you are going, the time you’ll be arriving, and the time you’re expected back. Carry a

cell phone with you, but if you’re going to remote areas without cell coverage, consider investing

in a satellite or analog cell phone that might extend your coverage. Always educate yourself about

the indigenous species in the area you’re venturing to. You might be going out to take photos of

bunnies, but you need to be aware of the bears, alligators, tarantulas, scorpions, or snakes that might

also live in the area.

■ Protect the environment. In addition to protecting yourself, be mindful of the environment you are

visiting. If you’re camping out, don’t leave food lying around the campsite. Make sure any camp-

fires are properly ignited and properly extinguished. Check the guidelines in the various state and

national parks you’re visiting as well; each may have a separate specific set of rules. Most impor-

tant, respect the environment the wildlife is living in—you don’t want to disturb any of the natural

habitat. As a rule of thumb, leave the area as pristine as you found it.

Composition and Camera Settings for Wildlife Photos

As with landscape photography, I suggest you follow a rigid workflow when you go out in the field to shoot

wildlife photos. Most of the rules are going to be the same, but shooting wildlife poses specific situations you

need to address. Landscapes don’t breathe, run, or get mad when you get near their young. Depending on how

serious you are about photographing wildlife in the field, you might want to concentrate on learning patterns

of animal behavior, such as birds or deer if they are your primary subjects, and then approach the field with

those patterns in mind.

As a rule of thumb, follow a workflow. The following step-by-step process for taking wildlife photos will give

you some good guidelines.

1. Be ready. I learned a trick from friend and professional wildlife/photo tour leader John Baker: Leave

your digital camera in action mode in case you come across wildlife while traveling. If you come

across some critters—large or small—you can easily grab your camera, turn it on, and begin shoot-

ing. When your digital camera is in action mode, it will automatically adjust itself for a fast shutter

speed and change the focus mode to allow you to track moving targets—a perfect combination for

photographing wildlife.
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If you recall my story of the occasional herd of deer that like to trespass on my lawn, I’m always at

the ready. I keep a digital camera nearby in the house at all times, set to action mode, just in case

one of us in the house spots these graceful creatures strolling outside.

2. Evaluate the subject. It’s often difficult to anticipate what wildlife will do next, and some species are

easier to photograph than others. Deer will often run like the wind if you get too close, but horses

grazing in the wild, like the one shown in Figure 5.4, could care less what’s going on around them.

It gives you more time to evaluate the scene and frame your shot.

Figure 5.4  Some wildlife subjects cooperate well and even let you take the time to compose shots of them properly.
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One common mistake I see a lot of photographers make is centering their subject in the frame. If

you’re shooting in action mode, you might be faced with keeping the focus point of your camera

on-center, which does lend itself to centered action shots. I get around that problem when shoot-

ing wildlife by zooming out a bit more than I usually would, and then cropping later in Photoshop

so my subject matter isn’t perfectly centered.

3. Place your digital camera on your tripod. This might be tough to do for some forms of wildlife,

such as birds, but your rule of thumb is still to shoot as many wildlife photos as you can on a tri-

pod. Consider investing in a good ball head for your tripod; it will allow for more freedom of move-

ment while panning animal movements. As a reminder, always use a sturdy tripod for your nature

and landscape photos. Your portfolio will include sharper photos!

4. Compose the scene. The next step is to carefully compose the scene the best you can in your

viewfinder (if you’re shooting with a digital SLR) or your LCD. When shooting wildlife, you will

have many situations in which your subjects are on the move. Again, in those cases, you might be

lucky just to keep the images centered in the frame. Though it’s not a great habit to get into, you can

always crop in Photoshop later. Keep in mind that when you’re shooting photos outdoors, it can be

difficult to view the scene. When you’re shooting stationary wildlife—the ones that aren’t in a hurry,

like the horse in Figure 5.4—you’ll have ample time to compose your photo so you can avoid crop-

ping later.

5. Implement the 360-degree rule. This quick step is a reminder that when you’re out in the field com-

posing photos, you should remember to implement the 360-degree rule. Turn yourself around in a

full circle and look all around for other photo opportunities. Even if you’re concentrating on a flock

of geese or a distant deer, take a look around in all directions in your immediate vicinity, just to see

whether there are other photo opportunities you might not have noticed.

6. Choose the shooting mode. Most digital cameras offer a number of different shooting modes for you

to use. Nature photographers typically use aperture priority mode, which allows you to choose the

aperture setting for the photo while the digital camera chooses the shutter speed for that aperture

setting based on its internal light meter setting. For shooting wildlife, it’s not that cut and dried,

though. The wildlife photographer has to take into account movement by the subject and often has

to increase ISO (see the following step) or use a wider aperture setting in order to get enough of a

shutter speed to freeze the action.
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7. Set the ISO. As a rule of thumb, when I’m shooting wildlife I turn up the ISO setting to around 400.

This increases my shutter speed while leaving the chosen aperture setting as is. Be careful using

ISO settings above 400, because this is when image noise starts to become an issue on many digi-

tal camera models.

8. Set the white balance. Just like when you’re shooting any other subject, try using your auto white-

balance setting. If you’re getting color tints that don’t look kosher, try a manual white-balance set-

ting that best matches the given lighting conditions.

9. Focus. Back in the film days, I used manual focus

for most of my photos. Age takes a toll on eyesight,

and I’ve taken to depending on auto focus for most

of my shots. I’ve actually found that on today’s dig-

ital cameras auto focus is quite accurate, and I

rarely have to shoot in manual focus mode.

When focusing on wildlife, I use the same rule that

I use for my portraits of people—focus on the eyes!

Wildlife is no different than people when it comes

to photographs; you’ll find that the best wildlife

photos you take are where the eyes are the center

of attention in the photo, and you want that part of

the subject focused perfectly, like the distinguished

old pooch shown in Figure 5.5.

10. Review the image. After you take a photo, review

the image on your digital camera’s LCD. Check the

preview in the LCD for sharpness first by using the

digital camera’s image-viewing zoom feature. Look

at the image for composition, depth of field (aper-

ture), white balance, and exposure using the digi-

tal camera’s histogram feature.

11. Take more photos. After you review your photo, make any necessary adjustments, such as adjust-

ing your focus, aperture, shutter speed, zoom, or even your composition, and reshoot your photo.

If you were pleased with the results, recompose the image for the other orientation—landscape or

portrait.

Figure 5.5  Whether you’re photographing people or

animals, their eyes are the windows to their souls—and

the absolute key to great photographs.
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Go on a Wildlife and Nature Photo Tour

Getting photos like the ones shown in Figure 5.6 just doesn’t happen by accident. If you’re new to photo-

graphing wildlife, I highly suggest going on a trip with an expert. John Baker is a longtime nature photographer

who leads photo excursions all over the world. Many times a year, John leads photo tours for small groups, get-

ting to where the wildlife is, as well as guiding you to the grand vistas of their environment. I’ve had the pleas-

ure of joining John on one of his tours, and I highly recommend the experience to you. You can look up John’s

latest tour schedule by visiting his Web site at http://www.travelimages.com.

Figure 5.6  If you’re new to shooting wildlife and you want to have a great nature photography experience, consider booking yourself on a

photo tour. Photos courtesy of John Baker. © John Baker, 2006.

http://www.travelimages.com
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© John Baker, 2006
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Advantages to traveling with an experienced leader include

■ Better production. Let’s face it, if you travel on your own and you’re not familiar with the area, you

can spend a lot of time just learning the land. An experienced tour guide will save you a lot of time.

They know where to go and when to get there. What that means for you is greater productivity.

Instead of spending half your trip wandering around and scoping out areas of interest, with an expe-

rienced guide you’ll get to more places than you could ever plan on—and a lot faster!

■ Safety in numbers. When you’re on a tour with other photographers, you’re not alone! You’ll often

travel in groups and be guided along the way as well. It’s much safer that way, and a lot more fun.

What could be better than traveling and shooting wildlife photos with other photographers?

■ More economical. If you were to plan on a one- or two-week trip to the national parks to shoot land-

scapes and wildlife, it could cost a small fortune. I’ve found it more economical to book a trip that’s

already planned and take advantage of the group fares that are available.

Summary

Photographing wildlife is a lot different than just shooting landscapes. Wildlife, by nature (no pun intended),

tends to move around a little more and some have sharp teeth. All kidding aside, wildlife photographers quickly

learn that their craft is as specialized as a portrait photographer’s, but that it requires the skill of a sports pho-

tographer.

I can’t stress enough the importance of knowing the behavior of the wildlife subjects you are photographing—

each has its own unique characteristics and presents its own safety concerns. Like I’ve mentioned, for those who

are not full time wildlife photographers, I highly recommend traveling with an experienced guide and book-

ing yourself on a photo tour. It will be the best thing you’ve ever done. You’ll be safer, you’ll be in the great com-

pany of an experienced guide and other photographers, and you’ll be much more productive in the time you

are traveling. Trust me, you’ll get many more quality photos this way than traveling to areas with which you’re

not familiar, and it will probably save you money as well.
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I
f you want to be a little different than the typical nature photographer, you need to shoot things differently

sometimes, with your final product, the print, in mind. For many years I photographed classic scenes,

mostly landscape photos. I was proud of a lot of my work, but after years of shooting waterfalls and forests,

sunrises and sunsets, my tastes changed. While I still shoot a lot of traditional nature photos, I’ve added some-

thing different to my portfolio—abstracts.

Abstracts are photos that represent an object or scene in a totally different way, almost like creating a totally

different representation of what the object actually is. It could be an extreme macro of a portion of a flower,

leaf, or insect that is distorted using Photoshop to a point where you can’t immediately tell what the heck it is,

but the image is pleasing, like in the photo in Figure 6.1. It could be a manipulated section of leaves that you

photographed while using a slow shutter speed and actually panning the camera while the shutter was open.

The point I’m trying to make is that abstracts are what you conceive them to be. You can photograph abstracts

right out of your digital camera or manipulate the images later in Photoshop.

Figure 6.1  Abstracts are alternative representations of what a composition actually is.
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Abstracts aren’t for everybody’s taste; after all, art is appreciated on an individual basis. You might like Dali, but

I might prefer Picasso (actually, I like both). The purpose of this chapter is to point out an alternative way of pro-

ducing nature photographs and to open your repertoire to other artistic nature possibilities. Besides, there’s a

pretty good chance that you already have these gems in your portfolio; creating abstracts can be a way of res-

cuing lost treasures.

Capturing Abstract Images

Abstract nature photographs are really a difficult concept for a traditional photographer to grasp. You really

have to turn your imagination loose to be able to visualize a nature subject as an abstract, photograph the sub-

ject, and then finish the work in Photoshop. It’s a new way of thinking while you’re shooting, and it can even

be a fun exercise for a typical photo outing.

Another way to capture abstracts is to go to your image library. Honestly, most of my abstract in nature images

were conceived after the fact. I would be out in the forest capturing fall color for days, and when I was review-

ing images later on my computer, I would pick just certain parts of a photo and then work with them in

Photoshop to create my abstract. Similarly, I could be out shooting mountain ranges or high-desert scenes,

using traditional photographic techniques. The photos would look great later as I processed them, but I might

take a few and really mess around with them using Photoshop filters and other techniques.

Rescuing Lost Treasures

Rescuing lost treasures is a description I often use to describe digging into your old folders of digital images,

opening ordinary nature images, and them turning them into abstract works of art. I make it a habit to not

delete digital images just for this reason. I know a lot of photographers who will go out and take 200 images

on a photo outing, and then delete a good percentage of them when they download them and view them on

their computer. After all, why save the duds and take up disk space?
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My approach is to archive everything I capture. I often go back weeks, months, or even a few years later to view

a batch of original images, and then I start messing around with the images in Photoshop. I might do some

extreme cropping, blurring, or adding color (sometimes outrageously), and then I might apply some filters.

Often, I come out with an artistic piece like the one shown in Figure 6.2. The point is, don’t chuck ordinary

images you wouldn’t normally add to your nature portfolio. You can always rescue these images and produce

a work of art!

Figure 6.2  Take an ordinary photograph, such as a photo of a campfire, and then turn it into an abstract.
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Choosing Abstract Subjects to Photograph

One good thing about abstracts is that you can find them in almost any nature subject. It might take a macro

shot, an out-of-focus attempt, or some extreme color saturations in Photoshop to do it, but if you look hard

enough and concentrate on abstract representations of your subjects, you’ll be amazed at what you can find.

As I mentioned earlier, you can also find abstracts in images you’ve already shot—just go perusing through

your image library and you’ll find them. It could be a simple close-up photo of part of a waterfall, like the one

shown in Figure 6.3.

Figure 6.3  A zoomed-in part of a waterfall is abstract in itself. Adding color and lens effects to the same image can give it

an entirely different perspective.

Original image Enhanced in Photoshop
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If you’re going to venture out in the field to purposely look for abstracts, keep these tips in mind:

■ Look for portions of a scene that are

already abstract. You might be out taking

nature photos of a sunrise or sunset. Look

for color in portions of the clouds. If you

have a long enough zoom, try zooming in

on just that portion of the sunrise or sunset.

It could be an image you can use later to

knock the socks off people you show it to.

On the same note, you could be taking

photos of reflections of foliage in a river.

Again, look for something in the reflection

and zoom in on it, like in the example

shown in Figure 6.4.

■ Look for color in your subjects. You might

find that color is the key to abstract

images. Your photos don’t need a lot of dif-

ferent or complex colors like the one

shown in Figure 6.4; they could have sim-

ple colors. The key is, make color the main

part of your subject matter.

■ Don’t delete those blurred photos. As

shown on the next page, you can rescue

those blurred photos. Don’t delete them

when you view your images on your LCD

when you’re out shooting. A little cropping

combined with some interesting color sat-

uration can give you an image you never

thought you’d have!

Figure 6.4  Simply zooming in on just a portion of a scene can turn

an ordinary photo into an abstract.
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■ Look for patterns in nature. Some of the

best abstracts come from identifying pat-

terns found in nature and exploiting those

patterns for abstract photos. By changing

the way you compose an image in your

viewfinder or on your LCD, you can turn a

good landscape into an even better

abstract, like the photo of the Mexican Hat

area of southern Utah shown in Figure 6.5.

Summary

Abstracts are basically what you make of them. You

might run into some art lovers who will argue what is

an abstract and what isn’t, but to us, their opinion

doesn’t matter. Just that fact that you’ll get an occa-

sional argument makes it worth the effort.

You can find abstracts in many of the areas you’re

photographing; you just have to look for them. I try to

first look for patterns, and I almost always look for

color I can capitalize on. If your digital camera has a

macro mode or if you have a macro lens for your dig-

ital SLR, take advantage of it to get close-ups of flow-

ers, leaves, or rocks. Close-ups make for great

abstracts, and with a little finesse in Photoshop, you

can really draw a lot of interest in your photographs.

Last, I highly recommend viewing some of those oldy-

moldy images you never paid attention to in the past.

Blurry images can make for some great abstracts if you’re in the mood to be creative, so hopefully you’ve saved

some of those. Taking time to create abstracts from old images is a worthwhile exercise, and I’m sure you’ll pro-

duce images you never knew you had. You might even impress some of those artsy types!

Figure 6.5  Simple patterns in nature make great abstracts—the

simpler the better.
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I
n the previous chapter, I showed you how you can

fairly easily produce abstracts from nature scenes

that you’re shooting and how you can rescue other

images from lost archives to create artistic images.

Another alternative method to capture nature and pro-

duce provocative images is to either zoom in on sub-

jects or shoot macros of nature.

Close-ups and macros (yes, there is a difference) are

two other ways to represent objects as you see them.

These methods are overlooked by many nature pho-

tographers—just go on the Internet and view a few

nature photographers’ portfolios, and you’ll see my

point. Making a conscious effort to look for close-up

and macro opportunities will greatly enhance your

nature photography portfolio and expand your

approach to capturing images.

Close-Up Photography

Close-up photography can be described as capturing

images up close. (Pretty simple, right?) It could be an

image of a plant or a tree—the only difference is that

you’re zooming in on only a portion of the object

instead of the entire thing. As nature photographers,

we can be so regimented that we don’t even look at

the small area; we’re always concentrating on the

grand landscape. Getting in close, like in the image

shown in Figure 7.1, can give you a dramatic repre-

sentation of the original scene. Just expand your

thought process.

Figure 7.1  Getting in close is another way to represent an

object. Not all nature photos need to be shot at a wide angle

with a foreground and background as part of the image.
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You don’t need any special equipment to shoot close-ups, just a tripod, a good digital camera, and a good lens.

The simple workflow I use to shoot close-ups includes the following steps.

1. Implement the 360-degree rule. As you might recall, I suggest you always take a moment at each

location in which you’re shooting nature photos and turn your body around 360 degrees, carefully

looking at everything far and wide, as well as looking down for something small. You might be at a

location to shoot a mountain range, but if you just take the time, you might find a plant, desert

flower, or tree that gives you some interesting close-up or macro opportunities.

Keep an open mind and always take advantage of all interesting objects in a given area. Your port-

folio of nature subjects will thank you for it! It’s hard to break old habits, and all of us have a ten-

dency to look for the grand subjects, but looking around for the small stuff can increase your sphere

of objects to photograph.

2. Place your digital camera on a tripod. When you are getting close to subjects, a tripod is a must,

even though you might be shooting an object at a faster shutter speed. For close-ups you need to

get in close, and often it will be a lot easier to hand-hold your camera to get the shot. Try to get into

the habit of taking an extra 30 seconds to properly set up your digital camera on a tripod. The over-

all quality of your close-ups will improve!

3. Use a self-timer or remote shutter release. When you’re getting in close, it’s important to ensure your

images are the sharpest and best quality they can be. Normally, if you shoot your photos by press-

ing the shutter, you’re introducing vibration to the camera, which often results in blurred images.

Using a tripod and then using the self-timer or remote shutter release on your digital camera will

help reduce the vibration.
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4. Change your composition. Don’t rush your shooting, but do take your close-ups at different angles,

change the lighting, and vary your focus. You can change focus by shooting wide open, adjusting

your aperture to a larger setting, thus reducing the depth of field. On the other hand, you can close

down (also referred to as stopping down) your aperture, allowing for a more focused foreground and

background. Additionally, try to capture different aspects of the subject by zooming in and then

zooming out, like I did with the ear of corn in Figure 7.2.

5. Review your images. Don’t forget to take the time to review your images as you’re shooting them.

Look for proper white balance, focus, and exposure. Make any necessary corrections, and then take

more photos!

Figure 7.2  When taking your close-ups, zoom in and out and take several photos. You’ll get more usable

images in the long run.
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Figure 7.4  It’s easy to get lazy

and hand-hold macro shots—as a

matter of fact, a tripod is almost a

must for macro shots because you

need to keep the camera vibra-

tion- and movement-free for the

sharpest results, especially when

you are shooting at a low ISO

setting of 50 or 80.
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Figure 7.3  My little pocket-sized Nikon Coolpix 7900 gives me better

macro results than all the other digital or film equipment I’ve ever used.

Digital Macro Photography

Digital cameras have given us the ability to shoot objects from very close up—this is called a macro. Film cam-

eras didn’t give you this ability unless you had a special lens attached, a macro lens. Many digital cameras with

built-in lenses give you excellent macro capabilities with results that, as far as I’m concerned, outperform their

old film-camera counterparts.

You can create a macro when you have the ability to produce high enough magnification to fill an entire dig-

ital sensor frame with a close-up object. The magnification results are rated by a 1:1 ratio, or “real-life size” pro-

portion, to the image sensor. For instance, if you photograph a leaf with an actual size of 20mm measured

horizontally, that same section of the leaf will fill up the image sensor with an approximate 20mm size.

Since I’ve been using digital cameras, I find the best results don’t come from my expensive digital SLR equip-

ment with those big expensive lenses. My best macros come from my compact, all-in-one digital cameras,

such as my little Nikon Coolpix 7900, pictured in Figure 7.3. The little guy fits in my pocket and allows me to

take great photos for a carry-around camera. I keep it with me to shoot macros of flowers, which I do quite often.

Additionally, I take it out in the field with me, just in case I come across any objects I want to capture macros

of. I always take my macros with the camera mounted on a tripod, as shown in Figure 7.4, using the digital cam-

era’s self-timer.
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With digital cameras with sensors smaller than

35mm film and lenses that are 3× (three times

zoom multipliers) or 4×, you can understand how

many compact digital cameras can have excel-

lent macro capabilities. Many of these compact

digital cameras also come equipped with macro

mode, which adjusts the auto focus to allow you

to focus on subjects as close as less than one inch

from the lens, enabling you to get results like the

macro of the flower in Figure 7.5.

If you’re using a digital SLR, there are many

accessory lenses you can purchase that can give

you up to 1:1 magnification, which will fill a dig-

ital camera sensor with your subject. You can also

look into extension tubes (optical add-ons for

normal SLR lenses). An additional and economi-

cal accessory is a close-up filter, which attaches

directly to your lens filter thread. Canon, Nikon,

and other popular filter and lens manufacturers

offer these options to help you get close up to

your little subjects.

Figure 7.5  Macro mode allows you to focus on subjects almost as close

as the lens, sometimes within an inch.
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Close-Ups and Macros in the Studio or the Home

I live in a region of the country where we get three or four months of gray, cold, wet, snowy weather. Every 

few weeks we’ll get a really cool snowstorm, and when it’s finished snowing, you can get some great winter

shots. The rest of the time, we’re stuck with lousy Midwest weather. What a great time for some studio shots of

flowers!

Don’t let the yuck times during the year make you forget you have a digital camera. You have a home (or, if

you’re lucky, a studio), a tripod, a digital camera, maybe some flash or flood lights. Put them to use with your

creativity. Take an afternoon and set up your studio for some close-up and macro shots of flowers or plants.

Try to keep your setup simple and use some of these tips for indoor shooting of flowers, plants, or anything else

interesting.

■ Use natural light. I’ve found that the natural light that pours in from windows can make for a great

light source, especially on days when it’s cloudy. The light on those days is nice and even and dif-

fused. Take advantage of nature’s light box.

■ Use a flash. I use a wireless flash system with my digital SLR for a lot of still life shots and some-

times even flowers. If you have an external flash, or even a few, try tabletop setups where you can

illuminate your subject from different angles so you can get some even lighting while reducing

shadows.

■ Use a daylight-balanced light source. If natural light isn’t going to cut it or if you don’t have strobes

at your disposal, you can still build yourself a great lighting setup cheaply. If you visit your typical

“big-box” home store, you’ll find that they carry those new daylight-balanced fluorescent screw-in

light bulbs. These bulbs last forever and are set at 5000 degrees Kelvin, which is pretty close to day-

light. With some inexpensive reflectors, you can build yourself a pretty good indoor lighting setup.

■ Use a backdrop. For dramatic shots of flowers and plants, consider using a colored backdrop. I pre-

fer black as a backdrop for colorful flora because it adds a dramatic effect to my images. A cloth or

large sheets of paper will often do the trick.
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■ Make color part of your subject matter. When shooting flowers, I always pick a species that gives

me dramatic color. I like color! When contrasted against a dark background, your close-ups and

macros will appear to jump out, giving you that wow factor when you show your work. Figure 7.6

shows some examples of flowers photographed using simple materials found around the home,

such as natural light and a dark background.

Summary

Close-up and macro opportunities are often overlooked as we search for images of a grander nature. To broaden

your horizons, make shooting close-ups and macros a part of your everyday work. Even if you travel halfway

around the world to shoot nature and grand landscapes, pay attention to the local flora. Chances are, you’ll see

a whole new world you’ve never seen or photographed before.

Figure 7.6  You can easily put together a studio setup to photograph flowers on those days when you’d rather not venture outdoors.

Nature photography doesn’t always have to take place outside!
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M
anaging hundreds or thousands of digital images on your computer is no easy task. On any partic-

ular day out shooting nature photos, I can come home with easily 500 images, especially if I’ve been

bracketing my shots. In any given year, I can shoot between 10,000 and 20,000 images. Even if you

shoot a lot fewer images than that, managing all those files can be a task. If you don’t have a good system to

manage them, anarchy will arise!

Because I use Photoshop as my image editor, I use Bridge as my file-management application. Why not? Bridge

comes standard with all Adobe CS2 applications and it’s the best tool for the job. You can think of Bridge as

your digital “light table,” an image file system with a whole lot of bells and whistles to boot. I can use Bridge

for almost all of my image management, including viewing my images on my virtual light table—the computer

monitor. Bridge is an upgrade to the File Browser we came to love in previous versions of Photoshop. It’s now

a standalone application that can be launched independent of the Creative Suite programs or from within

Photoshop. Bridge provides better integration between the Creative Suite programs, but if you only use

Photoshop CS2, it works great as your standalone or integrated program to organize, browse, and locate pho-

tos. Bridge also serves as the launching point to process raw images in Camera Raw, which I’ll cover in Chapter

9, “Using Camera Raw.”

Before diving into Bridge, you need to think about file management. You’re probably currently downloading

images to a variety of places on your computer, such as the My Pictures folder or other folders you’ve created.

Consider coming up with a plan, a system of file management where your images can be stored that will closely

resemble your own image editing workflow.

Creating a File Management System

As a nature photographer out in the field shooting great photos, you’ll be eager to get back to your computer

so you can mess around with your shots. After downloading your images, you’ll be excited to open Bridge, view

the images you’ve just taken, and then process the best of the litter. The next thing you know, you’ll have run

the nature images through Photoshop, made a few prints, and then moved on to something else, such as cruis-

ing the Web to do some shopping for more digital camera gear! The downloaded images will then sit in their

folders, maybe soon to be forgotten.

If you’ve been using a digital camera for a while now and you take thousands of nature and landscape photos

like I do, you’ve probably noticed how quickly images pile up on your hard drive. Every time you download

photos from a memory card to your hard drive, you could be adding hundreds of digital images to an already
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crowded storage space, one gigabyte at a time. They then sit there, pile up, reduce the amount of available disk

space, and maybe even get lost or forgotten.

Whether I’m shooting nature images in the field, downloading pictures, organizing files, or working with images

in Photoshop, I have a workflow for everything. As a review, a workflow is a step-by-step progression of actions

you take on a consistent basis to ensure that proper techniques are consistent from shooting a photo to creat-

ing the final print. An image-management workflow will work equally well when you’re managing those hordes

of images I’ve been warning you about. By spending a few minutes planning your file management approach,

and then by following your workflow, you’ll be much better organized, more productive, and saner. And best

of all, it doesn’t cost you anything!

Creating a file-management system starts with two simple tasks:

■ Plan how to organize and store your images. All photographers have different needs. Make a plan—

the simpler the better—to organize all of your images, not just your nature stuff. If you’re like me,

you’ll have nature images divided between wildlife photos, landscapes, macros, and maybe even

abstracts. Like many nature photographers, you might also have images of family, friends, or even

some commercial clients for whom you shoot images. You need a plan of organization to keep all

of those images straight.

For your nature photos, you might want to separate images into categories, such as plants, animals,

flowers, or geography. You can also divide up your images by region, such as the Midwest,

Southwest, or even the Antarctic region. (I hear it’s cold there this time of year—well, any time of

year!)

■ Create folders to store categorized images. Whether you’re using a Windows PC or a Mac, first

create a master folder to contain all your original, working, and final output images. (I call my mas-

ter folder Digital Images, but you can name yours anything you want.) The next step is to create sub-

folders within your main images folder to classify each major step of your workflow.

With the thousands of shots I shoot each year, I try to keep it simple. I set up a master folder called

Digital Images. Within that folder, I set up folders for all my original images, working images, and

finally output images. Figure 8.1 shows my basic folder structure.

■ Back up all of your images in one step. When all of your images are contained in one folder (that

contains all of your subfolders), backing up to a CD, DVD, or external hard disk or file server

becomes a lot easier.



Chapter 8    Using Bridge to Manage Your Nature Images

135

Simple Steps to Managing Files

Now that you’ve thought about your strategy for how you are going to store and back up your image files, con-

sider following a simple workflow for your everyday work. The following steps might not exactly match how

you approach your work, but you can use them as an example of an image-management workflow.

1. Make a backup in the field. I haven’t spoken of this in detail, but if you’re out on an extended field-

shooting expedition, consider carrying a portable storage device, such as the Epson P-4000 or even

an Apple iPod. These devices are small and battery-powered, and they can also play music and

audio books! In the case of the iPod, you can also watch downloaded TV shows and the like, if

you’re into that sort of thing! (I’m getting acquainted with my new iPod 60-gig model. See you in

six months!) Getting back to digital images, I recommend making backups of your memory cards if

you’re away from a computer. Memory cards can easily be lost or damaged in the field, and one

more line of defense doesn’t hurt.

An additional piece of advice I have for when you’re using a portable storage unit in the field is, don’t

be comfortable enough to reformat your memory cards after you’ve downloaded the images to your

iPod or other portable device. These devices can fail or get lost too! I only recommend using these

devices for backup purposes (and on a temporary basis, at that) until you get your memory cards

downloaded to your computer.

Figure 8.1  All you need is one folder to hold your

original, working, and output folders. Backing up all of

your images will be easier when they are all held in one

folder.
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You might think this step is a little excessive, but I’ve heard horror stories. Recently, a friend of mine

lost most of his shots when he misplaced a 2-gig memory card on an airplane on a trip back to the

U.S. from eight days of shooting in England. He wasn’t a pro, but most of his shots, including those

of Stonehenge, London, Avebury, and Wales were lost.

2. Download your memory cards to your computer. The first thing I do when I get back to my hotel

room, my office, or my home after a day of shooting is immediately download my images to my

computer. I create a subfolder in my Original Images folder, usually named in sequential order with

a date and a descriptive name for the images taken that day, such as IMG0041 May 30 England,

IMG0042 May 31 England, and so on.

3. Back up your images to DVD, CD, and/or a backup hard disk. Right after downloading my images

to my Original Images folder, I back up to DVD—twice! A DVD holds more than 4.5 gigabytes of

data, or more than four 1-gig CompactFlash or SD cards full of images. I often go through at least

four or five cards when shooting nature photos all day; raw images are quite large. One DVD usu-

ally holds 500 or 600 images, depending on the size of the files you are capturing. I make two

copies of my DVDs, one to keep onsite in my image library and one to keep offsite in my safety

deposit box.

You can purchase blank CDs or DVDs inexpensively now, and great bargains are available at your

local computer and office supply stores. Whether you’re using CDs or DVDs to archive your images,

be aware that optical discs are not all alike. CDs and DVDs, like many things, are available in dif-

ferent levels of quality.

There are some cheap discs on the market, but they might be cheap for a reason. They might scratch

easily or they might be susceptible to quicker chemical deterioration than other discs. When buy-

ing blank CDs or DVDs to archive your images, buy name-brand premium discs, such as Delkin

Archival Gold or Verbatim DataLife. These discs are supposed to hold up for many years, even

decades if they’re carefully handled and stored.

Backing up twice to optical disc might seem a bit extreme, but your original images are like your

original negatives—if they get lost or destroyed, you always have an extra copy offsite as a last resort.

I learned this the hard way 28 years ago, when all of my negatives were destroyed in a fire. All of

my high school and college photographic work was wiped off the face of the earth in one night.

Luckily nobody was hurt, but my negatives were destroyed.
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4. Back up your hard disk. In addition to backing up my original images to DVD or CD, I also back

up my Digital Images folder to an external hard disk every night. You can never have enough back-

ups of your important image files and documents. As my technical editor tells me, “There are two

kinds of people—those who have lost data and those who will….”

If you don’t have an external hard disk to make nightly backups of your data files—not just your

images, but all of your other personal work—I recommend getting one. You can purchase external

hard disk drives with capacities of more than 300 gigabytes for less than the cost of a couple of

memory cards. For a couple hundred bucks, you can rest easy knowing that your valuable data is

protected in case your computer’s hard disk fails.

5. Use Bridge as your image-management system. The next step in the image-management workflow

is to work with your images using Bridge. I know you were probably wondering when we would

get to that subject, so here we go!

Managing Images with Bridge

After you get your images to your computer and organize them in a basic folder structure, your work is just

beginning. Bridge is a standalone application that can be started on a Windows PC or a Mac independent of

Photoshop.

You can start Bridge a few different ways.

■ From the Start menu in Windows or from the desktop on a Mac

■ By clicking on the Go to Bridge button on the Photoshop option bar

■ From Photoshop, by choosing File, Browse

You can use Bridge to perform quite a range of tasks as you organize your photos.

■ Browse your images. Bridge is, first and foremost, a great image browser. Bridge enables you to

easily navigate all the hard drives and folders on your computer for images in an intuitive graphi-

cal interface. If you’re used to using Windows Explorer, you’ll immediately be comfortable. Figure

8.2 shows the Folders tab as viewed in Bridge.

■ Open your images directly in Camera Raw or Photoshop. Double-clicking raw-image thumbnails

in Bridge will automatically open the images in Camera Raw. If the image selected is in another file

format (such as JPEG, TIFF, or PSD), the image will be loaded directly into Photoshop. It’s a lot eas-

ier to double-click a thumbnail than it is to use the normal File, Open route to open files.
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■ Add metadata to your images. For most of my work, one of the first things I do when I’m viewing

newly downloaded images is add metadata to each image. Metadata is information about the images

that will help further organize the files. Your digital camera provides some metadata, such as the date

the image was taken, as well as the camera’s shutter speed, aperture, and ISO settings. You can add

more metadata in Bridge, such as copyright information or a text description of the photo, by enter-

ing that information in the Metadata tab, as shown in Figure 8.3.

Metadata is stored in a sidecar file that’s kept in the same folder with your images. When you are

viewing thumbnails in Bridge or editing photos in Photoshop, that metadata is retained.

Figure 8.2  Bridge provides an interface similar to

Windows Explorer so you can browse through

folders.

Figure 8.3  You can add file descriptions in the

Metadata tab.
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■ Add ratings and color labels to your images. One nifty feature of Bridge is the ability to rate, rank,

and label your images. You can indicate a rating of one to five stars for an image, and you can even

apply a color code to the image. Both ratings and color labels are good tools to use in conjunction

with Bridge’s image search features, which allow you to filter images based on ratings and labels.

■ Batch-rename your images. Bridge offers you the ability to rename as many images as you select,

giving you the option to rename those images and then store the renamed images in a folder of

your choice. This timesaving feature can let you rename, for example, a group of photos of butter-

flies, automatically renaming the batch of photos any way you choose, such as butterfly 001, but-

terfly 002, and so on. This feature comes in handy when you have a number of images you want to

send to another person, such as a client or your Aunt Bea, and you don’t want to use the same non-

descriptive filename that your digital camera provides for the images.

■ Work in multiple workspaces. Depending on what you’re doing with your images or what your per-

sonal preferences are, you can use Bridge to switch between workspaces (different working views

of Bridge). You can change workspaces easily by choosing Window, Workspace or by clicking the

Workspace icons in the lower-right corner of the Bridge window. Figure 8.4 shows you examples

of the different workspaces available to you in Bridge.

■ Automate functions. Photoshop automation features can be run directly from Bridge. You can select

any numbers of images and create a PDF presentation or a Web site using Photoshop’s Web Photo

Gallery, or you can stitch together a panorama using the Photomerge feature. I often use the pow-

erful and timesaving Image Processor, where you can batch-convert any number of images from

one format to another while choosing a separate destination folder for those files. That feature itself

is worth the price of Photoshop!

With all the image-management functions that Bridge offers, it’s worth taking some time to get familiar with it

and make it part of your overall workflow. Working with Bridge will help you keep your digital images organ-

ized, labeled, and rated. When you are working with thousands of images, Bridge is indeed the best image-man-

agement solution available.

Just as Windows or Mac OS is the operating system for your computer, consider Bridge the operating system

for your images and Photoshop.
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Figure 8.4  Working with images

in different Bridge workspaces
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Figure 8.5  Resizing panels is as easy

as dragging panel borders.

Figure 8.6  Resizing the Bridge window is easy as well.

Customizing and Using Bridge Functions

One of the benefits to using Bridge is that you have the ability to customize the software to best match your

needs. The ability to choose workspaces gives you control of how you work with Bridge. Many other image-

editing or image-organizing programs don’t let you customize panels and work areas, but Adobe has gone out

of their way to make Bridge customizable to fit your tastes or needs. You can even change the background

color of the work area, although your only choices are black, white, and shades of gray. For images, you can

put a lot of detailed information in metadata and manage it with Bridge. You can even specify which metadata

fields are viewable. You might not use even a fraction of the customizable options Bridge offers, but you have

them if you need them.

Some of the options you have for changing how Bridge and its sections appear include the following:

■ Changing your workspace. The Window menu offers a useful range of workspaces, but the one I use

most is the default. It includes the Favorites/Folders section, a small preview, and Metadata and

Keywords panels, which is everything I need for my image-management work.

■ Resizing panels and the Content Area. You can easily resize your panels and the size of the Content

Area by dragging the borders, as shown in Figure 8.5.

■ Resizing the Bridge window. In the bottom-right area of the Bridge window, you can drag the cor-

ner (shown in Figure 8.6) to resize the entire Bridge window (unless you’ve maximized it already

by clicking the Maximize button in the upper-right corner of the window).

Click and
drag

Click and drag
to resize the
Bridge window
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■ Changing views. My preferred view is the default (F1), but if you’d rather look at your thumbnails

in Filmstrip view (F5), as shown in Figure 8.7, click the Filmstrip View button at the bottom-right of

the Bridge window.

If you’re comparing and analyzing your images, you’ll want to view them with more image data dis-

played. The Details view provides a view of each image in the work area, showing more file prop-

erties than are displayed in the other views.

Figure 8.7  Changing views is as easy as clicking a button.
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Changing Bridge Preferences

If you thought that customizing Bridge ended at resizing panels or changing workspaces and views, there’s

more customization to be had! In the Preferences menu (Edit, Preferences) Bridge gives you some detailed

options for changing window colors and specifying which metadata fields to display with thumbnails. To change

Bridge preferences, follow these steps.

1. Start Preferences by choosing Edit, Preferences (or press Ctrl+K on a PC or Command+K on a

Mac). The Preferences window gives you various ways (in the left column) to modify your prefer-

ence settings: General, Metadata, Labels, File Type Associations, Advanced, and Adobe Stock Photos.

The default choice is General Preferences, as shown in Figure 8.8.

Figure 8.8  The General Preferences tab



Chapter 8    Using Bridge to Manage Your Nature Images

149

2. Change the Content Area background to black, white, or gray. If you’re a radical and you like to

work with black or gray backgrounds, you can change the background of the Content Area in Bridge.

Kind of like choosing a color for an old Model T, you can choose any color you want, as long as it’s

black, white, or gray, as shown in Figure 8.9. Use the Background slider in the Thumbnails section

to adjust from black (at the left) to white (all the way to the right).

A neutral gray background is actually best for viewing images or thumbnails, and that’s true whether

you’re viewing images in Photoshop or Bridge, or even as prints on your desk. It’s a scientific fact

(I’m not really a scientist, but take my word for it) that your eyes can best judge colors without the

interference of a white, black, or colored background. My tip of the day is to leave the background

of the Content Area gray.

Figure 8.9  You can change the background color as long as it’s to black, gray, or white.
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3. Modify the metadata displayed under thumbnails. By default, thumbnails appear with the filename,

date/time the image was taken, image dimensions, and keywords. Figure 8.10 shows a fourth-line

change to show the description I’ve added in Metadata, which I specified using Additional Lines of

Thumbnail Metadata in the third selection box.

4. Customize the favorites. Remember the Favorites panel? You can specify the areas of your com-

puter that appear in Favorites by selecting what you want in Preferences Favorite Items.

5. Customize the metadata preferences. Click Metadata in the Preferences window to show the avail-

able metadata selections. There you can select and deselect the metadata fields you want to appear

in the Metadata panel. Review the metadata default fields carefully.

Figure 8.10  You can change the metadata information displayed under thumbnails.
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6. Modify label definitions. You can apply color labels to your images, but you can also customize the

descriptions of your color labels in the Labels section of Preferences. The default for each color

label is simply the color name, but you can customize these names to fit your own labeling system.

7. Modify file type associations. I recommend leaving this section of Preferences alone. You can change

the software programs associated with file types (if you’re a Windows user, you can do that in Control

Panel, Folder Options, and on a Mac, you can do it in File, Get Info, Open With), but why do that

if you’re happy with the way things are working on your computer? You’re not likely to need this sec-

tion unless something unusual is going on.

8. Change miscellaneous settings. The advanced Preferences give you more ways to customize how

Bridge works. You can set the largest file you’ll let Bridge open, how many recently viewed folders

the Look In pop-up shows you, and whether to use double-clicking to edit Camera Raw settings. I

tend to leave these settings alone, but if you’re bored one day take a look at the options to see

whether you can tweak your Bridge settings to your liking.

Working with Images

Bridge provides super integration between the Creative Suite programs, but if you only use Photoshop it works

great as your standalone or integrated program to organize, browse, or locate photos. Bridge also serves as the

launching point to process raw images in Camera Raw.

To work with images in Bridge, follow these steps:

1. Start Photoshop CS2 by either double-clicking the icon on your desktop or choosing Start,

Photoshop CS2. You can also press Alt+Ctrl+O on a PC or use the shortcut for Browse on a Mac.

2. From Photoshop, choose File, Browse or just click the Go to Bridge button. The Go to Bridge but-

ton is located on the right side of the Photoshop CS2 Option bar shown in Figure 8.11.

Figure 8.11  Start Bridge by clicking the Go to Bridge button on the Photoshop Option bar. Go to Bridge
button
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3. Browse folders. Click the Folders tab. This shows you your computer’s drives and folders, allowing

you to navigate your computer’s folders to locate the folder you want to view, such as a newly cre-

ated folder of images you’ve just taken (as shown in Figure 8.12). Notice the cool black background

in the figure? I’ll be changing that back to a neutral gray shortly.

Figure 8.12  Locate folders by clicking through the folder tree on the Folders tab.
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4. Click on the folder to view. Clicking on a folder in the Folder tab will display the images in that folder

in the Bridge Content Area.

TIP
Creating your image folders and downloading images to the same area on your com-

puter makes it easier for you to locate images in Bridge.

5. Click on an image. Clicking an image in the Bridge Content Area shows you its metadata (informa-

tion such as the camera settings you used when you shot the photo) in the Metadata tab, along with

a thumbnail of the image in the Preview area, as shown in Figure 8.13.

Figure 8.13  Clicking on an image provides a preview of the image on the

Preview tab, as well as the metadata information on the Metadata tab.

TIP
After you’ve selected a photo, slide the Resize Thumbnails slider (located on the bot-

tom-right of the Content Area) all the way to the right to enlarge the thumbnail and get

a better view of the image. You’ll be able to see more image detail to better judge

whether the image is sharp enough or focused correctly. Images can look great when

they are viewed as smaller thumbnails, but when you view them at larger sizes, you can

better judge whether the images are good enough to use.
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6. Open the image. After you’ve browsed folders and selected an image in Bridge, double-click the

thumbnail to open the image. If the image is a raw file, it will open automatically in Camera Raw.

If the image is in another format (such as JPEG, TIFF, or PSD), it will open automatically in Photoshop.

You can also right-click (Ctrl+click on a Mac) and choose Open from the menu to open the image

(see Figure 8.14).

Figure 8.14  Right-clicking (or Ctrl-clicking on a Mac) lets you choose from a menu

of options what to do with an image, including opening it in either Photoshop or

Camera Raw.
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Summary

If you’ve experimented with Bridge, you realize the power it gives you over managing your images and its use-

fulness as a great virtual light table (on steroids) that you can use as a visual interface to Photoshop and Camera

Raw. After getting comfortable using Bridge, you’ll discover that you will be replacing your old image-man-

agement habits and becoming much more productive at managing and navigating your thousands of nature

images.

In summary, these are the steps to a successful image-management system—your image-management workflow:

1. Plan how you want to organize your images. I’ve given you the example of creating one master

folder (called Digital Images) with three subfolders: Original Images, Working Images, and Output

Images. It’s in those Original, Working, and Output folders that you store all of your image folders.

As a tip, make sure you name your folders in a descriptive manner that provides a chronology, con-

tent, and date method.

2. Make backups of all your images. Immediately after downloading the images on your memory cards

to your computer, back up to optical discs and/or an external hard disk. These are your originals,

just like negatives. You want to protect yourself from losing these because original images are not

replaceable if you have a computer catastrophe or theft.

3. Customize Bridge. I’ve gone into great detail about how you can customize the appearance and

functions of Bridge. Honestly, I usually stick close to defaults—hey, they work for me—but your

needs might be much different from mine or those of any other nature photographer, for that mat-

ter.

4. Add metadata to your images. Get in the habit of rating images, adding descriptions, and adding

keywords in the Metadata tab. It’s time-consuming up front, but it will save you a lot of time later.

When your image library grows, it will be easy to view images according to your ratings. It’s a great

way to separate the duds from the studs (hey, I should patent that saying) and it will save you time

when you are cruising for images to process in Photoshop or looking for all of your top butterfly

images.

5. Have fun. One of the most exciting things about digital photography is when you first view your

newly downloaded (and backed up) images on your computer. It’s the same feeling us old-timers

got when we watched prints magically appear in the darkroom developer tray.
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I
became enlightened about the raw file format a few years ago. Up until then, I was shooting all of my dig-

ital images in the highest-quality JPEG format my digital cameras offered. I obtained many a worthy nature

and landscape photo that way, but I ran into some limitations. I realized that I had very little latitude to

underexpose or overexpose images and that I had a problem with image noise. Actually, the image noise would

drive me crazy. Many of my landscape photos included big skies with long exposures, which would result in

those little color-speckled thingies in the shadows (technical terminology, you understand), also known as

image noise. Yes, I could use the Photoshop Reduce Noise filter, but even that had a cost to it (reduced sharp-

ness when using the filter). I also had to rely on my digital camera to calculate the proper white balance, which

was accurate most of the time. The times when white balance was off, giving my images a color tint, were a

pain in the mouse to correct in Photoshop. With problems with noise, exposure, and white balance, I realized

it was time for something better. After all, these tools are digital, aren’t they?

When digital camera manufacturers started shipping their higher-end digital cameras (usually digital SLRs or

advanced compacts) with the new raw format, I got excited. I went out and got me one of them new-fangled

digital SLRs, just so I could take advantage of the raw file format. Excited as I was to have more control over

exposure, noise reduction, color and tonal adjustments, and most of all, the ever-challenging white balance, I

was actually disappointed in a big way. It wasn’t disappointment in the actual digital camera and the raw for-

mat; it was disappointment with the software the manufacturer supplied with the camera.

I was able to process my raw images with the supplied software, but it was an extra step in my workflow. Shoot

raw images, download to computer, open the images with the software that came with the digital camera,

process the images, and then open them in Photoshop. And if I was using another brand of digital camera, I

couldn’t use the same software! It was proprietary to that particular make of camera. Great—proprietary raw

conversion software, just what I needed! That is, until I found Camera Raw, a compatible, digital camera–

independent raw conversion software.

Advantages to Raw

Serious digital nature photographers have always wanted a file format that works like the digital equivalent of

a traditional negative, providing total control over processing the image data captured by the digital camera.

Digital cameras do a pretty good job of getting general settings correct, but when was the last time you didn’t

have to make any adjustments in Photoshop after the image was taken? In the past few years, new digital cam-

era models have delivered just what we wanted—the raw image format. The software that gives you full con-

trol over processing these images is Adobe Camera Raw.
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In the past few years, there’s been a lot of argument over the issue of shooting raw versus JPEG format. Some

professionals will even tell you that they don’t bother with raw; they “get it right the first time.” Personally, I don’t

buy that argument, primarily because I am much more particular about controlling color, tone, noise, and

exposure in my digital images. When you’re out in the field, where nature photographers are, it’s often hard to

tell whether exposure, color, and tone are correct by viewing images on your digital camera’s LCD. It’s difficult

to accurately view the image on that little screen while outdoors! Our internal digital camera meters usually

do a good job, but often there are more tweaks that can be made.

Advantages to shooting images in raw format and processing them in Camera Raw include

■ Artistic control. Today’s digital SLR and advanced compact cameras can capture images in raw for-

mat, leaving the enhancements up to the digital photographer. That unprocessed image file, a dig-

ital negative, provides more artistic control. As a nature photographer, I shoot in raw format because

it gives me better creative control over the image data captured by my digital camera, especially

color. Raw format gives me an image file created exactly as the digital camera’s sensor captured it.

I can adjust white balance, tint, brightness/contrast, and hue/saturation exactly the way I want, like

in the raw image in Figure 9.1. I don’t have to settle for how my digital camera’s firmware (built-in

internal software) processes the image.

■ Exposure and white-balance correction. Shooting images in raw format gives me a huge advantage

over shooting in JPEG; I can correct nearly any exposure or inaccurate white balance I might have

made while shooting. As a rule of thumb, getting the correct exposure and white balance is still just

good photographic practice. You have less tweaking to do later, but sometimes when you’re out in

the field taking photos, exact exposure or white balance just may not happen. Having the ability to

make those corrections later is a big advantage. Raw format lets you use the capabilities of Photoshop

to compensate for underexposed or overexposed photos without degrading the quality of the image.

It’s a nice backup if you ever need it.

■ Software compatibility. As a new file format, not all raw images are the same. The actual image data

collected by a digital camera’s image sensor can vary noticeably from one manufacturer to another;

the electronics are different from model to model. For that reason, camera manufacturers offer their

own proprietary software to process the raw images produced by their cameras, and, in turn, each

of their raw formats is different.
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If you’re shooting with a Nikon digital camera that offers the ability to capture raw images, you can

process those raw files with a proprietary program, either Nikon Picture Project or Nikon Capture

(advanced raw conversion software available at an additional cost). If you also own a Canon digi-

tal camera that produces raw images, however, you won’t be able to use Nikon’s software to process

them. For those images, you have to use Canon’s proprietary software, Digital Photo Professional.

However, you can’t process Nikon images using Canon’s software. Personally, I shoot with both

Canon and Nikon, and I really avoid using Nikon’s or Canon’s raw converting options. I’d much

rather use one type of software for both, like Camera Raw.

Even different camera manufacturers have their own versions of the raw format; Adobe provides a

standard platform you can use to process almost all manufacturers’ raw image files, regardless of

their proprietary formats. As an added bonus, Camera Raw can handle the whole process of adjust-

ing and editing your raw images without you needing to add other software programs.

Figure 9.1  Color and tonal adjustments are best made in Camera Raw instead of Photoshop whenever possible.

Unprocessed raw image Color and tone adjusted in Camera Raw
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■ Non-destructive color and tonal adjustments. One advantage of making color and tonal adjust-

ments (also referred to as overall adjustments) in Camera Raw is that doing so keeps the overall

quality of the image intact. Whenever you adjust the exposure, brightness, contrast, hue, and satu-

ration in Photoshop, you actually destroy information in the image file. The more adjustments you

make to the image, the more information you potentially destroy, degrading the overall quality of

the image. Making as many of these overall adjustments as you can in Camera Raw will help guar-

antee that you retain the data that makes up the image file. Making overall adjustments in Camera

Raw will definitely help you make higher-quality images.

■ The original raw image is never altered. When you make changes to a raw file in Camera Raw, you

actually don’t change the original file. All of your changes are kept in another file called a sidecar.

The Camera Raw sidecar file contains all of your changes, so you are never in danger of erroneously

altering the original, keeping your “digital negative” intact.

Using Camera Raw

One big advantage of using Camera Raw for your raw processing needs is its constant improvement. Adobe first

introduced Camera Raw with Photoshop version 7 and has consistently improved this tool with the next ver-

sions, CS and CS2. Recent improvements, such as clipping warning, curves, and auto adjustments, have made

Camera Raw a powerful tool to process your raw images. Additionally, Camera Raw’s integration with Adobe

Bridge and Photoshop makes it the tool of choice for many photographers who shoot raw and use Photoshop.

Speaking of constant improvement, Adobe has added some welcome features of late. Camera Raw is a pow-

erful enough tool that it’s a good idea to get a handle on some of its new features before you dive right in. One

of the new convenient features is the addition of auto adjustments in Camera Raw. When you open a raw image

in Camera Raw, auto adjustments for exposure, shadows, brightness, and contrast are automatically made. For

some images, auto settings for these adjustments might be sufficient; however, you’re still going to want to

adjust exposure, shadows, brightness, and contrast a bit to see whether you can get either better results or the

effects that you want.

As I’ve mentioned, Camera Raw is a powerful enough tool that I ignore the raw image–conversion software from

the manufacturers of the digital cameras I use. As standalone applications, the proprietary software is actually

very good, but I like the idea of using one program that allows me to use raw files from different manufactur-

ers’ cameras and to work directly with Bridge and Photoshop CS2. So, my choice is simple: I use Camera Raw.
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Getting the Lay of the Land and Opening Images in Camera Raw

The Camera Raw window is laid out simply. Commands aren’t buried in a series of menus, and the Control tabs

are visible when you first open an image in Camera Raw (shown in Figure 9.2). Commonly used tools are eas-

ily available to you on the Camera Raw Option bar, and the Image window is simple to operate (with zoom

controls laid out at the bottom of the image). The Camera Raw window is made up of these sections:

■ Option bar. The Option bar provides tools to help you move around, select a white point of the

image (to correct white balance), crop, straighten, and rotate an image. The Option bar also includes

check boxes you can use to toggle the image preview on and off, an easy way to switch between

the original (unadjusted) image and the image as it appears while you’re making adjustments.

■ Image preview. This is where you can view, zoom, crop, straighten, and rotate your image using the

tools in the Option bar.

■ Workflow Options. This is the area at the bottom of the Camera Raw window where you can mod-

ify the color space, size, and resolution of an image. In my workflow, I always make sure the set-

tings in these selection boxes are set to my needs before I begin having my way with my raw image.

As an additional benefit, workflow settings are “sticky”; when you open an image in Camera Raw,

the settings will be the same as when you last used the program. It’s very convenient!

■ Histogram. The histogram is the graph displayed in the upper-right part of the Camera Raw menu—

a graphical view of how much red, green, and blue make up the image and how these colors are

distributed.

■ Control tabs. The area to the right of the Camera Raw window contains tabs where Adjust, Detail,

Lens, Curve, and Calibrate controls are located.

Getting Started Using Raw

Before the advent of the raw file format, digital camera users (and film shooters who scanned their negatives

into digital images) typically worked with JPEG images in Photoshop, and most digital camera users still do.

The typical workflow for processing the images in Photoshop is to first adjust levels, curves, color correction,

and color saturation. If you have to adjust white balance, shadows, and tint in a JPEG, it can be very chal-

lenging in Photoshop. With Camera Raw, making those adjustments is a snap. I think it’s actually easier and

faster to make color and tonal corrections in Camera Raw than it is to do so in Photoshop!
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Before reviewing how to make color and tonal adjustments in Camera Raw, I would like to quickly review

which adjustments are tonal and which adjustments are for color.

■ Tonal adjustments. Tonal adjustments are changes that affect the overall tone of an image, such as

brightness, contrast, shadows, curves, and exposure. In Photoshop, the Levels, Curves, and

Brightness/Contrast controls are used to make tonal corrections.

■ Color adjustments. Color adjustments are changes that affect the color of an image. Changes to

color include adjusting white balance, tint, color balance, and hue/saturation.

The first obvious step in my raw conversion workflow is simple—open a raw image in Camera Raw and make

sure my workflow settings are correct.

1. Start Bridge (see Chapter 8). Choose File, Browse or click the Go to Bridge button on the Photoshop

Option bar. Browse images in the content area and choose the raw image you want to open in

Camera Raw.

2. Open a raw file. In Bridge, choose a raw image you want to process by double-clicking the thumb-

nail of the image. Alternatively, you can right-click the image and choose Open with Camera Raw

from the flyout menu.

3. Make workflow settings. Four selections in the Workflow Options area—Space, Depth, Size, and

Resolution—allow you to customize how you want your image set up when you open the image in

Photoshop after making raw adjustments.

The Space selection lets you choose what color space (see Chapter 10, “Setting Up and Getting

Around in Photoshop”) you want associated with your image. For editing images with the intent of

making prints, I always choose Adobe RGB (1998). If you will only be displaying your images

onscreen or if you’ll be doing both, choose Adobe RGB (1998); you can always change the color

space later in Photoshop.

The Depth setting tells Photoshop whether you want to edit your images in 16-bit or 8-bit space. I

always leave this setting as is, at the 16-bit setting. This allows you to edit your images with more

image data contained in your file, though some of the Photoshop filters will work with only 8-bit

images. Again, I’ll cover bit depth in more detail in Chapter 10.
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The Size setting will default to the actual image size taken with your digital camera. For most of my

work, I leave this at the native size, measured in megapixels, my digital camera has produced for

me. You can use this setting to upsize your image—in other words, to make it bigger than the digi-

tal camera produced. That can be handy if you’re planning to make large prints or crop to small areas

of your image.

The Resolution setting lets you indicate the output resolution of the image. I usually leave this set

to 360ppi because that is the optimum resolution used by my printer.

When you hear the term overall adjustments, it refers to general changes to color and tone. White balance, tint,

shadows, exposure, brightness, contrast, hue, and color saturation are all considered overall adjustments.

The controls to make overall adjustments in the Camera Raw Adjust tab (see Figure 9.3) include

■ White Balance control. White Balance can be adjusted using either the White Balance selection box

or the Temperature control. The selection box gives you choices to change the white balance to bet-

ter reflect what you have envisioned for the photo. You can choose from settings such as Cloudy,

Daylight, Shade, and Fluorescent. Changing the settings in the White Balance selection box will

Figure 9.3  Make overall adjustments using the Adjust tab.

Adjust tab
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adjust both the Temperature and Tint to match the Camera Raw predetermined color conditions for

that particular setting. For example, the Cloudy white-balance setting changes the Temperature con-

trol to 6500K and the Tint to a setting of +10.

The White Balance adjustment is best used on photos that had incorrect white-balance settings

when they were shot.

■ Temperature and Tint controls. For finer tuning of the white balance, you can adjust the Temperature

and Tint separately by using the adjustment sliders for both of those adjustments.

■ Exposure control. The Exposure control is the digital nature photographer’s best friend. We all know

the challenges to getting correct exposures in difficult lighting situations, and sometimes we’ll take

a photo in which only part of the image is properly exposed. The Exposure adjustment allows you

to correct an image that’s underexposed or overexposed. As with other adjustments in Camera Raw,

increasing or decreasing the exposure to obtain the results you want doesn’t degrade the quality of

the image file.

Click the Auto check box to let Camera Raw automat-

ically adjust your exposure. Camera Raw will choose

the optimum setting for the point at which the image

isn’t underexposed or overexposed, just shy of the

point at which the shadows and highlights start to lose

definition. This is called clipping.

Changing any of the control settings or having overex-

posed areas of an image can cause clipping. Clipping

occurs when too much of an adjustment or an over-

exposed area blows out highlights. Camera Raw pro-

vides you with clipping warnings by highlighting these

areas in the color red (see Figure 9.4). On the Camera

Raw Option bar, you’ll find the Shadows and

Highlights clipping warning check boxes. When these check boxes are checked, Camera Raw will

warn you of areas where clipping in the highlights or shadows is occurring.

Figure 9.4  Highlights clipping warnings appear in

the color red in Camera Raw, warning you when

areas are being clipped.
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■ Shadows control. Camera Raw lets you adjust shadow areas of your image by increasing or decreas-

ing the brightness and tone in these areas without affecting the highlight areas. Try the Auto setting

for Shadows first, or you can move the slider to the left or right to get the effect you want. Make sure

you keep the Shadows check box checked to limit and monitor clipping. If clipping occurs while

you’re making a Shadows adjustment, move the slider to the left until the clipping in the shadowed

areas disappears.

■ Brightness control. The Brightness control allows you to increase or decrease brightness of your

image. The Brightness control works independently of the Exposure setting and is best used in con-

junction with other Camera Raw adjustments, such as Contrast and Saturation. Changing the con-

trast and saturation may require you to increase or decrease the brightness of the image slightly to

compensate for the harsher changes. When using the Brightness control, keep in mind that you are

changing all the pixels in the image, so be careful!

■ Contrast control. The Contrast control simply allows you to darken the dark areas of an image while

brightening the lighter areas of the image. Using the Auto setting for contrast might be optimal, but

feel free to move the slider to the right to increase contrast in the image until you get the result you

want. The Curves tab will give you even more control over the contrast in your image. I’ll be cov-

ering Curves in the next section.

■ Saturation control. Before you adjust a raw photo, it might appear to be lacking color and just plain

dull. The color information is still in the file; all you have to do is increase the Saturation control to

bring the color out. This is my favorite control. After making a few overall adjustments, I love adding

color to the level at which I envisioned it. There isn’t an Auto setting for saturation; it’s up to you to

add the level of color you want in your raw image.

The Raw Processing Workflow

In case you thought you were done processing your raw image using the Adjust tab, there’s a whole lot more.

I’ve introduced you to making settings in the Workflow area of the Camera Raw window and I’ve talked about

making color and tonal adjustments in the Adjust tab. These are the basic tools to use when you are process-

ing raw images. Let’s take a step back, take a breather, and put all these processes together in a coherent work-

flow, including some goodies I haven’t even shown you yet. I might be repeating some of the material I covered

in the previous section, but bear with me—it all fits into the workflow I’m about to describe.
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The workflow that I recommend to process raw images in Camera Raw consists of the following steps:

1. Open a raw image using Bridge.

2. Click the Shadow and Highlights check boxes (next to the Preview check box) to turn on the clip-

ping warnings. I always keep these two check boxes selected. Shadows clipping warnings will

appear in blue, and highlights clipping warnings will appear in red. The warnings call attention to

where image data is lacking in color or tone—that is, where you’re losing usable image data due to

under- or over-adjustment of exposure, shadows, or brightness. Such warnings help you adjust the

image in Camera Raw.

3. Turn on Auto Adjustments. Camera Raw will automatically adjust color and tone to what it calcu-

lates is optimum for the image. I’ve found that Auto Adjustments work extremely well in about 80

percent of my photos. To turn on Auto Adjustments, press Ctrl+U on a Windows PC or Cmd+U on

a Mac.

4. Make overall tonal and color adjustments in the Adjust tab (see the previous section). When you

open an image in Camera Raw, the Adjustments tab is automatically selected. The Adjustments tab

contains all the controls you’ll use to adjust white balance, tint, exposure, shadows, brightness,

contrast, and saturation. Using Auto Adjustments in Step 3 will automatically assign values to expo-

sure, shadows, brightness, and contrast, but you don’t have to use the automatic settings. You can

adjust the overall settings until you get the results you want. Remember, Camera Raw doesn’t pro-

vide automatic adjustments for white balance, tint, or saturation. You’re on your own when it comes

to adjusting those settings.

5. Apply sharpness and noise reduction. Figure 9.5 shows the Camera Raw Detail tab, which offers

three controls for applying sharpness and noise reduction to both the luminance and the color of

the image. You can sharpen the outlines of the image and reduce those tiny messy bits in the

grayscale areas and get rid of the color-speckle thingies (one of my technical terms) that show up in

the color areas of the image. Both are referred to as noise.

TIP
I never use the Sharpness control to sharpen my image. That step needs to come later,

only after you resize your image for final output. You can turn off sharpening and use

the sharpening control for preview only (in Camera Raw) by pressing CTRL+K (Cmd+K

on a Mac) to bring up the Preferences window, shown in Figure 9.6. In the Preferences

window, select Preview Images Only in the Apply Sharpening To selection box.
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The Luminance Smoothing slider is great for reducing grayscale noise, while the Color Noise

Reduction slider is a hefty weapon against the color noise that can plague images shot in high ISO

settings or long exposures. I usually use settings of 25 for the Luminance Smoothing control and 20

for the Color Noise Reduction control. Try your own settings while zooming in on your image to 100

percent in the preview window until you get results you are happy with.

Figure 9.5  The Detail tab gives you

controls to increase sharpness (for

previewing only) and reduce noise in

your image.

Figure 9.6  Make sure you apply sharpening to preview images only in the Preferences

window.

TIP
Reducing luminance and color noise during the raw conversion workflow should be

your preferred method for handling noise. Although Photoshop offers the new Reduce

Noise filter, the goal is to be able to make as many adjustments as possible before you

open images in Photoshop.
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6. Adjust contrast and tone using the Curve tab. The Curve tab (shown in Figure 9.7) lets you fine-tune

an image’s tonal characteristics. Unlike the Curves adjustment in Photoshop, the Camera Raw Curve

adjustment works on top of the adjustments made in the Adjust tab; it works like an adjustment’s

own “fine-tuning.” I find that making careful changes in the Adjust tab reduces the need to make

changes in the Curve tab.

Figure 9.7  The Curve tab

NOTE
Most of your tonal adjustments should be made using the

Adjust tab, but when you want to fine-tune contrast and tone

or just experiment, play around with using the Curve tab’s

Tone Curve selection box. You can view your image using the

Medium Contrast and Strong Contrast preset adjustments. If

you don’t like the results of either, you can always leave the

Curve adjustment set to its default (Linear).

7. Click Open to open the image in Photoshop CS2. You can also click Done, but that will just save

the Camera Raw settings for the image you’ve just made, and then take you back to Bridge. Clicking

the Save button will allow you to save the raw file (and its sidecar file with your adjustments) to a

folder of your choosing. You can also specify another format for the file—RAW, DNG, TIFF, JPEG,

or PSD—but for the most part, you’ll be opening the image in Photoshop for overall correction and

image editing.

At this point, Camera Raw saves your changes, but not to the original raw file. It leaves that alone,

but it does add your changes to a sidecar file, created to contain changes you’ve added to the orig-

inal raw image. These files are small and are given an .XMP file extension.
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Two other adjustment tabs (see Figure 9.8) available in Camera Raw are usually used sparingly. Those would

be the Lens and Calibrate tabs.

Figure 9.8  The Lens and Calibrate tabs

The Lens tab gives the photographer the ability to

make corrections for lens shortcomings, such as

chromatic aberrations (color fringing) or vignetting

(dark edges in the frame). Most of the newer digital

cameras offer excellent lenses, so you’re really not

going to need these controls much, but I do like to

introduce some vignetting into some of my photos

(see Figure 9.9). I like the effect!

Figure 9.9  Adding a vignette to an image changes its appearance.
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The Calibrate tab is for those techies who like to create their own color profile for their given digital camera.

You can actually make adjustments to how your digital camera is calibrated for raw image color, and then

upload that profile to your digital camera. In my experience, I’ve never seen a major-brand digital camera that

needed any calibration. Adobe goes through great lengths to keep Camera Raw updated for the latest digital

cameras and those digital camera models’ color profiles. Unless you want to experiment, I suggest leaving the

Calibrate tab to the geeks. (Well, I guess I’m a geek, but I only use the Calibrate tab to do goofy things to my

images.)

Summary

I’ve personally gotten hooked on shooting all of my images in the raw. I’m not talking about taking photos

without wearing clothes (though I’ve done that), but shooting my images in the raw file format. I get more con-

trol over the color and tonal values of my images and I get to make adjustments without having a degrading

effect on the quality of my images. If you make those color and tonal adjustments in Photoshop, you do indeed

degrade the image somewhat every time you make a change. In Camera Raw, the adjustments you make don’t

affect overall image quality. Add the ability to fine-tune white balance without having to jump through hoops

in Photoshop, and I’m sold.

Lastly you’ll discover, like I have, that it’s actually more efficient to adjust white balance, shadows, tint, expo-

sure, brightness, contrast, saturation, and curves in Camera Raw than it is to do so in Photoshop. I find myself

more productive since I switched to raw than I was when I shot JPEGs and made similar adjustments in

Photoshop.
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I
f you’re experienced with Photoshop, you might not be aware of some things that I’ll be covering in this

chapter. Do you know all the tools available in the Toolbox? Do you know some of the goodies hidden in

the Photoshop menus? How about some of those palettes that you didn’t know existed? You see, you could

be a long-time user of Photoshop and not even be aware of all of its offerings. The program is so comprehen-

sive that I bet only a handful of the Adobe programmers even know most of its capabilities. I’ll be covering some

of the basics of Photoshop in this chapter, and I hope to turn you on to some capabilities you didn’t even know

existed.

As nature photographers, we are especially interested in color, and I mean perfect color. I’ve dedicated a large

part of this chapter to showing you how to set up your computer and Photoshop to make sure that whatever

you visualize on your computer monitor comes out the same in output; color management is the key for suc-

cessful digital photography. On the subject of color management, this chapter might be the most important

part of this entire book.

I’ll be covering many important concepts, so here is a review of what it means to you as a nature photographer:

Setting up your digital darkroom properly will save you a lot of time and head off those digital ulcers later.

Getting Acquainted with Photoshop

Do you ever ponder how photographers are able to produce stunning nature photographs that you only dream

you could create with your digital camera? You see their work every day in magazines, books, and galleries.

Chances are these nature photographers process their photographs using the leading photo-editing software,

Photoshop. Sure, some professionals have years of experience using image-editing software, but you would be

surprised how much you can improve the quality of your own photographs by performing some basic actions

using Photoshop.

I’ll always preach that the key to creating beautiful nature photographs is first photographing a great image. Of

course, you need a good original to begin with. It’s just like when we were working in the chemical darkroom;

we needed a good negative before we even began printing. Once you’ve taken good photographs with your

camera, it’s time to get them into Photoshop to finish your works of art.

Photoshop gives you all the tools you would ever need to enhance the images you’ve downloaded to your

computer. The basic steps will help you make some simple color and tonal corrections. (They’re the same basic

steps as you took using Camera RAW in Chapter 9.) You’ll then make adjustments to levels, curves, and color

saturation. 
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As an analogy, think of adjusting the screen on a brand-new television when you first bring it home—you want

the picture to look bright, with the right amount of color and contrast. For photographs, you can use automatic

adjustments in Photoshop to make these overall corrections.

Photoshop provides you with more editing tools than you can imagine. If I’m working on a landscape photo

with a power line in the middle of my deep blue sky—or worse, contrails (those streams of white mist left by

jets flying across our horizons, yuck!)—I can easily use the new Spot Healing Brush or Clone Stamp tool to

remove it. I’ll often use the Dodge and Burn tools to lighten or darken foliage, just like I would in the darkroom.

Photoshop is invaluable to nature photographers (or any other type of photographer, for that matter) because

it offers a complete end-to-end solution for getting your photos organized, adjusted, edited, and printed.

Advanced photographers and professionals demand control of color throughout their workflow. Photoshop

delivers with its incorporation of color management settings (the ability to control color as it appears on your

monitor and match that color during the printing process) throughout the program. You can even view a pre-

view of how a photo will appear on a particular type of photo paper loaded in your printer!

One set of features that separates Photoshop from other software is its timesaving automation tools. I like to shoot

panoramas, a common type of image for nature photographers, like the image in Figure 10.1. Photoshop allows

you to “stitch” these images together using the Photomerge feature. If I need to create a slideshow for a client

or to show off a recent shooting trip, I use the PDF Presentation feature.

Figure 10.1  Photoshop’s Photomerge feature lets photographers stitch photos together to make panoramas.
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As a photographer who dates back to the old “darkroom” days of photography, I can say that Photoshop gives

me everything I need to process my photos and produce better-quality prints than I could produce in my old

darkroom or get from a professional photo lab. There are a lot of features available to you, and if you’re new

to Photoshop, I recommend taking a little time to learn about basic image correction and editing before div-

ing in and trying to use as many features as possible.

As of this writing, the current version of Photoshop is CS2. This version hasn’t changed as far as the basic fea-

tures, but Adobe keeps adding some goodies every time they release a new version. Some of the newer fea-

tures include

■ New Exposure control (Image, Adjustments, Exposure). Photoshop now includes a new control

that lets you adjust exposure outside of Camera RAW. It can be used for JPEG or TIFF images.

■ New Blur and Sharpen filters (located in the Filters menu). CS2 provides more Blur and Sharpen

tools. The Smart Sharpen filter is bound to be the new photographer’s favorite sharpening tool for

photos.

■ Vanishing Point filter (located in the Filters menu). This feature is tailored to advanced users who

seek to edit images in perfect perspective.

■ Smart Objects (Layer, Smart Objects). Using these, you can make edits to an image file while link-

ing the image to the original. Linking to the original lets you maintain the quality of an image; your

photos remain sharp even after extensive edits because the linked original remains unchanged. I’ve

found that even some older, low-resolution digital images can benefit from this feature, especially

those I’ve edited extensively.

■ Lens Correction filter (located in the Filters menu). The new Lens Correction filter gives you the abil-

ity to correct lens shortcomings, such as barrel distortion and vignetting. These characteristics appear

when lenses at extreme settings create slight darkened borders around an image, called vignetting.

Also, you can see visible distortion at extreme zoom settings, especially wide angle.

■ Red Eye tool (located in the Photoshop Toolbox). The new Red Eye tool lets you easily correct the

red-eye effect that plagues so many snapshots of family and friends who really don’t want to look

like insomniacs or vampires. I’ve even used the tool on some wildlife photos that were taken at

night with a strobe.
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■ Spot Healing Brush. I often use this tool to rid my photos of stray beer cans that are laying around

scenic vistas, especially out West. (Don’t they have returnable bottles out there?) Very little can ruin

a photographer’s mood more than traveling a few thousand miles, taking photos of the national

parks, and then viewing images that reveal litter on the ground! The Spot Healing Brush comes in

handy for just those situations.

■ WYSIWYG fonts. Photoshop now shows you exactly what the font will look like when you add text

to a Photoshop document using the Text tool.

A Tour of Photoshop

If you’re new to Photoshop, I probably should cover some of the basics here, such as starting the program and

understanding what those little boxes are that float around the screen! First, let’s just start it up. Start Photoshop

from a shortcut on your desktop or choose Start, All Programs, Adobe Photoshop. On a Mac, you can put

Photoshop on the Dock for immediate access.

When Photoshop starts (see Figure 10.2), you’ll find that the program is divided into these basic areas:

■ The Photoshop window. The Photoshop window will appear with the Toolbox and palettes already

started. Like all computer programs, you can close, maximize, or minimize the Photoshop program

window. You find these controls located in the upper-right corner of your Photoshop program win-

dow in Windows and in the upper-left corner of the window if you’re using a Mac.

■ Toolbox. The Photoshop Toolbox is located on the left side of your Photoshop window. Think of 

the Photoshop Toolbox as an artist’s paint box; in it, you find the tools you need to edit your 

photos. Instead of grabbing a tube of paint or a brush, you grab photo-editing tools, such as the

Marquee tool, the Paint Brush tool, the Cropping tool, the Text tool, and the Healing Brush tool,

among others.

■ Palettes. On the right side of the Photoshop program window, you find the palettes. These windows

contain their own specific operations, while providing you with image information needed in the

editing process. Among the most-often-used palettes are the Layers, Histogram, and History palettes.

■ Image window. After you open an image to edit in Bridge or directly from Camera RAW (or by

choosing File, Open or File, Browse), you are presented with your image window. Just like the

Photoshop program window, you can close, minimize, or maximize your image window.
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Figure 10.2  The Photoshop window
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A Menu for Everything

Photoshop commands can be accessed two different ways—either through the Photoshop menus or by using

keystrokes. I don’t know about you, but I find myself using both. There must be hundreds of keystroke commands

for performing functions in Photoshop, but I find the menu system much more intuitive, especially for casual

users. I know a number of experienced users who seem like they know all of those keystrokes. (I think they need

to get out a little more—you know, get away from their computers.) To be honest, if you know most of those

keystrokes, you either have way too much time on your hands or you have a photographic memory (no pun

intended!).

To make it a little less intimidating, become familiar with the commands, functions, and controls in the

Photoshop menus, and you’ll be on your way to becoming a Photoshop master. Let’s take a quick tour of the

Photoshop menus:

■ The File menu. Shown in Figure 10.3, the File menu in Photoshop contains functions that allow

you to perform image-related functions. Typical commands allow you to create a new file, open an

existing file, browse files, close a file, add file information, save a file, and even access the Automate

menu.

■ The Edit menu. Commands such as Undo, Cut, Copy, and Paste are available here. Important 

functions, such as Color Settings and Preferences, are also available in the Edit menu, as shown in

Figure 10.4.

Photoshop’s enhanced Edit menu includes a helpful command called Step Backward. Step Backward

is handy when you need to reverse your steps while editing images. This command is even more

helpful when you are applying enhancements using brushes, the Blur tool, or the Sharpen tool, or

when you are burning or dodging.

■ The Image menu. The Image menu holds some adjustments. Photoshop has flyout menus for Mode,

Adjustments, and Rotate Canvas. As shown in Figure 10.5, the Adjustments flyout menu is where

you can find common image-adjustments functions, such as Hue/Saturation, Brightness/Contrast,

and Levels.
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Figure 10.3  The File menu, shown with the

Automate flyout menu

Figure 10.5  The Image menu

Figure 10.4  The Edit menu

■ The Layer menu. The Layer menu is where you manage your image-editing workflow. Think of lay-

ers as a stack of transparencies that make up one image. For example, if the first transparency con-

tains your image, the second transparency might add tonal correction using Levels, the third

transparency could add some contrast using Curves, the fourth might add increased color saturation,

and the fifth might add sharpness. As you proceed with editing your image, each step in the process

can be contained in an individual layer.

The advantage to using layers is that they make it easy to backtrack later and make minor tweaks

without undoing the rest of your image adjustments. The Layer menu is where some of the 

real power of using Photoshop resides, and it is what separates Photoshop from other image-

editing programs.
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Figure 10.6 shows the Photoshop Layer menu. Many of the functions in the Layers palette can also

be executed from the Layer menu.

■ The Select menu. Selections are some of the most challenging commands to master in Photoshop.

Carefully segregating a portion of an image for adjusting or editing can be a tedious task. The Select

menu (see Figure 10.7) contains the commands you use in conjunction with the Toolbox selection

tools, such as the Magic Wand tool, the Marquee tools, the Pen tools, and the Lasso tool.

■ The Filter menu. This is where the real fun starts. As shown in Figure 10.8, the Filter menu contains

all the really cool processes for transforming your photo into a work of art. Other editing features,

such as the Sharpen and Blur filters, also reside here.

Figure 10.6  The Layer menu

Figure 10.7  The Select menu

Figure 10.8  The Filter menu
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■ The View menu. Shown in Figure 10.9, the View menu maintains the functions that relate to how

images are shown on your computer monitor. Guides, rulers, and functions to zoom in and out are

all included in the View menu. Proofing setups also reside in the View menu for those who prepare

images for desktop printing or even press work.

■ The Window menu. Shown in Figure 10.10, the Window menu presents you with the wonderful

world of Photoshop palettes. Palettes are small windows docked on the right side of your Photoshop

window that contain specific functions relating to editing and making overall adjustments to your

images. If you can’t find a certain palette or even your Toolbox, just go the Window menu and select

the palette to bring it back to your workspace.

Figure 10.9  The View menu shown with

the Proof Setup flyout Figure 10.10  The Window and Help menus

■ The Help menu. For almost any procedure you want to perform in Photoshop, you have either a ref-

erence or a tutorial available to you in the Help menu (refer to Figure 10.10). More than 50 “How

To” links are in the Help menu; they link you to tutorials that are loaded on your computer when

you install Photoshop. It’s sort of like having a quick reference right on your computer.

TIP
You can set the palettes that appear on your

screen every time you start Photoshop by

choosing Window, Save Workspace.

TIP
Need to look up your Photoshop serial num-

ber? Choose Help, System Info. This feature

provides you with more system information

about your computer than you probably care

to know, but this information can come in

handy when you are troubleshooting issues

about your computer and Photoshop.

Additionally, if you need to look up available

Photoshop software updates, choose Help,

Updates. This option takes you directly to the

Adobe Web site Photoshop download section.
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The Photoshop Toolbox

Where in an art studio can you find a toolbox that contains more than 60 artistic tools you use in your every-

day creations? Hint: It’s only a few inches long, and it’s the Photoshop Toolbox, shown in Figure 10.11. The

Photoshop Toolbox provides a number of tools you use to edit images. Among the 60 or so tools offered in this

window are brushes, lassos, burning and dodging tools, marquees, erasers, healing brushes, and many more.

Figure 10.11  The Photoshop Toolbox
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Clone Stamp, Pattern Stamp  S H History, Art History 
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Foreground Color Swap Foreground/Background Colors

Default Colors (Black & White)  D Background Color

Edit Standard Mode Q Q Edit in Quick Mask Mode

Standard Screen Mode  F F Full Screen Mode

Image Ready F Full Screen Mode with Menu Bar

Toward the bottom of the Toolbox, you find commonly used color-selection, masking, and viewing icons. The

tiny triangle at the bottom-right of an icon represents a flyout menu that contains similar tools. Right-click the

icon to bring out the flyout menu for that icon.

You’ll notice that whenever you click on a tool in the Toolbox, the options in the Option bar change. Photoshop

provides a different set of tool controls for each tool and will display them in the Option bar. I recommend exper-

imenting with each tool and the variations for each tool offered in the Option bar.
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Palettes

One of the most powerful Photoshop features is the ability to display and hide a number of tool options and

functions in the form of floating and dockable palettes. As I explained earlier when I discussed the Window

menu, these palettes are accessible through the Window menu.

As shown in Figure 10.12, each palette displays as a group of tabs. When you click a tab, a function of the

palette appears. For example, the Layers palette includes tabs for Channels and Paths. The Navigator palette

includes tabs for Info and Histogram.

Figure 10.12  The Navigator, History, and Layers palettes

Like the Toolbox, palettes are an important part of your Photoshop feature set and they assist you in customiz-

ing your Photoshop screens. Here are some tips about palettes you might find helpful:

■ Open a palette by choosing the palette name from the Window menu.

■ Click the tabs within the palette to show other palettes.

■ Dock individual palette tabs by dragging them to the palette well.

■ Create your own palettes or break out any tab to its own palette by dragging a palette tab to the

Photoshop Workspace or by dragging palette tabs to other palettes.



Digital Nature Photography and Adobe Photoshop

204



Chapter 10    Setting Up and Getting Around in Photoshop

205

Working in Layers

I like to use the analogy of a big sandwich to describe the use of layers in working with images in Photoshop.

I start with a couple slices of bread, or maybe three (you know, double-decker sandwiches)—the basis of every

good sandwich. I then add a layer of lettuce, one of

tomato, a layer of salami, and a layer of rare roast

beef. Add a little layer of mustard, another layer of

cheese, and I’m in heaven: a layered hero-sized

sandwich. The idea is the same when you’re using

layers in your Photoshop images.

Like making a sandwich, editing images in

Photoshop is also based on the premise of per-

forming each individual change to an image on its

own layer. Think of each layer as a transparency,

and each transparency as containing a particular

change. When you open an image file in

Photoshop, the original image is used as a back-

ground layer. Add a layer to make an adjustment,

and that layer is placed on top of the background

layer. Each new edit is contained on a new layer,

stacked from the bottom on up. Stack the images

together, and you have a composite image: a fin-

ished product, just like my sandwich. Now I’m get-

ting hungry!

The Layers palette, shown in Figure 10.13, contains

all the layers that make up an image. You use the

Layers palette to control all layers; you can create

new layers, hide layers, and work with groups of

layers. With all these layers, maybe we should be

calling images processed in Photoshop “digital

sandwiches.”

Figure 10.13  The Layers palette, shown with the Create New Fill or

Adjustment Layer flyout menu
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By default, the Layers palette is visible in Photoshop. If you inadvertently close the Layers palette while you’re

working in Photoshop, you can always start it up again by choosing Windows, Layers or by pressing the F7 key.

Following are some important facts about working in layers.

■ Background layer. When you’re opening an image file, Photoshop creates the bottom-most back-

ground layer. There are certain changes that cannot be made to the background layer in Photoshop:

You cannot delete, reorder, or change the opacity or blending mode of the background layer.

TIP
Before editing your image, always make a duplicate of the background layer. It is a best

practice to not perform edits to the background layer. Reserve that layer as the original on

which to base all your edits: It’s your backup parachute in case anything goes wrong.

■ To show or hide the contents of a layer, click the eye icon. If the eye icon is visible, the contents of

the layer are visible. If the eye icon is not visible, the contents of the layer are hidden.

■ Rename layers by double-clicking the layer name and typing the new name. You want to make

sure that your layers are named correctly, pertaining to the particular adjustment or edit you are

making to that layer. It helps you remember what you did in that layer later if you save the file, and

then go back to it days or weeks later.

■ Click and drag to change the layer order. To change the order of your layers, click a layer and drag

it to the position where you want that layer to appear.

■ Create new layers from the flyout menu. Click the Create a New Layer button. Choose the layer type

from the flyout menu. You can also create a new layer by dragging an existing layer to the New

Layer button, which is located on the bottom of the Layers palette.

■ Drag to delete layers. Click the layer and drag it to the trashcan icon located on the bottom right of

the Layers palette. You can also right-click the layer and choose Delete Layer from the flyout menu.

If you’re using a Mac, simply select the layer in the Layers palette and press the Delete button on

the keyboard.
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■ Flatten layers. Flattening layers combines all layers into one. When you flatten an image, your abil-

ity to make changes to individual layers is lost. Flattening layers is usually performed to create a ver-

sion of an image to print or to submit for publishing.

If no layers are selected, the entire image is flattened into one layer with the top layer’s name. If two

or more layers are selected, only those layers are combined into one layer, again taking the top

layer’s name.

To maintain your image edits, save your image before flattening it and save the flattened version of

your image file using another filename.

Adjustment and Fill Layers

Adjustment layers allow you to change color or tonal values of an image without affecting the original (back-

ground) image. When you create an adjustment layer, changes made in that layer are viewable along with all

the adjustments you made in the layers underneath it. You can use adjustment layers to make enhancements

to levels, curves, color balance, brightness/contrast, and color saturation.

TIP
The Brightness/Contrast adjustment layer is a tempting tonal adjustment tool to use, but

it is highly recommended that you use the Levels and/or Curves adjustment layer

instead to adjust contrast. The Brightness/Contrast adjustment can be very destructive

to your image, meaning that its usage results in the destruction of valuable pixels. You

can get very good results for increasing contrast or adjusting brightness by using Levels

and Curves adjustments properly. I’ll explain the use of color and tonal adjustments

further in Chapter 11, “Making Color and Tonal Corrections to Nature Photos.”

An adjustment layer affects all the layers beneath it in the Layers palette. The advantage is that a change made

to an adjustment layer doesn’t need to be repeated in the layers stacked beneath it. For example, if you want

to change the brightness of an image, you only have to make that change once to the overall image.

Fill layers allow you to fill the layer with solid colors, gradients, or patterns.
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The following list describes the types of adjustment and fill layers you can use in your image-editing workflow.

■ Solid color. A solid color layer is considered a fill layer. Create a solid color layer to fill an image

with a color. You can also use it to create a colored background for an image.

■ Gradient fill layer. You can use gradients to apply a color in a transition from light to dark. They are

useful for creating dark-edged vignettes for some images or for creating transitioned color back-

grounds.

TIP
You can also use gradients to create some cool image special effects, and you can

experiment with images by adding or reducing the opacity of the fill layer.

■ Pattern fill layer. Create a layer containing a pattern from the Pattern menu. Adjust the layer’s opac-

ity to strengthen or weaken the pattern effect.

■ Levels adjustment layer. This is the first tonal adjustment I make in my workflow. You can make

adjustments to levels of red, green, blue, and midtones in this layer. Chapter 11 covers the proce-

dure for using the Levels adjustment layer to make overall corrections to an image.

■ Curves adjustment layer. The Curves adjustment layer is the second step in my overall adjustment

workflow. Curves lets you make specific changes to tonality and color in an image. You can use it

to complement changes made in the Levels adjustment layer. For most photos, only slight changes

to the Curves grid are necessary.

■ Color Balance adjustment layer. The Color Balance adjustment layer makes changes to color hues

in an image. For most photos, these corrections are not needed if you use correct color-balance set-

tings in your digital camera, or even better, if you make color-balance corrections in Camera Raw.

■ Brightness/Contrast adjustment layer. As I’ve stated, you’re better off using Levels and Curves to

adjust the tonality and contrast of your images.

■ Hue/Saturation adjustment layer. This is my favorite of them all. One of the last steps in your image-

editing workflow is creating a Hue/Saturation layer and punching up the color saturation in your

image to make the color in your images pop.



Digital Nature Photography and Adobe Photoshop

210



Chapter 10    Setting Up and Getting Around in Photoshop

211

Implementing Color Management

We nature photographers can spend a lot of money for the gear we use for our craft. Travel costs to near and

faraway vistas can also put a dent in the pocketbook. There’s always the latest digital camera to buy, the next

lens in our collection, memory cards, gadgets, gizmos, and outfitting gear. Believe it or not, there’s something

else to help drain your wallet.

If you do a lot of printing, you’re constantly running to the computer store or getting on to the Web to purchase

inkjet cartridges and photo paper. At today’s prices, you can figure at least a dollar per 8×10-inch print, plus a

lot more when you’re printing up to 13×19-inch prints, like I do. Printing one series of prints can cost a lot, and

if you’re not using a color-managed workflow, your costs can skyrocket.

When adjusting and editing images in Photoshop, you want to make sure that the images you print on your

printer match exactly the image you’ve been viewing on your computer’s display. Otherwise, you’ll be throw-

ing money out the window every time you make a “test” print that doesn’t match, not to mention the level of

aggravation you have to put up with during the never-ending trial-and-error method of printing. To guarantee

your sanity, you need to implement color management.

If you’ve been doing nature photography and printing on your own for a while, you probably already have dis-

covered that the hardest thing to accomplish in digital photography is managing color. When you think about

all the steps involved—first shooting an image with particular light in mind, then converting the raw file, then

making further adjustments and edits in Photoshop, and then sending the image to a printer—it’s a miracle that

the final print even resembles what you first envisioned! Managing color helps you create prints that closely

match what the colors should look like, as illustrated in Figure 10.14.
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Figure 10.14  Color management helps ensure that color remains consistent from digital camera to print.

Processed with color management Processed without color management
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Color management is the process of producing images with the correct color, where color is predictable through-

out the image capture, editing, and printing processes. The key to ensuring that color is consistent throughout

the photographic process can be summed up by the following steps:

1. Capturing images. This is a fancy way of saying “shooting photos.” Making color-space settings in

your digital camera is the first step in your color-management workflow. Digital cameras actually

have a setting that determines the type of color they produce. This setting is known as color space.

Many digital cameras operate in one color space: sRGB. sRGB is a color space intended for images

to be viewed on your computer, not prints. This doesn’t mean that images from most digital cam-

eras won’t make good prints; Photoshop will convert the images to any color space you choose. If

your digital camera only offers sRGB as its color space, don’t worry; you can always convert your

files to another color space, such as Adobe RGB (1998), when you open them in Photoshop.

If your camera has the option of setting its color space to something other than sRGB, set it to Adobe

RGB (1998). Doing so will ensure that you’re shooting images in the same color space used for

working with photos in Photoshop that are intended for printing.

2. Applying color settings in Photoshop. After you install Photoshop on your computer, it isn’t exactly

ready to roll. You’ll have a little work to do to make sure color settings are applied correctly.

3. Viewing images on your computer monitor. Most of your time is spent in the digital darkroom,

working with images in Photoshop. The most critical element in implementing color management

is calibrating your monitor. (I’ll discuss profiling your monitor further in the next section.)

4. Printing. In effect, this is the final destination for all your efforts, and printing can be considered an

art in itself. There is actually a profession for master printers. As nature photographers who process

and print our own images, we need to become masters of printing as well. During the printing

process, color settings need to be precisely applied so that Photoshop is able to properly convert

color that will correctly be applied by the printer when producing prints.

If you apply the color-management processes described in this chapter, your prints will look more like what you

originally envisioned when you were shooting your images and working with them in Photoshop. You’ll save

time, money, and your sanity in the process!
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Calibrating and Profiling Your Display

As nature photographers, everything we do is visualized, and a key component of our visualization is our com-

puter monitor. It’s also the only device that stands between the digital camera and your final print; displaying

your images accurately on your monitor is critical. Properly profiling and calibrating (adjusting) your monitor

ensures that what you see is what you’re going to get in your final output of the image.

The most important step in implementing color management into your workflow is calibrating your monitor.

Calibrating on a regular basis is important because the colors, brightness, and contrast of your monitor change

over time. Whether you use a CRT (you know, an older, clunky monitor), one of those sleek new LCD moni-

tors, or a laptop computer, the rule remains the same: Calibrate on a regular basis.

By calibrating your monitor, you are effectively setting the stage for a successful color-managed workflow. If you

skip this step, you end up making adjustments to your digital files on the basis of false information. The result-

ing prints won’t match what you see on your monitor.

TIP
Most laptop (and some LCD) monitors won’t let you adjust color balance and contrast;

with some of them, only brightness can be adjusted. If you have an LCD monitor, you

should still calibrate to ensure optimal brightness settings. Calibrating is important to

ensure that colors are completely accurate; do as much of it as you can on your machine.

When you calibrate your monitor, you make adjustments to the brightness, contrast, and color balance to match

what your calibration software uses as its standard. These adjustments are actual physical changes to the oper-

ation of the monitor (but not to the image files you are viewing). They’re necessary to produce an accurate pro-

file that your computer then uses to determine what prints out.

The best solution for calibrating your monitor is specialized software used in conjunction with a colorimeter

that reads the actual color values produced by your monitor. Today’s top monitor-calibration systems include

the ColorVision Spyder2 or Color Plus (http://www.colorvision.com), or the Monaco Systems MonacoOPTIX

and MonacoEZcolor Photo Bundle (http://www.xrite.com).

http://www.colorvision.com
http://www.xrite.com
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Prices for these products vary, but if you are on a budget consider the ColorVision Color Plus. This software-

and-colorimeter system offers a good value for the money for most home systems; Color Plus provides much

more accurate calibration than Gamma or Colorsync for the Mac. Professional or serious photographers might

opt for the more high-end ColorVision or Monaco products.

Following are some important points when using a monitor-calibration package to calibrate your monitor.

■ Know how colorimeters work. Colorimeters read color from your monitor much more accurately

than you can when you look at your monitor; they provide a precise color profile.

■ Know the available products. All the monitor-calibration products mentioned include colorimeters

that attach to LCD monitors as well as to CRTs.

■ Understand the software. The software programs included are easy to use and provide step-by-step

instructions for you to calibrate your monitor. Calibrating your monitor using any of these products

isn’t any more difficult than using Gamma or Colorsync on the Mac. It’s easy!

■ Calibrate frequently. Most monitor-calibration solutions automatically remind you to calibrate your

monitor every few weeks. This is important because monitor characteristics change over time, so you

need to recalibrate over time. Calibrating your monitor every two to four weeks is recommended.

■ Have appropriate room conditions. Make sure the lights in the room you’re working in are dimmed

and the blinds are closed when you calibrate your monitor.

Setting Photoshop Color Preferences

After making sure your computer’s monitor is calibrated and profiled, the next most important step in ensuring

proper color management is making sure Photoshop color settings are correct and correct color profiles are

assigned to your images. Believe it or not, these are the most overlooked steps for photographers using

Photoshop. Making sure color preferences are correct will enable you to work in the best color environments

for the different types of images you might produce, including images for prints, screen, or media publishing.
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If most of your work involves preparing images for the Web, for printing, or for publishing, each of those tasks

will need a different color setting. The first step after calibrating your monitor (see the previous section) is to set

up your default color settings in Photoshop. Following are the steps to do so.

1. Access Color Settings. Choose Edit, Color Settings or press Ctrl+Shift+K (Cmd+Shift+K on the Mac)

to bring up the Color Settings dialog box.

2. Click the More Options button. This expands the Color Settings dialog box so you can see all the

options, as shown in Figure 10.15.

Figure 10.15  The Color Settings dialog box
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3. Choose overall settings. From the Settings drop-down list at the top, choose North America 

Prepress 2. The default for Settings is North America General Purpose 2, which isn’t very good for

photographers. North America Prepress 2 works best for photographers.

4. Set the working spaces. Change the Photoshop default for the RGB working space to Adobe RGB

(1998). Adobe RGB (1998) is the best working space for photographers, providing the widest color

gamut for color saturation. Make sure to leave CMYK, Gray, and Spot selections to their defaults. For

most of your image editing, use Adobe RGB (1998) to edit your master images. If you need to, you

can convert to the sRGB working space for the final output of Web images.

5. Set color management policies. Make sure to leave RGB, CMYK, and Gray set to Preserve Embedded

Profiles. This ensures that color settings are maintained in images you open in Photoshop. Leave the

three Profile Mismatches and Missing Profiles check boxes selected. These settings ensure that you’re

prompted to choose a color space to apply when you open an image in Photoshop that doesn’t

match your default working space.

6. Set conversion options settings. I recommend leaving the defaults for these settings to Adobe (Ace)

for the Engine and Relative Colorimetric for the Intent. The Engine setting controls Photoshop meth-

ods used for converting colors from one profile to another. The Intent setting specifies what you

want the rendering to accomplish for conversions from one profile to another. Adobe (Ace) and

Relative Colorimetric are optimal conversion settings for photographs. When editing photographs

in Photoshop, you get the best results by leaving the defaults (Use Black Point Compensation and

Use Dither) selected. This option ensures that the black point of your image matches the black point

of your print (or output). I normally leave the advanced controls set to their default settings of not

selected.

7. Click OK. This will save your color settings.
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Assigning Color Profiles

The final step to ensuring proper color management throughout your process is to make sure that the images

you open in Photoshop contain the correct color profile you’ve set up in the Color Settings dialog box. When

you open an image that doesn’t match that default color space, you’re prompted with the Embedded Profile

Mismatch dialog box, shown in Figure 10.16.

Figure 10.16  The Embedded Profile Mismatch dialog box

In this dialog box, you can choose one of three options:

■ Use the Embedded Profile. Select this option if you want to leave the image’s working space as is.

Remember that if you leave this option selected, you won’t be working in the default color space

you indicated in the Color Settings window.

■ Convert Document’s Colors to the Working Space. Select this option if you want to use your default

color space. This is recommended for most images.

■ Discard the Embedded Profile. Select this option if you don’t want to use a color profile for the

image.

Sometimes when you’re working on an image in Photoshop, you need to convert the image to another work-

ing space to obtain the best color for your intended output. To get the best color space, first edit your images

in Adobe RGB (1998), and then convert them later to meet your specific output needs. The combination of using

monitor profiles (explained earlier in this chapter in the section on calibrating your monitor) and assigning

color profiles will ensure an optimum color-management workflow.
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The process to assign a color profile to an image is as follows.

1. Open Assign Profile. Choose Edit, Assign Profile. The Assign Profile dialog box will appear.

2. Select the Working RGB option. Figure 10.17 shows Working RGB set to Adobe RGB 1998. Use the

Don’t Color Manage This Document selection only if you might need to submit your images to a lab

or publisher and you don’t know how they will color manage your images.

Figure 10.17  The Assign Profile dialog box

3. Select a profile. Select another profile from the drop-down list provided by the third option if you

desire. This choice is rare for most photographers, but you can use this option to assign a specific

profile. For example, a printing company for press services might have supplied you with a required

profile. You might also want to convert an existing image to sRGB if you are going to save a version

of the image for viewing on the Web, but I usually use the File, Save for Web command for that.

TIP
For most photographs, you want to select the Working RGB option, the same option I

recommend you choose in the Color Settings dialog box as your default working space.

Proofing

After making color settings in Photoshop and calibrating your monitor to give your computer a good profile to

set your display to, you’re ready to get into your color-managed workflow. When working with images, it’s

important to proof the images to make sure that what you’re viewing on your monitor closely matches the type

of output you intend for the image. Proofing is what all the information in this chapter is about—making sure

what you see on your monitor will be sent for output looking the same.
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Proofing is actually a pretty simple process. First, you need to set up your proofing profile to match the exact

output for which your image is intended. When I use the term “output,” I’m referring to a printer, a specific type

of paper you’re using in the printer, or even output intended for viewing on the Web or a PDF presentation. Turn

on proofing in Photoshop so the image you’re working with is simulated as viewed on your monitor and what

you’re seeing closely matches what should be printed.

Following are the steps to proofing in Photoshop.

1. Open the Customized Proof Condition dialog box. Choose View, Proof Setup, Custom.

2. Select a profile to simulate your intended output on your monitor. In the Customize Proof Condition

dialog box, select the output profile of the printer and/or paper combination, and then click OK.

Figure 10.18 shows the Customize Proof Condition dialog box with the Epson R1800 Velvet Fine

Art paper profile selected. I chose that selection because that is the particular printer and paper

combination I use. Your printer and paper combination will probably be different.

Figure 10.18  The Customize Proof Condition dialog box
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3. Turn on proofing. You can toggle Proof Colors on by choosing View, Proof Colors or pressing Ctrl+Y

(Cmd+Y on the Mac). Selecting the profile doesn’t change your monitor display, which is why you

must perform this step to get the right results. To view the difference between how your image looks

onscreen and how it should look when you toggle Proof Colors on and off, press Ctrl+Y (Cmd+Y

on a Mac) to toggle proofing on and off. When Proof Colors is on, the image you’re viewing on the

monitor should closely match what should be printed.

Summary

I’ve thrown a lot of information at you in this chapter, but it’s all important to guarantee the utmost quality.

Knowing how to navigate Photoshop’s menus, palettes, and the Toolbox is the key to being comfortable work-

ing with Photoshop. Implementing a color-management workflow is the most important step you can take to

ensure your nature photographs are going to match what you envisioned.

In writing and teaching Photoshop concepts to many, I’ve learned that if you practice and master the Photoshop

navigation, then implement a color-management workflow, you have 80 percent of the digital darkroom knowl-

edge. The rest—making overall corrections and editing images in Photoshop—will be a breeze.

To review, following are the skills you need to be successful processing your nature photos in Photoshop.

■ Become comfortable navigating Photoshop. The first step is becoming familiar with Photoshop

menus and all the functions and commands those menus contain.

■ Get to know the tools available in the Toolbox. Like a painter, you need to have all of your paint-

ing stuff handy, know what these tools are, and know where you can use them.

■ Take advantage of what palettes have to offer. Photoshop palettes provide you with a slew of tools

you can use when processing your images. The most important palette is the Layers palette.

■ Implement a color-management workflow. By applying the correct color settings in Preferences,

assigning profiles, and proofing, you’ve guaranteed yourself an efficient work environment to process

your images. What you’ll see on your screen is what’s going to pop out of your printer, saving you

a ton of money in paper and tranquilizers.
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I
’ve been stressing throughout the book the need to process your images in a step-by-step manner, a work-

flow. One of the first steps I showed you to work toward this goal was to review the image in Camera Raw.

Although the goal in making overall adjustments in Camera Raw is to reduce the sheer number of overall

adjustments needed in Photoshop, there is still much creative work to do! Photoshop is actually where you take

the steps to complete the adjusting and editing of your image. Heck, you might not even be shooting your

images in the raw format, so Photoshop is the place where all of your tonal and color adjustments will need to

be made.

In this chapter, I’ll show you in detail the workflow for making tonal and color corrections in Photoshop. The

following overview of this workflow summarizes the steps for making quick tonal and color adjustments and

edits to an image.

1. Open an image in Photoshop. If your image is in raw format, using Bridge, open an image in Camera

Raw, make adjustments, and then click the Open button. The image will open in Photoshop. If the

image is in JPEG or TIFF format, browse the image thumbnails and double-click on an image to

open it directly in Photoshop.

2. Save the image as a PSD file. After you open an image in Photoshop, the file is still in the digital

format native to the camera that took the picture. For example, if you took the image in raw format

and converted it in Camera Raw before opening it in Photoshop, the image would still be in the raw

format taken, such as .NEF for a Nikon digital camera or .CR2 for a Canon model. Saving the image

to another folder in Photoshop format is the best method for keeping your images organized and your

original image preserved.

Select File, Save As or press Shift+Ctrl+S (Shift+Command+S on a Mac). The Save As window, shown

in Figure 11.1, gives you the choices to select a folder, change the filename if you choose, and most

importantly, change the file format. Select the folder to which you want to save your working file,

and then click the Format selection box to select Photoshop (*.PSD, *.PDD) as the file format. Click

the Save button to save your working file.

3. Duplicate the background layer. As you’ve discovered, I’m a stickler for making backups and pro-

tecting original files…and layers. As discussed in Chapter 10, images are adjusted and edited in

separate layers. When you open an image, all the image information is contained in the background

layer. You should create a new layer to contain every color adjustment, tonal adjustment, and edit

separately. By creating separate layers, you ensure that you can always go back to that particular layer

and make changes without affecting the other layers. You can also delete a layer if you don’t like an
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adjustment you made, and then keep the original image intact. When you’ve finished making

changes to your image, you’ll have a number of layers, each with its own adjustment or edit.

Backing up the original background layer is just my particular best practice for protecting the back-

ground layer. To back up and protect the original background layer, choose Layer, Duplicate.

4. Evaluate the image and formulate a plan of attack. Before diving in and beginning to make adjust-

ments and edits to an image, I always sit back and view it first, evaluating the image. This important

step ensures that you are making a plan of attack for the image.

Figure 11.1  The Save As window
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TIP
One tool offered by Photoshop is Variations. Variations is found in the Image,

Adjustments menu and can be a very useful tool in helping you evaluate your image.

Variations, shown in Figure 11.2, allows you to make changes to an image’s shadows,

midtones, highlights, and saturation by viewing different variations of the image and

clicking on those variations to make changes. As a nature photographer, I like Variations

because it gives me a visual cue for what changes I might want to make during my color

and tonal adjustments. However, I usually don’t use Variations to make my changes, just

to view different possibilities.

Figure 11.2  Using Variations to help evaluate an image



Digital Nature Photography and Adobe Photoshop

234



Chapter 11    Making Tonal and Color Corrections to Nature Photos

235

5. Correct the exposure. A recent addition to Photoshop with the release of CS2, the Exposure adjust-

ment (Image, Adjustments, Exposure) gives you the ability to correct JPEG or TIFF images that are

overexposed or underexposed. If you shoot and process raw images, you won’t need to take this step.

The Exposure adjustment in Camera Raw is non-destructive and is a better adjustment to use, but

only if you shoot raw images. If your image is a JPEG or TIFF that is in need of exposure correction,

consider using the Exposure adjustment to make changes.

6. Adjust shadows. Another addition to Photoshop with the release of CS2 is the Shadows adjustment

(Image, Adjustments, Shadows). Like the Exposure adjustment, if you shoot and process raw images

in Camera Raw, you won’t need to use the Shadows adjustment in Photoshop.

7. Create a Levels adjustment layer. The first step in my overall adjustments is adjusting levels. Levels

adjustments make corrections to the tonal values of an image by fine-tuning the colors in the high-

lights, midtones, and shadows.

You can create adjustment layers by clicking on the Create New Fill or Adjustment Layer icon that’s

located on the bottom of the Layers palette, and then choosing which type of layer to create.

8. Create a Curves adjustment layer. To avoid using the Brightness/Contrast adjustment layer to increase

or decrease the contrast in an image, I strongly recommend you use the Curves adjustment layer to

make fine adjustments to contrast and the tonal values in an image. Using Curves is much less

destructive than using the Brightness/Contrast adjustment and it allows for adjustments on up to 14

points of the tonal range of an image.

9. Create a Color Balance layer. You only need to do this if your white balance is out of whack for your

image, especially if the original wasn’t processed in Camera Raw.

10. Create a Saturation adjustment layer. My favorite adjustment can be found in the Saturation layer.

Saturation allows you to increase color in your image. To make your images “pop” with some color,

click the Create New Fill or Adjustment Layer button on the Layers palette and choose

Hue/Saturation.

11. Save the image. After making adjustments, save the image by choosing File, Save or by clicking the

Save button on the Option bar.
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Correcting Exposure

If you’ve followed the steps I just described by opening an image in Photoshop and then duplicating the back-

ground layer, you’re ready to make any exposure corrections that might need to be done to your image. As you

recall, Camera Raw has a great exposure adjustment, but not all of us shoot in the raw format. If you need to

make a correction to an underexposed or overexposed image, follow these steps:

1. Open the Exposure adjustment. Choose Image, Adjustments, Exposure. The Exposure Adjustment

window, shown in Figure 11.3, will appear.

2. Adjust the exposure. The image shown is underexposed by about a half stop. Using the Exposure

adjustment, you can increase the exposure by moving the slider slightly to the right. You’ll notice

that you don’t have to move the slider far to get results.

Figure 11.3  The Exposure adjustment and the Layers palette
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3. Adjust the offset. The Offset slider will change the shadow areas of the image without affecting the

highlights. In real-speak, this means you can increase the contrast (darken it) by moving the slider

slightly to the left, and you can decrease the contrast by moving the slider slightly to the right. Again,

you only have to move the slider in small increments to make any change to the image. I usually

leave this adjustment set to its default.

4. Adjust the gamma. Gamma is an adjustment to the midtones of the image. I rarely use this slider in

the Exposure adjustment, but you can experiment with your results by moving the slider slightly to

the left to decrease the gamma or slightly to the right to increase the gamma of the image.

5. Click OK. To save your changes, click the OK button, or click the Cancel button if you would rather

not use the changes made with the Exposure adjustment.

TIP
To compare the changes you’ve made to the exposure, select and deselect the Preview

check box. If you like the version of the image without the Exposure adjustment, just

click Cancel.

Adjusting Shadow/Highlights

The Shadows adjustment (Image, Adjustments, Shadows) lets you lighten or darken the shadow areas of an

image. I’ll often use it to darken backgrounds, such as in photos of foliage where I want fall color in the leaves

to stand out against a darker background. When I’m shooting raw, I’ll use the Camera Raw Shadows adjustment,

but if you’re shooting JPEG or TIFF images from your digital camera, you’ll want to give the Photoshop Shadows

adjustment a whirl.

To adjust shadows in Photoshop:

1. Create a new layer. Because the Shadows adjustment isn’t an option on the Create New Fill or

Adjustment Layer button in the Layers palette, you can simply right-click on the background layer

and choose Duplicate Layer to duplicate the background layer. Make sure you name the layer

Shadows, like in the Layers palette shown in Figure 11.4. If you have already made some adjust-

ments, you can create a new layer that combines all the previous layers into one by pressing

Shift+Ctrl+Alt+E on your PC or Shift+Command+Option+E on a Mac.
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Figure 11.4  Creating a

Shadow/Highlights layer

Figure 11.5  Adjusting Shadow/Highlights

2. Adjust Shadow/Highlights. The Shadow/Highlight window, shown in Figure 11.5, shows the

Shadows slider and the Highlights slider. You can check the Show More Options box in the lower-

left corner of the window to view more options. I rarely ever use them, but you can experiment with

the more advanced options.

Move the Shadows slider to the left to darken the shadow areas of the image, or move the slider to

the right to lighten the shadow areas of the image. My goal was to correct the exposure in the

shadow areas while adjusting highlights in this image to compensate for some overexposed areas

at the top of the tree. If you noticed, the image has a nasty magenta cast. I’ll be correcting that later

in the workflow.

3. Click OK. If you don’t want to save your changes (this can be a complex adjustment, so sometimes

you won’t want to save your changes), just click the Cancel button.
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Levels Adjustment Layer

Creating a Levels adjustment layer is often the first step I take after opening raw

files in Photoshop. The Levels adjustment makes corrections to the tonal values of

an image by fine-tuning the colors in the highlights, midtones, and shadows. If I’m

processing a raw file in Camera Raw, I have already adjusted white balance, expo-

sure, and shadows. My next step is creating a Levels adjustment layer. If I’m pro-

cessing JPEGs or TIFF images, this step might come after Exposure or

Shadow/Highlights.

1. Create a Levels adjustment layer. Click the Create New Fill or

Adjustment Layer button located on the bottom of the Layers palette,

as shown in Figure 11.6.

2. As shown in Figure 11.7, the Levels adjustment window shows you a

graphical representation of the color distribution (red, green and blue

channels) of the image, also referred to as the histogram. Below the his-

togram are three sliders.

The slider on the left controls the shadow portions of the image, the

middle slider controls the midtones (also called the gamma) of the

image, and the slider on the right controls the amount of color in the

highlight areas of the image.

With the default channel set to RGB, move the left and right sliders to

the point of the histogram at which pixels begin to show up clearly.

Moving the middle slider to the right increases contrast in the image

by darkening the highlight areas. Experiment with moving the sliders

until you get the result you want. Don’t forget to have the Preview box

checked! Figure 11.6  Creating the

Levels adjustment layer
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3. Select a channel. Keep the channel selection as RGB so you can correct levels for the entire image

(all three color channels—Red, Green, and Blue) at the same time.

As you become more familiar with adjusting levels in Photoshop, experiment with changing the

channel selection to the Red, Green, or Blue channels and adjusting them individually. If you are a

new user of Photoshop, keep the RGB Channel selected.

Figure 11.7  The Levels adjustment window
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4. Adjust the shadows. View the histogram and slide the Shadows input slider (the one on the left) to

the right until it gets to where the curve begins to appear in the histogram.

With Preview selected, you can view the image changes as you move the slider.

A histogram provides a snapshot of the tonal range of an image. The histogram shows how much

detail is in the shadow area on the left, in the midtones in the middle, and in the highlights on the

right.

Histogram data is different for every image. For many images, the histogram curve begins all the way

to the left, where no Shadow input-slider adjustment is needed.

5. Adjust the highlights. Slide the Highlights input slider (the one on the

right) to the left until it gets to where the Highlights curve begins.

6. Adjust the midtones. Move the Midtones input slider (the one in the

middle—this is the one you’ll use most) to the right slightly, checking

the image for improved color saturation and contrast. You can often

improve the appearance of an image by using the Midtones slider to

darken the midtones.

7. Click OK to complete the Levels adjustment. If you are not satisfied

with the effects of your Levels adjustment, just click on the Cancel but-

ton.

Curves Adjustment Layer

When you adjust the tonal range of an image using Levels, you make only three

adjustments: shadows, midtones (gamma), and highlights. The Curves adjustment

allows for up to 14 different points of adjustment throughout the tonal range.

Make a habit of using the Curves adjustment to finish any fine-tuning of tonal

adjustments.

To adjust an image’s tonality and increase some contrast at the same time using

the Curves adjustment layer, follow these steps:

1. Create a Curves adjustment layer. Click the Create New Fill or

Adjustment Layer button in the Layers palette and then choose Curves,

as shown in Figure 11.8. Figure 11.8  Creating a Curves

adjustment layer



Chapter 11    Making Tonal and Color Corrections to Nature Photos

245

2. Increase the grid lines. Increase the number of grid lines to provide a more precise grid. Press and

hold the Alt key (the Option key on the Mac) while clicking inside the Curves grid to increase the

number of grid lines. Figure 11.9 shows the Curves grid with increased grid lines.

Figure 11.9  The Curves adjustment window

3. Make tonal adjustments. Click on a point of the curve line and drag it to the desired grid point or

click Auto. To adjust the highlight areas of the image, drag the curve line that is closer to the top-

right of the grid. To adjust the shadow areas of the image, click and drag the curve line at the bot-

tom-left of the grid. Drag the curve upward and left to brighten, downward and right to darken.

Experiment with creating adjustments for shadows, midtones, and highlights. I find that creating a

slight S curve works best for most images.

4. Click OK to save your changes. If you don’t like the results of using the Curves adjustment, just

click the Cancel button, and the layer will not be created.
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Color Balance Adjustment Layer

Now is the time to get rid of that nasty magenta color cast in our tree photo. The rock that appears in the back-

ground should be more red, and the tree is too blue. Normally, I would have eliminated this color cast in

Camera Raw using the White Balance adjustment (the image was shot with an incorrect white balance, which

makes for a good example, don’t you think?), but if you’re shooting JPEG or TIFF, you don’t have the luxury of

that adjustment; there isn’t one in Photoshop.

The Color Balance adjustment accomplishes changes to color in your images like

we used to in the chemical darkroom. When making prints with a color enlarger,

we had to manually insert color filters consisting of cyan, magenta, yellow, red,

green, and blue. Depending on the combination of filters you used in the enlarger,

you were able to somewhat control the color output of the print. These adjust-

ments are automatically made when you take rolls of film to the corner store to

be developed on their expensive computerized equipment (either in-house or sent

out). The Photoshop Color Balance adjustment gives the photographer finer con-

trol over color than any computer adjustment can calculate; our own eyes give us

more of an interpretive understanding of color than any computerized whiz-bang

machine ever could.

To make color correction using the Color Balance adjustment:

1. Create a new Color Balance adjustment layer. Click on the Create

New Fill or Adjustment Layer button on the Layers palette, as shown

in Figure 11.10.

2. Make color adjustments. This is the fun part. Remember how I men-

tioned in Chapter 9 that making white balance adjustments is a lot

easier in Camera Raw than in Photoshop? This is the part where you’ll

need just a little practice balancing your color in other types of images.

The Color Balance adjustment gives you three sliders (see Figure

11.11)—the Cyan/Red, Magenta/Green, and Yellow/Blue sliders. By

judging the test image we’ve been using throughout this chapter, I’ve Figure 11.10  Creating a Color

Balance adjustment layer
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already evaluated the image and found that it has way too much magenta in the background rock

area; it should be more “reddish” in color. The tree is also off color, containing blue where it needs

more red. The three sliders allow you to readjust color from their opposites (Cyan/Red,

Magenta/Green, and Yellow/Blue).

I’ll first adjust the Cyan/Red slider by adding red to the image, then I’ll add green to the image using

the Magenta/Green slider, and then I’ll reduce the blue by increasing yellow with the Yellow/Blue

slider. The results of making these adjustments put my image in more of a color balance.

3. Click OK to save changes.

Figure 11.11  Making color changes with the Color Balance adjustment layer
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Finishing the Hue/Saturation Layer

The next steps in the overall-adjustment workflow are to add some visual “pop”

to your image, to add color saturation to make final color adjustments, and to

increase vibrancy in the image. Hey, I like color! You can also make final correc-

tions to color if your image still contains a slight color hue, like in the example.

With any overall adjustment, sometimes less is more; you might need to make only

a slight correction. When adjusting color saturation, for example, sometimes all you

have to do is nudge the slider to the right until you see the colors pop a little. “Easy

does it” is the rule if you don’t want to make your images appear unrealistic. For

our test image, I still think there is a little too much blue in the image, especially

in the wood part of the tree. Let’s fix that and add some pop to the image.

To create a Hue/Saturation layer, follow these steps:

1. Create a Hue/Saturation layer. Click the Create New Fill or Adjustment

Layer button on the Layers palette, and then choose Hue/Saturation, as

shown in Figure 11.12. The Hue/Saturation dialog box will appear.

2. Make sure Preview is selected. You want to be sure you see these

changes before you apply them.

3. Adjust the hue of the image. Move the Hue slider to the right to

increase the green hue in the image. Move the Hue slider to the left to

increase the reds. Figure 11.13 shows the Hue/Saturation window.

4. Adjust the saturation. Increase image saturation by moving the

Saturation slider slightly to the right. As a rule of thumb, increase the

saturation until you see the colors start to pop. Be careful not to add

too much color saturation; it can make certain colors in the image

blow out, or lose detail as they’re overpowered by the color. If some areas look blown out, back off

your adjustment slightly until you’re pleased with the results.

You can use the Hue/Saturation adjustment layer to adjust individual color hues or saturation

amounts. This is an advanced method of color-correcting your images. Just click on the Edit field and

choose an individual color to adjust. Experiment with changing the hue and/or saturation of each

color to see the results. You might find that adjusting the Master (the default setting) alone can work

just fine for your photos.

Figure 11.12  Creating the

Hue/Saturation layer
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Figure 11.13  Adjusting Hue/Saturation in the image to make final color corrections

For this image, I decreased the saturation in the blue color, increased some saturation in the remain-

ing colors, and darkened the yellow channel a bit.

5. Check the gamut warning. Choose View, Gamut Warning. For our test photo of the tree, I actually

had to decrease some saturation in the red channel to bring the image more within the gamut of my

selected output (but then I increased the saturation of some other colors).

6. Click OK to save your settings. Figure 11.14 shows the original image compared to the image after

I made all the adjustments illustrated in this workflow—Exposure, Shadow/Highlights, Levels,

Curves, Color Balance, and finally Hue/Saturation. It’s quite a difference! You can see that using a

structured color and tonal correction workflow can do wonders for images that are out of whack

when it comes to color balance, and you can salvage those off-color images.
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Figure 11.14  The original image and the final image with the Exposure, Shadow/Highlights, Levels, Curves, Color Balance, and Hue/Saturation adjustments

applied

Original image Final adjusted image using the color and tonal correction workflow
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Summary

Adjusting color and tonal values of an image is a talent you can only acquire with practice. Using a consistent

and rigid workflow, you’ll master this most important part of your overall image processing. Following is a

quick review of the steps to making color and tonal adjustments to your nature images:

1. Open an image in Photoshop.

2. Save the image as a .PSD file. Make sure you save your image to a Working Images folder.

3. Duplicate the background layer.

4. Evaluate the image and formulate a plan of attack.

5. If needed, correct the exposure and shadows.

6. Create a Levels adjustment layer.

7. Create a Curves adjustment layer.

8. If needed, create a Color Balance adjustment layer.

9. Create a Hue/Saturation adjustment layer.

10. Save your .PSD file to your Working Images folder.
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A
fter running your images through overall color and tonal corrections, you’ll want to continue finishing

off your nature photos by adding edits. I’ve always recommended that everything you do in Photoshop

be part of a workflow, and editing nature photos isn’t any different. You still need to stick to a rigid

process to help you obtain consistent quality results.

The image-editing workflow is very much like the overall-correction workflow I described earlier. Image edits

are made in a step-by-step sequence of best practices. Unlike the procedure for overall color and tonal cor-

rections, however, you do have the freedom to mix up the order of your edits a bit. For the sake of consistency,

I recommend you make edits in individual steps.

1. Plan your edits. After you complete overall corrections, evaluate your image to determine what type

of edits are needed, if any. Common types of edits to plan for include dodging and burning, remov-

ing spots with the Spot Healing brush or the Clone Stamp, and retouch-

ing using other tools, such as the Paintbrush. I’ll review editing tools in

this chapter.

2. Create separate layers for each edit. After you evaluate an image, and

then decide that you need to perform additional editing, as a best prac-

tice, you need to create separate layers for each edit. That way you can

delete layers in which edits just didn’t do the job, without affecting other

image-editing layers.

To create a new layer, press Shift+Ctrl+Alt+E on a PC or Command+

Shift+Option+E on a Mac to merge a copy of all visible layers into a new

target layer. How ‘bout them keystrokes!

By combining all the previous layers into the new layer, you’re essentially

merging all the adjustment layers and other edits you’ve made so far.

Additionally, you will want to give the layer a proper name. For example,

if you’re creating a new layer to use the Spot Healing brush to remove

spots on your image, give the layer a descriptive name, such as “Reduce

Noise.” Double-click the layer name in the Layers palette and type in a

new name, as in the example shown in Figure 12.1.

Figure 12.1  Name your

editing layers with descrip-

tions of what was performed

on that layer. It will help give

you a reference of what

actions you’ve performed on

your images.
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3. Edit your image. Now that you have a fresh, newly merged layer to work on, you’re ready to use

Dodge, Burn, the Spot Healing brush, filters, or any other type of edit you want.

As a reminder, keep each edit to its own layer. If you start off by dodging and burning, and then you

decide you want to apply the Reduce Noise filter as your next step, create a new layer first by choos-

ing Layer, Duplicate Layer.

Common Editing Tools

Most of the tools you’ll use for editing will either be provided in the Toolbox or in filters. Filters are effects that

you can add to your image, such as a blur, a lens correction, or an artistic change to the image. Either way, edits

are not considered corrections; they are additions to (or subtractions from) your images.

When editing nature photos, the most common tools you’ll use will be the various selection tools Photoshop

offers, the Healing brushes, the Paintbrush, the Dodge and Burn tools, and the Eraser tool. All these tools are

easily available in the Toolbox, while filters are located in the Filter menu. (I’ll show you how to apply filters

in the next chapter.) In the next few sections, you’ll take a look at some of the more popular tools used by

nature photographers.

Selection Tools

If you’re editing photos that look just fine for the most part, often you’ll want to make edits (or overall color and

tonal adjustments) only to certain parts of them. I’ll often make adjustments only to the sky portion of an image

during the editing process. Photoshop offers a variety of tools to make selections from defined, editable areas

within an image. When you make a selection in Photoshop, you can then edit only that part of the image,

without changing the rest. Getting familiar with selections is necessary if you want to edit your individual

images with consistent quality.

TIP
After you’ve created your first editing layer and combined all the visible layers into that

layer, you can simply duplicate the new layer for whatever new edit you want to per-

form next.
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Selecting only certain parts of your images and editing only those selected parts using the tools covered in this

chapter gives you great creative control. You can replace a dull background with a vibrant color, darken a bright

sky (see Figure 12.2), brighten a dark sky, and selectively sharpen or blur a part of your image to get the desired

effects.

Figure 12.2  By making a selection of only the sky portion of the image, you can make overall adjustments to only that part of the image, without affecting the rest.

Before selection and adjustment After selecting the sky only, and then darkening

The Magic Wand Tool

The Magic Wand tool is probably the most popular selection tool used to make the most common selections

in photos. I often use the Magic Wand to select areas of an image that are similar in color if I want to make color

or tonal changes to only the selected areas.

The steps to making selections are as follows:

1. Create a new layer. You know the drill: Shift+Ctrl+Alt+E on the PC or Shift+Command+Alt+E on 

the Mac.
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2. Select the part of the image you want to modify using the Magic Wand tool. As you know by now,

I often use the Magic Wand tool to select backgrounds in images that I want to change. I can lighten

or darken the background, replace the background with parts from another image, or blur the back-

ground. Whichever adjustment I want to use, I have to separate the subject from the background

before I make my edits.

The Magic Wand tool (see Figure 12.3) works best when the area you’re selecting is one color (or

close to one color) and has distinct boundaries from the remaining areas.

The Magic Wand tool also works well as a way to select the subject of an image instead of the back-

ground. Select the background, and then choose Select, Inverse to swap the selections for the rest

of the image.

Figure 12.3  The Magic Wand tool and the Photoshop Toolbox
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The Feather setting is important when you’re making selections. The Feather setting determines how

many pixels will be “blended” along the border of the selection you make. The amount of feather-

ing determines how sharp or smooth the edges of the selection are. For the image in Figure 12.3, I

applied a Feather radius of two pixels by choosing Select, Feather (Ctrl+Alt+D on the PC or

Command+Option+D on the Mac), and then typing 2 in the Feather Radius field in the Feather

Selection window.

3. Apply corrections to the image. For the sunrise photo, I adjusted the tone and contrast of the sky

without adjusting color and tone for the rest of the image. For the lake, I simply chose Select, Inverse,

and then chose Image, Adjustments. Figure 12.4 shows the results.

Figure 12.4  Making changes to the selected part of the image only
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The Lasso and Magnetic Lasso Tools

I use the Magic Wand tool for many of the selections I make in images in Photoshop,

but there are more cool selection tools to choose from. The three lasso tools (see the

Toolbox in Figure 12.5) are used to create finer selections in your image. Each has

its own characteristics and function. The three lasso tools include:

■ Lasso tool. This tool is used for freeform drawing of selections. You can use

this tool to edit distinct areas in the image, which you draw around using

the Lasso tool.

■ Magnetic Lasso tool. This tool is used to trace more complex shapes. The

selection marquee (the dotted line surrounding your selection, also called

the “marching ants”) snaps to the selection like metal to a magnet.

■ Polygonal Lasso tool. This tool is used for drawing straight edges of a

selection. The Polygonal Lasso tool is great for making selections when the

areas to select are shapes that have straight lines (such as boxes, rectan-

gles, and triangles).
Figure 12.5  The lasso tools

TIP
You can always remove a selection if you want to start over by choosing Select,

Deselect or by clicking Ctrl+D on the PC or Command+D on the Mac. Additionally,

ending one selection and starting another automatically will deselect the first selection.

To add to a selection, hold down the Shift key and continue in a different location in the

image. You can even change tools while you’re at it! To remove a portion of your selec-

tion, press the Alt key (Option on a Mac) and use any of the selection tools to outline

areas you don’t want selected.
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Selection Options

When you make selections with any tools, options are available to make your selections

more precise. Figure 12.6 shows the Select menu, which provides functionality to help

you work with selections.

The most commonly used options in the Select menu include:

■ All. When you select All, you select the entire layer that’s active. You can also

press Ctrl+A on the PC or Command+A on the Mac to select the entire image.

■ Deselect. Choose Deselect to remove the selection outline you have made.

When making selections, you often have to deselect to start over when your

selections don’t come out right—hey, it happens! You can also press Ctrl+D

on the PC or Command+D on the Mac to deselect a selection outline.

■ Inverse. Sometimes you will want to select an area that’s just tough to select.

If you’re lucky, the rest of the image might be easier to select. In that case,

select the easier area, and then choose Select, Inverse or press Ctrl+Shift+I

on the PC or Command+Shift+I on the Mac. The Inverse command reverses

your selection, selecting the previously unselected portion of your image.

■ Feather. As I’ve mentioned previously, a feather of two or three pixels provides a smooth, realistic

edge for your selections in many photos. Experiment with setting the feature to different numbers

of pixels until you find the right setting for your photo. To feather a selection, choose Select, Feather

or press Ctrl+Alt+D on the PC or Command+Option+D on the Mac.

■ Grow. The Grow command increases the contiguous areas of your selection to include areas that

are similar in color. To grow a selection, choose Select, Grow.

■ Similar. The Similar command increases your selection to include all like colors of the current selec-

tion, regardless of their place in the image. To expand a noncontiguous selection with similar col-

ors, choose Select, Similar.

Figure 12.6  The

Select menu
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Before you can use the Select commands, you must have actual selections made in your image. Selections can

be cumbersome, but with practice you can become more proficient. I suggest you practice using the three

lasso tools, and especially the Magic Wand tool, and then experiment using the Feather, Grow, and Similar com-

mands to fine-tune your selections. Selections are one of the most challenging tasks to master in Photoshop,

and the best way to get proficient with selections is to become comfortable with each type of selection and the

commands to customize those selections.

Dodging and Burning

When I start to put the final touches on my images, some of the first edits I perform are dodging and burning.

This is an old technique that dates back to the old film and darkroom days of photography. Dodging and burn-

ing allowed me to darken or lighten certain areas of a print to my liking by either reducing or increasing expo-

sure to certain parts of the print. You can do the same thing in Photoshop using the Dodge and Burn tools,

shown in Figure 12.7.

Dodging is a technique you use when you want to lighten a certain area of an image; burning is a technique

you use when you want to darken a certain area of an image. Whether you’re working on landscapes or still

lifes, evaluate your images to see whether areas need to be dodged or burned. Figure 12.8 shows an image with

a lot of contrast and colors that are a little too bright. Shooting fall colors in ideal conditions (on an overcast

day, after a rainstorm) can bring out the colors, but it can also produce oversaturated colors, especially reds and

magentas. After my evaluation, I decided to lighten up some of the dark areas in the background, and to tone

down some of the oversaturated red and magenta areas of the image.

TIP
If you’ve used the Magic Wand to create your selection, you can change the Tolerance

level after you’ve made the selection, and it will affect the number of pixels that Grow

and Similar will add to the selection. In other words, if you had a tolerance of 16 when

you made the original selection and then you clicked Grow, you’d get a tolerance of 16

added to the selection. Changing the number to 64 will select a larger spectrum when

Grow is used. With that, you can go back and forth (using the Undo command), modi-

fying the tolerance level until you get exactly the pixels you want.
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The Sponge tool is useful when you want to make slight color-saturation adjustments to an area. For example,

you can decrease the color saturation of a certain area in which the red might be too bright or “blown out,”

giving an unnatural look to the photo. The Sponge tool can also come in handy to help bring out-of-gamut areas

of your image back into a color range that your printer can handle.

Figure 12.8  You can use the Dodge tool for an image in which the colors are too bright
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Figure 12.7  The Dodge,

Burn, and Sponge tools
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I often use the Dodge and Burn tools to fine-tune my images when there’s a little too much contrast between

the light and dark areas. Figure 12.9 shows the image before my edits, and then after I applied some dodging

and burning.

Figure 12.9  Using the Dodge tool

Before dodging and burning After dodging and burning
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Using the Paintbrush

The Paintbrush tool will be one of your most-used tools in the Toolbox. The Paintbrush is as simple as its name;

it’s a paintbrush! Not only can you specify colors and the opacity (how much of the edit is visible, based on a

scale of one to 100 percent) of those colors, but you can also use it to “paint” in other effects you add to your

image when you use it with layer masks. (I’ll provide more information on layer masks later in this chapter, in

the “Layer Masks to Selectively Correct Images” section.) In addition to the Paintbrush tool, the Pencil and the

Color Replacement tools are also commonly used to “paint” in changes to your photos. Figure 12.10 shows the

Paintbrush tool and its flyout menu.

Numerous Paintbrush sizes, tips, and modes are available on the Option bar, as well as in the Brushes palette

(choose Window, Brushes or simply press the F5 key), as shown in Figure 12.11. They’re useful with many

Photoshop image-editing techniques, allowing you to customize your brush types and various settings.

Figure 12.10  The Paintbrush tool

and flyout menu Figure 12.11  The Brushes palette and the Option bar with the Paintbrush tool options
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Using the Healing Brushes

One of the downfalls (the only one I can think of) to using a digital SLR is the possibility of dust getting onto

your image sensor. It has happened to me on a few occasions, usually when I’m changing lenses. For users of

compact digital cameras, dust spots aren’t really possible because the lens is built into the camera. Another

source of dust or scratches on images is related to scanned negatives or transparencies. Many of us have huge

photo libraries from years of shooting the old “analog” way. Those shots are still as valuable today as yesterday,

but when you’re scanning, it’s always possible to scan some specks of dust too. That’s where the Healing brushes

come in to help.

Some of the neatest editing tools that Photoshop offers are the Healing brush tools.

The flyout menu shown in Figure 12.12 includes four Healing brush tools that

enable you to correct minor details. Use the Healing brush tool to sample a selec-

tion of pixels, and then paint those selected pixels to other areas. It’s a great way

to retouch areas of your images! The Spot Healing brush, new in CS2, is even eas-

ier to use. Simply select the Spot Healing brush and start painting areas to retouch;

the brush samples surrounding pixels itself, without you having to make a selec-

tion. The Patch tool works like the Healing brush, except you’re actually making a

selection of an area (just Alt+click on the PC or Option+click on the Mac) to use

for painting in the selected pixels.

When using the Healing Brushes, there are three options: Source, Destination, and

Transparent. If Source is selected, the selected shape can be moved around the

image, and the area beneath the selection (the source area) will fill the area that

was selected (the destination area). Choose the Destination option, and it’s more

like a copy and paste function, because the selection area becomes the source

area and its contents are moved to the new spot in your document—the destina-

tion area. When the Transparent option is selected, it works in conjunction with the

other two options, and the result is a transparent overlay of the selected area of the

image. You cannot control the amount of transparency, but you can continually

add to the selection to create some interesting effects.

Figure 12.12  The Healing

brush and flyout menu
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The Clone Stamp Tool

The Clone Stamp tool is the equivalent of a rubber stamp, like the kind they use at the tax office. It allows you

to sample part of an image (that you want to clone) and apply that sample elsewhere in the image by painting

it with the Clone Stamp brush. All Paintbrush tips work with the Clone Stamp tool, so it’s a great retouching alter-

native. One of its special versions, the Pattern Stamp tool, recreates patterns from the cloned selection and

applies them to other parts of your images. Figure 12.13 shows the Clone Stamp tool flyout menu.

The Eraser Tool

The Eraser tool is the digital equivalent of those little pink erasers at the ends of pencils. Remember using those?

You can erase pixels as you move the Eraser brush over them, changing the behavior of the brush specified by

using the choices on the Option bar.

Use the Background Eraser tool to remove the effects of overall image adjustments made to only certain areas

or layers of the image. To erase all similar pixels within a layer, use the Magic Eraser tool. Among the tools shown

in Figure 12.14 (in the flyout menu) are the Background Eraser and the Magic Eraser.

Figure 12.13  The Clone

Stamp tool and flyout menu

Figure 12.14  The Eraser tools

TIP
If you use Adobe Photoshop Elements instead

of Photoshop, the Eraser tool is a great way to

selectively remove effects or filters you might

add to an image without the aid of layer

masks. (More on those later.) Elements does

not offer layer masks, which are an advanced

editing technique, but if you add effects to an

image and you only want a part of the image

to have those effects, you can use the Eraser

tool to erase whatever parts of the effect you

don’t want.
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Layer Masks to Selectively Correct Images

One of the more advanced features of Photoshop that separates it from any other image editor on the market

is layer masks. These specialized layers let you hide or expose specific parts of a layer by painting the portions

you want to hide, emphasize, or expose using the Paintbrush tool. I often use layer masks in my editing to

selectively apply blurs, sharpening, or color and tonal corrections to an image. For instance, I might have a land-

scape photo in which I want to darken the sky and add contrast using Curves, but I don’t want to add those

changes to the foreground of the image. In that case, I go ahead and make the adjustments to the image, but

then create a layer mask that hides the changes. I then use the Paintbrush to paint in the changes only to the

sky portion of the image.

You can use layer masks for:

■ Selective blurs. You can create a layer in a landscape to blur or soften part of the subject. (This is a

portrait-editing technique.) You might not want the entire image blurred, but by using a layer mask,

you can paint in the blur effect to only the areas you want.

■ Selective overall (color or tonal) adjustments. You can create a layer mask to selectively paint in 

the effects of an overall adjustment. This is a great trick to use for retouching nature photographs

selectively.

■ Selectively darkening a background. You can darken the entire image using the Hue/Saturation

Lightness slider to the level at which the background is darkened to your liking. Create a layer mask,

and then paint back in the areas that you don’t want darkened!

The following steps give you a detailed example of using layer masks in nature images, showing you how to

use one to hide the sharp portions of a blurred image, and then selectively paint back in the parts of the image

you want to remain sharp. You can apply many such effects and filters, and then use layer masks to selectively

paint in the effects.

To apply a selective effect (in this case, a blur) to an image using a layer mask, follow these steps:

1. Create a layer to apply the effect to. Don’t forget to give descriptive names to your layers when you

create them. You can change the layer name by clicking the name in the Layers palette and typing

in the new text.
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Figure 12.15  Adding a Gaussian blur to the entire image

3. Create a layer mask. Choose Layer, Layer Mask. Choose the Reveal All option in the flyout menu to

fill the layer with white, allowing the effects of the layer adjustment to show through. Choosing the

Hide All option in the flyout menu paints the layer with black to hide the effects of the Gaussian blur

layer adjustment. For this example, I’ve chosen Reveal All.

As a friendly warning, I suggest that you do not use the Add Layer Mask button in the Layers palette;

you can’t choose the Reveal or Hide options that way.

2. Blur the image by choosing Filters, Blur, Gaussian Blur. I want to add a lot of blur to this image, so

I am using a setting over 38, as shown in Figure 12.15.
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The Reveal All option lets the effects of the Gaussian Blur continue to show in the image, as shown

in Figure 12.16. Choose this option to paint the areas to hide the Gaussian Blur effect. Choosing the

Hide All option hides the Gaussian Blur effect, allowing you to use a Paintbrush tool to paint in the

areas of the image where you want the Gaussian Blur effect.

Figure 12.16  The image with the Blur filter

(a lot of it!) applied

4. Click the Paintbrush tool in the Photoshop Toolbox. Press D to set the foreground color to white and

the background color to black. The D key always changes these back to the Photoshop default col-

ors (hence the D): white for foreground and black for background. Press X to reverse these colors.

Using black as the foreground color in the Reveal All mode paints away the layer mask; using white

as the foreground color paints the layer mask back in. You can also paint with shades of gray to get

toned-down effects.
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5. Lower the opacity. Lower the opacity to around 20 percent in the Opacity field on the Option bar.

Lowering the opacity reduces the “strength” of your painting, resulting in a more realistic transition

between the masked and the painted areas of the layer. You can increase the painting effect every

time you click and hold the mouse, and then paint more.

6. Paint in the portion of the image you want to remain in focus. Painting areas of the image hides

the Gaussian blur and reveals the sharper image behind the Gaussian blur mask, leaving the

unpainted areas still blurred. Painting reveals the sharper details of the chosen parts of the flower,

but leaves (no pun intended!) a softened look for the rest of the foliage, as shown in Figure 12.17.

Figure 12.17  Painting in the sharp portions

of the image to retain
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To selectively sharpen an image, use the same approach you used to blur the image: Create a layer and merge

the previous layers. Sharpen the entire image and create a layer mask to hide the sharpening. Paint the areas you

want to sharpen, and that’s it! Don’t forget, using layer masks works great when you’re adding Artistic filters to

your images, such as the Graphic Pen or the Charcoal filter. I’ll cover more on filters in the next chapter.

Summary

Applying edits to your nature images is one of the last steps you take before getting your image ready for out-

put. The most important thing to remember when making edits to your images is to continue on with a work-

flow where you left off making color and tonal adjustments. Just remember to create a separate layer for each

type of edit (such as dodging and burning, blurring, or retouching using the Paintbrush tool), and name that layer

for future reference.

There are other types of edits you can make to your nature images, such as converting an image from color to

black and white, adding an Artistic filter, or stitching multiple images together in a panorama, which I’ll cover

in the next chapter. There’s more editing fun to come!
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F
or years, I was what you might consider a traditional photographer. Shoot an image, and then process

that image to the exact vision of the scene as I saw it. No manipulation, just straight processing and print-

ing. For the past few years, I’ve been leaning more and more toward pushing the edge of my creativity

using my digital cameras, Photoshop, and third-party filter products. I’ve grown fond of taking images that I

would never use normally, and then turning those images into works of art using various Photoshop techniques,

with or without the use of filters. The results even astound me, and they have opened up creative possibilities

that I normally wouldn’t think of.

Whether our peers in the art community like to hear it or not, nature photographers are artists, not photojour-

nalists—there’s a big difference. Photojournalists record an event, publish a photo, and that’s about it. Nature

photographers do extensive research to find locations to photograph, scout the area, and determine the time

of day to capture the desired lighting, and then we spend enormous amounts of time and energy taking pho-

tos of nature. Once the photo is taken in the field, we’re still only halfway there. We often spend more time pro-

cessing and fine-tuning images in the digital darkroom before we’re satisfied with the final result, the final print.

If that’s not fine art, I don’t know what is.

In this chapter, I’m going to cover techniques that you can use to enhance your nature photos—and yes, that

means manipulating them as well. You might have heard the arguments, especially in the early days of digital,

that manipulating photos is wrong and that it detracts from the true art of photography. I’m not going to take

sides on that, and I don’t suggest that you do either. There are valid points on both sides of the subject, but I

think that pertains to other forms of photography, such as photojournalism. I think fine art photography is a totally

different ballgame without any rules, unless you decide to self-impose them.

When you’re creating digital nature images for your personal or professional enjoyment, who is to say you

can’t tweak the images to your heart’s content? Did Picasso or Salvador Dali reproduce direct representations

of the subjects they were painting? No! They produced their artwork to where they had envisioned, which,

incidentally, was way out there. I think that nature photographers fall into the same category. Create your images

the way you envision them, and don’t limit yourself to whatever someone else says is a photograph.

In short, do whatever blows your hair back.

Photoshop Filters

The more I mess around with creating effects for my nature and landscape photos, the more fun I have. It

reminds me why I got into photography in the first place—to have fun creating images. Yes, most of my photos

you’ve seen displayed throughout the book were created without the use of any manipulation effects, but that
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doesn’t mean I can’t go back and mess around with some of those images. Sometimes you can dig into your

image library, pick a few favorites, and have some fun with them by adding Photoshop artistic filters, oversat-

urating images for some different color effects, converting color images to appear as if they were captured in

infrared, or just converting your color images to black and white. Let your creative conscience be your guide,

and you’ll be surprised at how you can change the entire appearance of an image.

Photoshop filters are editing functions that are used mainly for transforming images. There are even a few in

there that are used to correct a camera lens’ shortcomings. You’ll also find the filters to sharpen your images—

Smart Sharpen, Sharpen, and Unsharp Mask. For the most part, most of the filters provided add artistic effects

to your images.

Applying a filter to an image is one of the last steps you want to perform in your editing workflow. You want to

make sure that your image is adjusted for color, tone, and any other editing techniques before applying filters.

Treat applying filters as part of your image-editing workflow and use separate layers for each filter addition.

Before you dive into applying all these cool effects to your images, I have a few interesting points for you to

consider.

■ Filters are located in the Filter menu. To access filters,

just click on the Filter menu, shown in Figure 13.1. As

you’ll see, many of the artistic filter choices include

submenus that include even more filters.

■ Only some filters will work in 16-bit mode. Many fil-

ters won’t work in 16-bit mode. If you’re working on

an image in 16-bit mode and you access the Filter

menu, you’ll notice some of the choices are grayed

out, which means that those particular filters will only

work in 8-bit mode. To convert your image to 8-bit

mode, choose Image, Mode, 8 Bits/Channel.

■ Create a new layer to apply filters. Press Shift+Ctrl+

Alt+E (Shift+Command+Option+E on a Mac). The

best effects can be obtained by applying filters to a

duplicate layer, and then adjusting the opacity or fill

in the Layers palette. Duplicating the background

layer retains the original image and allows you to go

back and delete the duplicate if you don’t like the

effect you’re applying.

Figure 13.1  The Filter menu



Figure 13.2  The Filter Gallery suffices as a one-stop-shop graphical interface to more

than 45 artistic Photoshop filters.
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■ Combine multiple filters for multiple effects. There are no rules when it comes to using filters, and

of the more than 70 artistic filters available in Photoshop, the possibilities for using any of these fil-

ters in conjunction with others are limitless.

■ Additional filters are available from other software manufacturers. Yes, there are legions of geeks

out there creating new filters to apply special effects to your images as we speak! The two leading

filter packages out there are nik Color Efex Pro (http://www.nikmultimedia.com) and Auto FX

(http://www.autofx.com). Both nik and Auto FX provide packages with many artistic filters, as well

as enhanced correction filters. You can download demo versions of their Photoshop filters from their

Web sites.

■ Most filters can be accessed through the Photoshop Filter Gallery. One sweet little custom inter-

face Photoshop supplies is the Filter Gallery. You can access all of the artistic filters Photoshop pro-

vides in one easy-to-use interface, shown in Figure 13.2. To access the Filter Gallery, choose Filter,

Filter Gallery.

■ Most filters include a unique set of controls. You’ll discover that filters include controls (see Figure

13.3) that, when changed using sliders, change the effects of the particular filter.

Figure 13.3  Each filter will

have its own set of controls.

Use the sliders to change the

effect of the filter.

http://www.nikmultimedia.com
http://www.autofx.com
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Artistic Filters

As you’ve seen, you can easily access Artistic filters using the Filter Gallery or by choosing Filter, Artistic. This

is the area where you can really let your artistic inhibitions go out the window, enjoy an evening with a cup of

tea and a bright computer display, and go wild on some of your images. Figure 13.4 shows the Artistic filter

choices offered in the Filter Gallery.

Figure 13.5 shows a simple autumn color subject from my portfolio, one that normally I might have not both-

ered processing, printing, framing, and mounting. This is an example of an image to which you can try apply-

ing Artistic effects. Take some time to find lost treasures in your image library, making an ordinary image into

something you originally didn’t envision.

Figure 13.4  The Artistic filters

are where you can really

enhance your images with

special effects.

Figure 13.5  The original image before applying

Artistic effects
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Descriptions and examples of the Artistic filters and their uses include:

■ Colored Pencil. This filter provides the effect of an image drawn using colored pencils.

■ Cutout. This filter allows you to create an image that looks as if it was made of cut-up pieces of col-

ored paper.

■ Dry Brush. This filter simulates a bristle brush that has had paint applied and mostly wiped off,

becoming “dry.” It creates a wispy or stippled effect.

■ Film Grain. For some photographers, film grain is something to avoid; for others it adds an artistic

touch. The Film Grain filter applies an even grain-like pattern to shadows and midtones.

■ Fresco. This filter creates a coarse, daub-like pattern, similar to a fresco painting.

■ Neon Glow. This filter adds glows to an image in a softening manner. Using different brushes

achieves various effects.

■ Paint Daubs. This filter applies a number of different painting effects, using 50 different brush sizes

and a number of brush types.

■ Palette Knife. This filter transforms the image into a thinly painted scene with texture underneath.

■ Plastic Wrap. This one is really out there. The Plastic Wrap filter creates a plastic wrap–like texture

over the entire image. It’s great for creating abstracts.

Our technical editor on this book, Ron Rockwell, likes this filter too. Just for fun, he suggests creat-

ing blue as a foreground color and red as the background color. Run Filter, Render, Clouds, and then

Filter, Render, Difference Clouds. Then run the Plastic Wrap filter. It looks like a bowl of blackberry

jam! It totally destroys any image you had, but it’s neat.

■ Poster Edges. This filter reduces the number of colors in an image (called posterizing) while draw-

ing black lines around edges.

■ Rough Pastels. This filter applies chalk strokes to the image and creates a textured background. The

good thing about this one is that you don’t get any chalk on your fingers or your mouse!

■ Smudge Stick. Like the name implies, the Smudge Stick shmushes (another one of my technical

terms) backgrounds, while highlights become brighter with less detail.

■ Sponge. Whhhooooo… lives in a pineapple under the sea…. The Sponge simulates the sponge-

painting technique used by artists.

■ Underpainting. I bet this is a word you don’t see in any dictionary. The Underpainting filter simply

applies the image to a textured background.

■ Watercolor. This filter is for those like me, who couldn’t create a painting even with a paint-by-

numbers set. The Watercolor filter creates a watercolor painting by reducing detail while watering

down the highlights.
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Figure 13.6  Applying Artistic filters to an ordinary image can transform it into a totally new artistic presentation. You can adjust the opacity of layers

containing filter effects, letting the original image show through and giving you some very nice results.
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Figure 13.6 shows examples of some of the artistic effects you can add to an ordinary image to transform it into

a more artistic presentation. Remember, you can combine filters; just create new layers for each one and com-

bine the effects at your own will!

Colored Pencil filter Dry Brush filter
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Figure 13.6  Continued.

Rough Pastels filter Underpainting filter
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Figure 13.6  Continued.

Sponge filter Watercolor filter
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The Brush Strokes, Distort, and Sketch Filters

Image-altering effects don’t stop with the Artistic filters. Next on the long list of Photoshop filters are the Sketch

and Brush Strokes filters. These filters transform images to emulations of an artist’s hand using pencils, brushes,

and pens on art paper. Figure 13.7 shows the Sketch, Distort, and Brush Strokes filters in the Filter Gallery.

The Brush Strokes, Distort, and Sketch filters included in the Filters Gallery

include the following:

Brush Strokes Filters

■ Accented Edges. Accented Edges changes the edges of the image,

simulating either dark or light edges. The filter gives the photo a soft,

painted look.

■ Angled Strokes. This filter paints the image using angled strokes, like

an eccentric painter might.

■ Crosshatch. This filter transforms the image as if it were painted with

a crosshatch pattern.

■ Dark Strokes. Similar to the Water Paper Sketch filter, the Dark Strokes

filter can provide a fine-art look to portraits.

■ Ink Outlines. Remember Salvador Dali? The Ink Outlines filter simu-

lates a pen-and-ink drawing effect on the image to create a surrealis-

tic look.

■ Spatter. This filter gives your image the appearance that ink was shot

through a small nozzle, like those tattooed guys (you know, the ones

wearing leather vests and no shirts so they can show off their own

artwork) do back at the tattoo studio.

■ Sprayed Strokes. The Sprayed Strokes filter is similar to the Spatter fil-

ter except that you can change the direction in which the strokes are

made. I don’t think they can do those when doing tattoos (at least not

without some pain).

■ Sumi-e. That’s what I say when I say something maybe I shouldn’t

have: “Go ahead and sue me!” Anyway, this filter gives an eerie feel-

ing to the image, kind of like lawyers do to the rest of us.

Figure 13.7  Brush Strokes,

Distort, and Sketch filters in the

Filter Gallery
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Distort Filters

■ Diffuse Glow. This Distort filter adds a ghostly effect to an image. You might have seen some pho-

tos used in fashion magazines—you know, the ones of starving girls with an eerie glow to them? I

bet the photographer used the Diffuse Glow filter on those. For nature photos, this can be a fun one

to play around with.

■ Glass. This is one of my absolute favorite filters. I like taking my fall-color images and applying this

filter to make it appear as though you’re looking through glass blocks or frosted glass (like a shower

door) at an image. See my example in Figure 13.8.

■ Ocean Ripple. The Ocean Ripple filter is really another extension of the Glass filter. It gives your

image another distorted glass effect.

Figure 13.8  The Glass filter, part of the Distort family of filters, really gives you a different way to distort an

image for some great effects.
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Sketch Filters

■ Bas Relief. I like to fish, especially for bass. It’s a great stress reliever. This filter changes dark and

light areas, swapping color while the image is transformed into a carved-looking plate.

■ Chalk and Charcoal. This filter transforms your image into a monochrome chalk or charcoal draw-

ing, just like when we did those drawings in art class.

■ Charcoal. Like the name implies, this filter creates a charcoal drawing with drawn highlights.

■ Chrome. The auto industry stopped using chrome years ago; plastic is cheaper! This filter brings the

chrome look back, transforming the image as if it were molded in shiny chrome. You’ll get better

mileage out of this one if you’re into that sort of thing.

■ Conté Crayon. A Conté crayon is usually sepia/red or black in color and is a really common draw-

ing tool in art classes. It starts out as a quarter-inch square stick about three inches long, and you

can either draw with the blunt end of it or use the side for a wide swath of tone/color. Usually you

draw on newsprint for really quick (30-second) figure studies. In the Photoshop Filter Gallery, though,

the Conté crayon creates the effect of a monochromatic drawing with a textured background, such

as canvas, sandstone, or brick.

■ Graphic Pen. This filter swaps foreground and background colors while creating a grainy black-and-

white image.

■ Halftone Pattern. The Halftone Pattern filter creates a halftone version of the image while adding a

dotted, circular, or horizontal pattern. Your resulting image will be reduced in color, with a pattern.

■ Note Paper. This filter produces a toneless grayscale and embossed version of the image.

■ Photocopy. Like the name says, the results of this filter look like you made a photocopy of your

photo.

■ Plaster. Looks like they left the “ed” off the end of the word. Similar to the Note Paper filter, this fil-

ter creates a grayish embossed version of the image.

■ Reticulation. I got caught reticulating many times. Back in the days of the chemical darkroom, we

would purposely develop film in ice-cold temperatures, thus creating a cracked pattern on the film

emulsion. The Reticulation filter simulates the same thing, applying a textured look to a mono-

chromatic version of the image.

■ Stamp. Like the name says, this filter makes your image look as if it were printed using a rubber

stamp. Black and white are the only two colors.

■ Torn Edges. This one is similar to the Stamp filter effect, but with smoother edges.

■ Water Paper. Ah yes, the fine art photographer, using the Water Paper filter to apply paint colors that

look like they were poured on and merged.
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Figure 13.9 shows examples of how a regular photo can be modified using the Brush Strokes, Distort, and

Sketch filters. Remember, you can combine filters on the same image; just follow the best practice of using sep-

arate layers for each filter effect. With the use of the Opacity adjustment in the Layers palette, these filters work

well as a semi-transparent effect to the “real” or filtered image.

Original image Sprayed Strokes filter

Figure 13.9  Using the Brush Strokes, Distort, or Sketch filters (or a combination thereof) to produce other versions of an image
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Figure 13.9  Continued.

Angled Strokes filter Spatter filter
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Figure 13.9  Continued.

Diffused Glow filter Glass Blocks filter
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Figure 13.9  Continued.

Chalk and Charcoal filter Water Paper filter
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Photoshop Black-and-White Landscape Techniques

Black-and-white photographs have always been considered the “fine art” of photography. There are some col-

lectors and purists who, for reasons that aren’t completely understood, think traditional black and white is the

only true art form for photography. Personally, I’ve never believed that for a second. Besides, I personally like

color, and I’m of the opinion that art is what you make of it. The most important question to ask yourself as a

nature photographer is, why should I limit myself to either black and white or color? Do both!

As with a lot of the cool things you can do in Photoshop, converting a color digital image to a B&W image can

be accomplished in a number of ways. I’m going to show you a few that I use. The first is a quickie method,

using the Desaturate command. A second technique uses the Channel Mixer. A third method uses the

Hue/Saturation adjustment layer to convert color photos to black and white. Each method has its own merits

and its own uses.

TIP
Many digital cameras provide you with the ability to capture images in black-and-white

mode. One of the advantages of shooting images with digital cameras and using

Photoshop to process the images is the fact that you can have the best of both worlds—

color and black and white. I suggest always shooting your images in color mode; you

always have the option to convert any image to black and white later, when you’re

processing the image in Photoshop.

Using the Desaturate Command to Convert to Black and White

Sometimes it’s best to take the path of least resistance. There are many ways to convert color images to black

and white, and there’s one little command that will allow you to do that quickly—the Desaturate command.

Here are the steps to that quick conversion:

1. Open a photo in Photoshop that you want to convert to black and white. Converting to black and

white is a step that should be taken after all of your color, tonal, and image edits are made.

Converting an image to black and white should be the next step in your workflow.

2. Create a new layer to use when you make your B&W conversion. Create a new layer by pressing

Shift+Ctrl+Alt+E (Shift+Command+Option+E on a Mac). Name this new layer Desaturate.

3. Desaturate the image. Choose Image, Adjustments, Desaturate or press Shift+Ctrl+U (Shift+

Command+U on a Mac).
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You’ll find that using this procedure to convert your image to B&W is about as easy as it comes. The Desaturate

command simply converts the entire image to black and white, shown in the example in Figure 13.10.

TIP
When converting color images to black and white, an important factor to consider is that

you still have an RGB or CMYK image, not grayscale. Therefore, your printer will be using

the whole spectrum of ink at its command to print gray. One printer might produce a

pink-tinted print, and the next might produce a cool blue. By changing the image at

some point to grayscale, you’re at least using only black (and gray, in some printers) ink.

Figure 13.10  The Desaturate

command is the quickest way to

convert color images to black and

white.
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Using the Hue/Saturation Adjustment to Convert to Black and White

The second method to convert color images to B&W involves the Hue/Saturation adjustment. I like to use this

method to desaturate yellows, greens, blues, cyans, and magentas in a color image. I then use the Red Saturation

control to add a little tone back into the image. By adding a little red back into the image, you get that “sele-

nium-toned” look (black-and-white photos with a brownish tone to them) to your converted B&W photos.

Here’s how to use this method:

1. Open a photo you want to convert to B&W. As in the Desaturate method, make sure you’ve made

your tonal and color corrections before proceeding. (I covered those corrections in Chapter 11.)

2. Create a new layer to use for the Hue/Saturation adjustment. Create a new layer by pressing

Shift+Ctrl+Alt+E (Shift+Command+Option+E on a Mac). Name this new layer Hue-Saturation.

3. Desaturate colors. Click the Edit menu and select Yellows (Ctrl+2 on a PC and Command+2 on a

Mac). In the Saturation control, move the Saturation slider all the way to a setting of 100 to remove

the yellow color. Repeat this step for each of the other colors: greens, cyans, blues, and magentas.

(You adjust the reds in the next step.)

4. Desaturate the Red channel. Move the slider all the way to a setting of 100. Move the slider to the

left slightly, until you obtain a toned effect. A setting of 70 to 40 usually gives me the toned effect I

like in some of my B&W conversions. The photo, when converted to B&W as shown in Figure 13.11,

is slightly toned with a Red-channel Saturation setting of 40.

TIP
When converting color images to black and white using the Desaturate command or

the other methods described in this chapter, you might have to make some additional

overall corrections to finish your image. I often add contrast and possibly some burning

and dodging to an image after I’ve converted it to black and white. Because the overall

appearance of the image is going to change, you’ll need to make some further adjust-

ments to your liking. Remember to create a new layer for each correction.
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Figure 13.11  Creating

a B&W image with a

selenium-toned appear-

ance using the Hue/

Saturation adjustment
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Using the Channel Mixer to Convert to Black and White

The Channel Mixer is another method for converting color images into black and white. Use the Channel Mixer,

remove color from your entire image, and then fine-tune the Red, Green, and Blue channels to obtain more

control over the tones of the image you are converting. As a reminder, Photoshop always gives you many ways

to obtain similar results, and using the Channel Mixer is another way to convert color images to B&W. To use

the Channel Mixer to make your conversion, follow these steps:

1. Open a photo in Photoshop that you want to convert to B&W. Process the photo as you would any

other, making the color and tonal adjustments, and then the edits.

2. Create a new layer to use for the Channel Mixer. Create a new layer by pressing Shift+Ctrl+Alt+E

(Shift+Command+Option+E on a Mac). Name this new layer Channel Mixer.

3. Start the Channel Mixer. Choose Image, Adjustments, Channel Mixer.

4. Click the Monochrome check box. Clicking the Monochrome check box immediately converts your

image to black and white. Figure 13.12 shows the Monochrome check box and the Channel Mixer

window.

Figure 13.12  Using the

Channel Mixer to convert

color images to black and

white with finer tuning of

color channels
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5. Make adjustments to fine-tune the color channels. Make moderate adjustments to the Red, Green,

and Blue channels in the Channel Mixer dialog box. You don’t need to move the Red, Green, or Blue

sliders much. Most of the time, you’ll want to adjust the Red channel slightly to get the B&W effect

you want.

Experiment by moving each slider—Red, Green, and Blue—and you’ll probably find that only slight

(or even no) adjustment gives you great results. Figure 13.13 shows the image converted using the

Channel Mixer.

Figure 13.13  The image con-

verted to black and white using

the Channel Mixer
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Selective Color Techniques

You might have seen black-and-white images in which only a portion of the image is in color. The technique

to obtain selective color in Photoshop is actually very simple. I always get that “wow” factor when I show off

my nature photos and mix in a few that are in black and white, with the exception of one portion of the image.

The technique is simple, and it’s almost the same as the previous technique that converts color to B&W, except

that you save a selection in which to retain some color.

The process to selectively retain color in a black-and-white converted image is as follows:

1. Open a photo you want to convert to B&W while retaining a portion of the image with color. As

in the previous methods to convert to black and white, make sure you’ve made your tonal and color

corrections and any edits that are necessary.

2. Create a new layer you can use to make selections. Create a new layer by pressing Shift+Ctrl+Alt+E

(Shift+Command+Option+E on a Mac). Name this new layer Selections.

3. Select a part of the image to remain in color. Using the selection techniques covered previously,

select an area of the image where you want color to remain.

4. Duplicate the layer. Right-click (Ctrl+click on a Mac) on the active layer and choose Duplicate

Layer. Name the new layer Convert to B&W.

5. Inverse the selection. Because I want to keep the color in the selected leaves, I choose Select,

Inverse (or press Shift+Ctrl+I on a PC or Shift+Command+I on a Mac), which inverses the selection

so the rest of the image will get converted to B&W.

6. Desaturate color. Choose Image, Adjustments, Hue/Saturation or press Ctrl+U (Command+U on a

Mac). Desaturate the reds, greens, and blues by clicking on the Edit Selection box, choosing a color,

and then proceeding to move the Saturation slider for each color all the way to the left.

7. Adjust contrast by using the Curves adjustment. Figure 13.14 shows the original image, and then

the image converted to black and white with selective color remaining.
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Figure 13.14  Image converted to black and white with selective color remaining

TIP
If you shoot your images in raw format and use Camera Raw to convert your photos,

you can skip some of the black-and-white conversion steps by doing your conversion in

Camera Raw. In Camera Raw, all you have to do is make all of your tonal and color

adjustments like you usually make them, and then move the Saturation slider to the left

to desaturate the color in the image. When you’re finished, just click the Open button to

open your image in Photoshop.
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Creating Scenic Panoramas

As a photographer who shoots landscapes often, I’ve learned to leverage the Photoshop Photomerge feature to

assemble multiple images taken in succession for the purpose of creating panoramas. There is an art to shoot-

ing panoramas and then stitching them together in Photoshop; I’ve used the Photomerge feature often, with great

results.

As in any workflow you initiate, there is a workflow for creating panoramics too. The panorama process starts

when you’re in the field shooting images, and then graduates to your digital darkroom from there. Before div-

ing into how to stitch panoramas together in Photoshop, let’s first review how to shoot panoramas with your

digital camera.

For best results, take three or four photos of a scene, all with the same exposure and white-balance settings.

All you need is a really cool panoramic scene to shoot and a couple of basic techniques. Here are some tips

for shooting panoramic scenes:

■ Select a scene that’s either wide or tall. Remember, you don’t have to shoot panoramic images

with your digital camera level! You can stitch together panoramas when the images are vertical too.

You can also shoot tall scenes from top to bottom to stitch together later.

■ Mount your digital camera to a sturdy tripod. I always recommend shooting as many of your pho-

tos on a tripod as is humanly possible. A tripod helps you achieve the sharpest possible photos,

especially when you’re shooting in low-light conditions and your shutter speed is less than 1/125

of a second. Look through your viewfinder or LCD and pan the scene from left to right (or top to

bottom) to make sure your camera is level. If you see that your panning is a little off, adjust your tri-

pod head to level your camera as best as you can.

Some tripod models include levels built into them; you can also purchase levels that attach directly

onto your digital camera’s hot shoe. If you don’t have a level, consider purchasing one to attach to

your digital camera.

■ Meter the main part of the scene. I recommend using manual shutter-speed, aperture, and white-

balance settings. Look at your LCD or viewfinder to see how your digital camera is metering the

scene. Switch to manual mode, and then set your shutter speed and aperture to match your digital

camera’s first meter reading of the scene. It is very important to ensure that the exposure is the same

for every photo sequence you shoot.

Additionally, set your white balance manually to match the conditions you’re shooting in, such as

daylight, overcast, or shade.
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■ Take a series of photos. If you’re shooting a horizontally oriented scene, start on the left and take

the first shot. Pan your camera to the right until you’ve overlapped the previous shot by one-third of

the frame. Take the second shot. Pan to the right again until you’ve overlapped the previous shot by

one-third of the frame and take the photo. If your panorama requires a fourth frame, repeat the

process, overlapping the previous frame by one-third.

■ Review your photos. Using your digital camera’s LCD, review your photos to make sure you

achieved the results you intended. Check to make sure your images are sharp and properly metered,

and of course level. If you need to, take another series of panoramic shots using different zoom set-

tings on your lens. Keep shooting different aspects of the scene to make sure that you captured the

panoramic frames you know will make a great continuous scene.

With a number of images taken in sequence that you can stitch together into a panorama, it’s time to use Bridge

and Photomerge. Photomerge is a Photoshop utility that’s accessible from both Bridge and the Photoshop File,

Automate menu. I find it easiest to use Bridge to choose my images first. Follow these steps to choose images

to stitch together in Photomerge:

1. Open Bridge and select the folder to choose your images from. Browse the thumbnails for images

you’ve taken in succession.

2. Process the images using Camera Raw (for raw images only). Assuming that the images you want

for your panorama are still in raw format, you need to process each of the three or four images

you’ll be using. To ensure that all of the images you’ll be using for your panorama share the same

Camera Raw adjustments, first process the initial image in the sequence in Camera Raw. Make any

necessary adjustments.

Now copy the raw settings. To copy raw settings, right-click (Ctrl+click on a Mac) on the image

thumbnail in Bridge and choose Copy Camera Raw Settings. You’ll want to apply the settings made

to the first image to the remaining two or three images in your sequence. This will ensure that adjust-

ments are the same for each image in your panorama, which is important because you want all the

images to have the same color and tone throughout.

You can then apply raw settings to the remaining images by selecting the remaining images in your

sequence into which you want to paste the Camera Raw settings. Click their thumbnails while hold-

ing down the Alt key (the Option key on a Mac), and then right-click (Ctrl+click on a Mac) and

choose Paste Camera Raw Settings from the flyout menu.
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3. Select images in Bridge that you want to Photomerge. Select each photo intended for your

panorama in Bridge by holding the Alt key (the Option key on the Mac) while clicking each image.

4. Start Photomerge. Choose Tools, Photoshop, Photomerge. Photomerge will attempt to assemble

the images as one. For some panoramas, Photomerge can’t quite figure out the entire panorama on

its own, so you’ll have to drag the images into the Photomerge window yourself (and line them up

in the proper position there) to complete your panorama. Figure 13.15 shows the Photomerge win-

dow with the panoramic image stitched together.

Figure 13.15  Photomerge stitches together your panoramic image
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5. Click the Advanced Blending check box. After checking the Advanced Blending check box, click the

Preview button. Advanced blending gives you a better preview of how well Photomerge combined

your images.

For more control over how your images are overlapped with one another, you might have to use the

Select Image Tool to move individual images around so they overlap properly. You can use the Zoom

tool to magnify the different overlapping areas of your image so you can check the overlap for each

part of the panorama.

6. Click OK to load the panorama into Photoshop.

7. Crop the image. After you get the image into Photoshop, crop the image to ensure that its borders

don’t contain any white space.

8. Complete final color adjustments, tonal corrections, and edits. As with any image, go through your

overall corrections and editing workflows to finish the image and get it ready for output. Start by

using the Levels, Curves, and Hue/Saturation adjustment levels to fine-tune color and tone. Make

any necessary edits, such as dodging and burning (covered earlier in this book).

Additionally, there isn’t any rule that says you can’t do panoramas in black and white! Create a new

layer and perform a black-and-white conversion (using the techniques discussed earlier in this chap-

ter) to create another interpretation of your panorama.

Summary

I consider this to be the most fun chapter in the book. Expanding your creativity with Photoshop filters, black-

and-white conversions, and panoramas will allow you to expand your portfolio of nature images. Consider

incorporating some of the techniques reviewed in this chapter into your everyday image-editing workflow. As

a rule, I often create a new layer for many color images, just to convert those images to black and white. Tastes

change over time, and one day you might want a black-and-white version of a photo. This way, you’ll always

have one stored in your image library.

I don’t recommend going hog-wild with adding effects to photos, but having these techniques in your own bag

of tricks is a great way to expand your nature photography horizons and have a little bit of fun while you’re doing

it. If you have time, revisit your old images and see whether you can rescue some duds by applying some cre-

ative filters or techniques to them. You’ll be surprised by how many more usable images you actually have in

your nature image library.
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palettes (Photoshop), 193, 200, 203

pan and tilt heads, 39–41

panels (Bridge), 145

panning (tripods), 39

panoramas

Photomerge, 319–325

settings/workflow

apertures, 88, 319

LCDs, 88, 321

lighting meters, 88, 319

manual mode, 88, 319

orientation, 87, 319

overview, 85

reviewing, 88, 321

series, 88, 321

shooting, 88, 321

shutter speed, 88, 319

tripods, 87, 319

white balance, 88, 319

patterns (abstracts), 117

Pencil tool, 273

Photomerge (panoramas), 319–325

Photoshop

black and white conversion

burning tools, 311

Camera Raw, 318

Channel Mixer, 313–316

contrast, 311

Desaturate command, 307–311

dodging tools, 311

hue layer, 311–312

overview, 307

saturation layer, 311–312

selection tools, 317–318

Bridge

automation, 142

starting, 152, 171

Camera Raw comparison, 162–163, 169

color/tonal adjustments

background layers, 230–231

color balance layer, 247–248

contrast, 237

curves layer, 244–246

exposure layer, 236–237

gamut, 251

highlights, 237–246

highlights layer, 237–240

histograms, 241–244

hue layer, 249–254, 311–312

levels layer, 241–244

midtones, 237, 241–246

offsetting, 237

opening images, 230

planning, 231

previewing, 237

saturation layer, 249–254, 311–312

saving images, 230–231

shadows, 237–246

shadows layer, 237–240

Variations, 233

workflow, 230–235
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color management

color balance, 214–215

color preferences, 217–220

color profiles, 222–223

display calibration, 215–217

overview, 211–214

proofing, 223–227

workflow, 214

Elements, 276

features, 191–193

filters

8–bit mode, 288

16–bit mode, 288

Artistic filters, 291–296

Auto FX, 289

Brush Strokes filters, 297–306

combining, 289

controls, 289

Distort filters, 297–306

Filter Gallery, 289

Filter menu, 288

layers, 288

nik Multimedia Color Efex Pro, 289

overview, 286–290

plug-ins, 289

Reduce Noise, 162, 179

Sketch filters, 297–306

Help, 200

image window, 193

images

automation, 142

bit depth, 171

color space, 171, 214

image window, 193

opening, 139, 230

ratings, 142

resolution, 173

settings/workflow, 171–173

saving color/tonal adjustments, 230–231

size, 173

layers, 205–209

menus, 196–200

Filter menu, 288

Select menu, 268–270

overview, 188–191

palettes, 193, 200, 203

Photomerge panoramas, 319–325

serial numbers, 200

tools

burning tools, 270–272, 311

Clone Stamp tool, 276

Color Replacement tool, 273

deselecting, 266, 268

dodging tools, 270–272, 311

Eraser tool, 276

feathering, 268–270

growing, 268–270

Healing Brush tools, 274

inverting, 268

Lasso tool, 266–267

layer masks, 273, 276, 278–283

Magic Wand tool, 261–265, 270

Magnetic Lasso tool, 266–267

Paintbrush tool, 273

Pencil tool, 273

selection tools, 260–270

similarities, 268–270

Sponge tool, 271

Toolbox, 193, 202

updating, 200

window, 193–194

workspaces, saving, 200

planning

abstracts, 111–113

editing, 258

landscapes, 57, 60

locations (wildlife), 95

Photoshop color/tonal adjustments, 231

settings/workflow

close-ups, 121

file management system, 134–139

landscapes, 73

wildlife, 98–101

plug-ins (Photoshop filters), 289

polarizers (landscapes), 66

portrait orientation (tripods), 39

ports (I/O)

desktop computers, 21

laptops, 24

preferences (Bridge), 148–152

previewing

Camera Raw, 169

Photoshop, 237

processing settings (Camera Raw), 176–184

processors

desktop computers, 21

laptops, 24

professional digital cameras, 7

proofing (Photoshop color management),
223–227

prosumer digital cameras, 8

Q–R
quality (Camera Raw), 167

quick release heads, 41

rain (landscapes), 61–66

ratings (Bridge), 142

readers (memory cards), 30

Reduce Noise filter (Photoshop), 162, 179

reflections (abstracts), 115

resolution, 173

reviewing settings/workflow

close-ups, 123

landscapes, 83

panoramas, 88, 321

wildlife, 103

rule of thirds (compositions), 68–69
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S
safety

accessories, 49–51

campsites, 98

cell phones, 49, 98

environment, 98

firearms, 49

first aid, 51

itineraries, 51

two-way radios, 49

wildlife, 49, 98, 106

saturation

Camera Raw, 176

saturation layer (Photoshop), 249–254,
311–312

saturation layer (Photoshop), 249–254,
311–312

saving

Camera Raw images, 181

Photoshop

color/tonal adjustments, 230–231

workspaces, 200

schedules (landscapes), 57–59

scouting locations (landscapes), 59

screens

calibration, 27, 215–217

choosing, 26

colorimeter, 27, 215–217

CRTs, 26, 215–217

laptops, 24

LCDs, 26, 215–217

Photoshop, 215–217

Select menu, 268–270

selecting

abstracts, 111–117

bags, 44–45

digital cameras, 7–9

displays, 26

locations (landscapes), 55

selection tools

black and white conversion, 317–318

deselecting, 266, 268

feathering, 268–270

growing, 268–270

inverting, 268

Lasso tool, 266–267

Magic Wand tool, 261–265, 270

Magnetic Lasso tool, 266–267

overview, 260–261

Select menu, 268–270

similarities, 268–270

tripods, 37–38

selection tools

black and white conversion, 317–318

deselecting, 266, 268

feathering, 268–270

growing, 268–270

inverting, 268

Lasso tool, 266–267

Magic Wand tool, 261–265, 270

Magnetic Lasso tool, 266–267

overview, 260–261

Select menu, 268–270

similarities, 268–270

serial numbers (Photoshop), 200

series (panoramas), 88, 321

settings

Camera Raw

conversion, 171–176

processing, 176–184

close-ups, 121, 123

landscapes

action mode, 79

apertures, 73, 77–81

compositions, 77

ISO, 81

LCDs, 77, 83

light meters, 73, 79

manual mode, 79

orientation, 75, 79

overview, 73

planning, 73

reviewing, 83

sharpness, 77

shooting, 83

shutter speed, 77, 83

timers, 83

tripods, 77

viewfinders, 77

white balance, 73, 81–83

zoom, 77

panoramas

apertures, 88, 319

LCDs, 88, 321

lighting meters, 88, 319

manual mode, 88, 319

orientation, 87, 319

overview, 85

reviewing, 88, 321

series, 88, 321

shooting, 88, 321

shutter speed, 88, 319

tripods, 87, 319

white balance, 88, 319

Photoshop, 171–173

wildlife

360–degree rule, 101

action mode, 98–99

apertures, 77, 101

centering, 101

focus, 103

ISO, 101–103

LCDs, 101, 103

orientation, 103

overview, 98

planning, 98–101

reviewing, 103

shooting mode, 101

shutter speed, 77
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tripods, 101

viewfinders, 101

white balance, 103

zoom, 101

shadows

Camera Raw, 175–176, 178

clipping (Camera Raw), 175, 178

Photoshop, 237–246

shadows layer (Photoshop), 237–240

sharpness

Camera Raw, 178

digital cameras, 9

landscapes, 77

shooting

landscapes, 83

panoramas, 88, 321

shooting mode (wildlife settings/workflow),
101

shooting mode (wildlife settings/workflow),
101

shutter speed (settings/workflow)

landscapes, 77, 83

panoramas, 88, 319

wildlife, 77

sidecars (Camera Raw), 167, 181

similarities (selections), 268–270

size

bags, 44

Bridge windows, 145

images, 173

Sketch filters (Photoshop), 297–306

software compatibility (Camera Raw),
164–165, 167

speed

advantages, 5

film (ISO)

landscapes, 81

macros, 125

switching, 4

wildlife, 101–103

Sponge tool, 271

starting

Bridge, 139

Photoshop, 152, 171

storage

CDs, 29

DVDs, 29

Epson P-4000 Multimedia Storage Viewer

overview, 13, 43

workflow (file management system), 135

external hard drives, 27

iPods

overview, 13

workflow (file management system), 135

memory cards

overview, 12, 43

readers, 30

workflow (file management system),
135–137

Nikon COOLWALKER Storage Viewer, 43

offline storage devices, 13, 43

optical drives, 29

studio close-ups/macros, 127, 129

subjects

locations (wildlife), 95–96

offsetting (landscapes), 71

switching ISOs, 4

T
tablets (graphics), 29–30

temperature (Camera Raw), 175

thumbnails (Bridge), 147, 150, 155

timers

close-ups, 121

landscapes, 83

tint (Camera Raw), 175

tonal adjustments. See color/tonal adjust-
ments

tools (Photoshop), 193, 202

burning tools, 270–272, 311

Clone Stamp tool, 276

Color Replacement tool, 273

deselecting, 266, 268

dodging tools, 270–272, 311

Eraser tool, 276

feathering, 268–270

growing, 268–270

Healing Brush tools, 274

inverting, 268

Lasso tool, 266–267

layer masks, 273, 276, 278–283

Magic Wand tool, 261–265, 270

Magnetic Lasso tool, 266–267

overview, 260

Paintbrush tool, 273

Pencil tool, 273

Select menu, 268–270

selection tools, 260–270

similarities, 268–270

Sponge tool, 271

Toolbox, 193, 202

tours (wildlife), 104–106

Travel Images Web site, 104

tripods

bags, 44–45

carbon-fiber, 38

choosing, 37–38

compositions, 101

focus, 34–35

heads, 39–41

height, 38

macros, 125

material, 38

metal, 38

overview, 13, 34–35

panning, 39

portrait orientation, 39
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settings/workflow

close-ups, 121

landscapes, 77

panoramas, 87, 319

wildlife, 101

versatility, 38

vibrations, 37

weight, 37–38

two-way radios, 49

U–V
underexposure. See exposure

updating Photoshop, 200

USB ports

desktop computers, 21

laptops, 24

Variations (Photoshop), 233

versatility (tripods), 38

vibrations (tripods), 37

viewfinders

landscapes, 77

wildlife, 101

vignetting (Camera Raw), 183

W
Wacom Technology Web site, 30

waterproofing bags, 44

weather (landscapes), 60

360–degree rule, 66

clouds, 61–63

foliage, 64–66

lighting, 61–67

polarizers, 66

rain, 61–66

wind, 61–63, 67

Web sites

Auto FX, 289

ColorVision, 27, 215

National Park Service, 59

nik Multimedia Color Efex Pro, 289

Travel Images, 104

Wacom Technology, 30

X-Rite Photo, 27, 215

weight (tripods), 37–38

white balance

advantages, 5

Camera Raw, 164, 173–175

landscapes, 73, 81–83

panoramas, 88, 319

wildlife, 103

wildlife

compositions

360–degree rule, 101

action mode, 98–99

apertures, 101

centering, 101

focus, 103

ISO, 101–103

LCDs, 101, 103

orientation, 103

overview, 98

planning, 98–101

reviewing, 103

shooting mode, 101

tripods, 101

viewfinders, 101

white balance, 103

zoom, 101

cost, 106

interaction, 96

landscapes, 55

locations

finding, 92–98

planning, 95

subjects, 95–96

overview, 92

safety, 49, 98, 106

settings/workflow

360–degree rule, 101

action mode, 98–99

apertures, 77, 101

centering, 101

focus, 103

ISO, 101–103

LCDs, 101, 103

orientation, 103

overview, 98

planning, 98–101

reviewing, 103

shooting mode, 101

shutter speed, 77

tripods, 101

viewfinders, 101

white balance, 103

zoom, 101

tours, 104–106

wind (landscapes), 61–63, 67

windows

Bridge, 138, 145

Camera Raw, 168

Photoshop, 193–194

workflow

Camera Raw, 169, 171–173

close-ups

360–degree rule, 121

apertures, 123

compositions, 123

depth of field, 123

focus, 123

lighting, 123

overview, 121

planning, 121

reviewing, 123

timers, 121

tripods, 121

zoom, 123
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editing, 258–260

file management system

backups, 134–139

CDs, 137

downloading, 137

DVDs, 137

Epson P-4000 Multimedia Storage
Viewer, 135

folders, 134–139

hard drives, 137–139

iPods, 135

memory cards, 135–137

overview, 134

planning, 134–139

landscapes

action mode, 79

apertures, 73, 77–81

compositions, 77

ISO, 81

LCDs, 77, 83

light meters, 73, 79

manual mode, 79

orientation, 75, 79

overview, 73

planning, 73

reviewing, 83

sharpness, 77

shooting, 83

shutter speed, 77, 83

timers, 83

tripods, 77

viewfinders, 77

white balance, 73, 81–83

zoom, 77

panoramas

apertures, 88, 319

LCDs, 88, 321

lighting meters, 88, 319

manual mode, 88, 319

orientation, 87, 319

overview, 85, 319

reviewing, 88, 321

series, 88, 321

shooting, 88, 321

shutter speed, 88, 319

tripods, 87, 319

white balance, 88, 319

Photoshop

color adjustments/tonal, 230–235

color management, 214

images, 171–173

wildlife

360–degree rule, 101

action mode, 98–99

apertures, 77, 101

centering, 101

focus, 103

ISO, 101–103

LCDs, 101, 103

orientation, 103

overview, 98

planning, 98–101

reviewing, 103

shooting mode, 101

shutter speed, 77

tripods, 101

viewfinders, 101

white balance, 103

zoom, 101

workspaces

images (Bridge), 142–143, 145, 147

saving (Photoshop), 200

X–Z
X-Rite Photo Web site, 27, 215

zoom

abstracts, 114–117

close-ups, 123

landscapes, 77

wildlife, 101
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